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What Is Aspen Graphics 4.2? 
 
Aspen Graphics Workstation Version 4.01 is the latest offering from Aspen Research 
Group.  The original application has been re-written to provide a more up-to-date and 
intuitive front-end, whilst retaining the powerful features and functions which traders 
have relied upon for 20 years. 
 
Aspen Graphics is able to display real-time data from a number of different data vendors 
and sources, depending on location and method of delivery (internal LAN or internet).  
The majority of features and functions covered in this manual are feed independent, there 
are some options which are feed specific and will be dealt with at the end. 
 

Objects in Aspen 
 
There are two objects with which we concern ourselves in Aspen, Pages and Windows.  
It is only possible to have one page displayed at any one time; however that one page can 
be made up of multiple windows.  The most commonly used ones are described below: 

Charts 
Charts are perhaps the most commonly used windows in Aspen Graphics, enabling users 
to view historical data on an intra-day or daily basis.  There are a large number of 
technical analysis studies which can be applied to these charts and these will be covered 
in a later section. 
 

Clocks 
The clock windows in Aspen are configurable clocks that can be set to different time 
zones and display modes.  
 

Quotes 
The quote windows in Aspen enable users to monitor price information and movement in 
real-time.  Completely customizable, the quote windows offer limitless options for 
display of data 
 

News 
Depending on the data package subscribed to, news from a variety of sources is available 
through Aspen Graphics.  News can be displayed by Category or specific keywords can 
be searched for from the whole news database. 



 

Time and Sales 
The time and sales window in Aspen Graphics is used to view tick data as it is received, 
users can view bid, ask, trade and settlement prices or any combination thereof.  In 
addition any associated volumes can also be displayed, and users further have the choice 
of filtering out small or large volumes. 
 

Price and Volume 
Also known as Market Profile®, Price and Volume is another way of viewing data, as 
opposed to viewing price against time, with this display method we are able to view how 
much volume has traded at a given level. 
 

Other Windows 
Either not as commonly used, or feed specific, there are several other types of display in 
Aspen Graphics.  These are mentioned in Appendix A: Additional Displays 
 

Display Options 

 

Toolbar 

Menu 
Bar 

Workspace 

Status Bar 



Toolbars 
The Toolbar below is the Standard Toolbar, it contains buttons for file management 
functions, printing, Cut/Copy & Paste and Font Sizes/ 
 

 
 
 
In addition, the Windows available (as mentioned above) can also be shown either as a 
simple icon or with their names alongside: 
 

 
 
Clicking any of these will add a new window to your desktop, and the appropriate toolbar 
for that window will be added to the top of the screen.  The different options on each of 
the toolbars will be covered under the relevant section. 
 
 
Whether or not these toolbars appear is controlled by the user, and the option to view 
toolbars is found under View, Toolbars.  It is also this option where settings for the Menu 
Bar and Status bar are kept. 
 
 

 
 
All Toolbar buttons have ToolTips associated with them which will appear after a couple 
of seconds of pointing at a given button. 
 



Menu Bar 
This can either be set to be permanently displayed or to only appear when the mouse 
pointer is moved over the title bar. 
 

Status Bar 
 The status bar can be turned on or off and set to display a number of pieces of 
information: 
 

 
 

Accessing Menu Options 
 
In Aspen, it is possible to access menu options in several different ways.  Using the 
mouse, a simple right-click on a window will display the quick menu, alternatively when 
a window has focus the options relating to that window will appear on the menu bar.  As 
has been mentioned before, there are a number of toolbars associated with the different 
windows, and most of the options are also available here. 
 
The fourth and final way is via keyboard shortcuts and commands.  Almost all keyboard 
commands should be prefixed by the full-stop to avoid confusion, however occasionally 
the full-stop can be omitted.  A list of the more commonly used keyboard commands is 
found in Appendix B: Keyboard Shortcuts. 
 
 

Managing the Desktop  
 
As Windows are added to the desktop they will (by default) be cascaded down the screen.  
Unless disabled, each window will have a title bar at the top which contains standard 
Microsoft windows buttons (Maximize, Minimize, Restore and Close).  If there are 
several windows on the desktop a quick way of organizing them neatly to fit is to use the 
Window, Tile Horizontally, or Tile Vertically option, note this will only work if title bars 



are displayed.  If different windows need to be sized and positioned independently then 
clicking and dragging on the border of a window will re-size and windows can be moved 
by dragging the Title Bar. 
 

Setup Options Dialog 
The Setup Options Dialog offers access to several features. Many of these features are 
global features that affect all windows for example. Other features may be feed specific.  
 

Miscellaneous 

 
 

o Display title bars on all windows – Toggles the display of Windows title bars for all 
windows. 

o Use Windows’ style menu – Toggles the menu style between Windows and Aspen’s 
3.71 styles. 

o Use Window’s standard mouse clicks – Toggles the mouse click style between 
Windows and Aspen’s 3.71 styles. 

o Use Window’s style edit boxes – Toggles the text boxes between Windows and 
Aspen’s 3.71 styles. 

o Use Symbol Aliasing – Toggles symbol aliasing on. Custom symbol aliases can be 



setup in Aspen and used in place of a feed’s regular symbol.  

o Snap to Grid – Causes windows to align to the workspace grid when moving or 
resizing. 

o Save prompt before closing – Toggles the display of the save prompt when closing 
Aspen.  

o Allow Fast Save from Toolbar – Toggles automatic overwrite when using the toolbar 
icons to save files. 

o Popup Titlebar Timer – Specifies the length of time the mouse must point at the top 
of an Aspen window before the title bar is displayed. Used only when Title Bars are 
disabled. 

o Auto Save every – Specifies a length of time in minutes that open pages are 
automatically saved.  

 
File Management 

About Aspen Pages and Aspen Windows  
 Aspen Graphics uses two file formats when saving and opening files. These file 
formats are Aspen Pages and Aspen Windows. An Aspen Page is a container of one or 
more Aspen Windows. An Aspen Page is the entire Aspen Graphics screen layout. An 
Aspen Window is a single chart, quote or news window. An Aspen Page can contain any 
number of such Windows. The Aspen Page below contains five windows, two chart 
windows, two quote windows and a news window.  
 



 
 

Saving Files 
 When saving files in Aspen care must be taken to ensure that the file is saved in 
the correct format. Aspen Pages and Aspen Windows are stored in separate sub 
directories.  Aspen Pages and Aspen Windows are also saved using a different process.  
 
Saving Pages 

Save an Aspen Page by left-clicking on the File Menu, then left-click Save 
Page.  



 
  
  

Enter a unique name in the Name field. You cannot use only symbols or numbers 
in naming pages; this will return an error message saying the name is reserved. Numbers 
and symbols can be used in combination with no conflict (e.g. - IBM_15 is a valid page 
name).  You also cannot use spaces in a page name; use the underscore ( _ ) instead. 

 
Select a folder from the choices available in the Create in: section. You may 

also create a new folder to store this page in. Click the New Folder button and, name the 
folder accordingly to create a new folder.  When you have selected (or created and 
named) the desired folder, click OK.  The software verifies that the page has been saved 
by displaying its name in quotes on the title bar. 
 
   



 
 
 

Saving Windows 
 Save an Aspen Window by left-click on the File Menu, then left-click Save 
Window. Aspen Windows must follow the same naming guidelines as Aspen Pages.  
 

Opening Files 
  Aspen Pages and Aspen Windows are stored in separate directories. Because of 
this, Aspen Pages and Aspen Windows must be opened using different processes.  
 

If you have difficulty in finding a previously saved file use both Open Page and 
Open Window. The file may have been accidentally saved as a Window when you 
intended to save it as a Page or vise versa. 

 
 

Opening Pages 
 Open an Aspen Page by Left-Clicking on File and selecting Open Page. This 
launches the Aspen Page Manager.  
 



 
 
 

Page Manager 

 
 

Page Manager Tool Bar 

Tool Bar 

Folders 

Page Files 



 
o Open Page - Opens the selected page in the Page Manager. 

o Import File – Allows the user to import existing Aspen Page files from directories 
other than the pages directory.  

o Rename File – Allows the user to rename the file in the Page Manager. 

o Delete File - Sends the selected file to the Recycling Bin.  

o New Folder – Creates and names a new folder in the pages directory. 

o Delete Folder – Deletes the selected folder.  

o Refresh – Refreshes the Page Manager contents.  

o Clear Screen - Removes and charts or quotes from the Aspen Graphics display.  
 

 

Opening Windows 
 Open an Aspen Window by left-clicking on File and select Open Window. This 
launches the Window Manager. 

Open Page 

Import File 

Rename File 

Delete File Refresh 

Clear Screen New Folder 

Delete Folder 



 
 

 
Window Manager 

 

 

Window Manager Tool Bar 

Tool Bar 

Folders 

Window Files 



 
o Open Window – Opens the selected Aspen Window file.  

o Import File – Allows the user to import existing Aspen Window files from directories 
other than the windows directory.  

o Rename File – Allows the user to rename the file in the Page Manager. 

o Delete File- Sends the selected file to the Recycling Bin.  

o New Folder – Creates and names a new folder in the pages directory. 

o Delete Folder – Deletes the selected folder.  

o Refresh – Refreshes the Page Manager contents.  

o Clear Screen - Removes charts or quotes from the Aspen Graphics display.  
 
 

 

 
o Chart – Opens a blank, default Chart Window in Aspen. 

o Quote – Opens a blank Quote Window in Aspen. 

o Equity – Opens an Aspen Equity window. 

o Time and Sales – Opens an Aspen Time and Sales window.  

o Clock – Opens an Aspen Clock Window. 

o Price Volume – Opens an Aspen Price Volume window. 

o Option Chart – Opens a default Option Chart Window in Aspen.  

o Volatility Skew – Opens a Volatility Skew Window in Aspen.  

Open Window 

Import File 

Rename File 

Delete File Refresh 

Clear Screen New Folder 

Delete Folder 

Chart 

Quote 

News 

Equity 

Time and 
Sales 

Price 
Volume 

Option 
Chart 
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Fixed 
Format 

Clock 



o Fixed Format – Opens the Platts Fixed Format Page Window in Aspen.  
 
 
 
 

Charts 
Adding a Chart 
 
If the Window Toolbar is visible then simply click the Chart button, alternatively choose 
File, New Window and select a chart from the list.  Both of these methods will add a 
default chart, that is to say a daily bar chart occupying a quarter of the screen. 
 

 
 
If more than one chart is required, repeat the process until all the charts are added.  These 
can then be arranged by choosing Window, Tile Horizontally, or Tile Vertically. 
 
Once all the charts are added, they can be populated by entering the symbols on each 
chart. 
 

Chart Toolbar 
The Chart Toolbar is enabled once a chart window is opened or created in Aspen. 

The Chart Toolbar contains commands for configuring the various charting features 
available in Aspen Graphics. 

 



  
o Refresh Data – Queries the server and fills in missing data on Aspen Servers. Refresh 

will only fill in missing data visible on the chart.  

o Add Symbol to Chart – Opens a text box for entering a symbol on the chart. 

o Expand Price Scale – Increases the details along the Price axis.  

o Compress Price Scale  - Decreases the details along the Price axis. 

o Move Chart Up – Moves the entire chart up.  

o Move Chart Down – Moves the entire chart down.  

o Auto Scale Price – Restores the default price scale for the chart. 
 

 
o Compress Time Scale – Decreases the details along the Time axis. 

o Expand Time Scale – Increases the details along the Time axis. 

o Shift Left – Moves the entire chart to the left. 

o Shift Right – Moves the entire chart to the right. 

o Auto Scale Time – Restores the default time scale for the chart. 

o Linear Scale – The price scale is set by an instrument's trading units, and the bar plots 
linearly along the scale. 

Refresh 
Data 

Add Symbol 
to Chart 

Expand Price 
Scale 

Compress Price 
Scale 

Move 
Chart Up 

Move Chart 
Down 

Auto Scale 
Price 

Compress 
Time Scale 

Expand 
Time Scale 

Shift 
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Shift 
Right 

Auto Scale 
Time 

Linear 
Scale 

Log 
Scale 

Percent 
Change Scale 



o Logarithmic Scale - Plotting prices on a logarithmic scale allows the presentation of a 
uniform picture of performance and permits the easy comparison of instruments that 
differ widely in dollar amount. 

o Percent Change Scale - Percent change charts are used to compare the percent change 
in price from the close of the left-most bar. 

 

 
o Time Scale – Opens a Drop-Down Menu containing popular time frames. Selecting a 

time frame will change the time frame for the chart. 

o Chart Type – Opens a Drop-Down Menu containing chart type options for Aspen. 
Selecting a chart type will change the current chart type.  

o Add Overlay – Opens a Drop-Down Menu containing indicators that can be displayed 
in the same window as the chart. Selecting an indicator will apply the indicator to the 
chart. 

o Add Study – Opens a Drop-Down Menu containing indicators that are displayed in a 
split window. Selecting an indicator will apply the indicator to the selected window. 

o Replace Study – Opens a Drop-Down Menu containing indicators and chart types. 
Selecting a menu item will remove the current indicator or chart type and replace it 
with the selection.  

o Add Split Study – Opens a Drop-Down Menu containing indicators that must be 
displayed in a split window. Selecting an indicator splits the chart and applies the 
indicator to the new split window.  

o Study Parameter – Opens a Drop-Down Menu containing the current indicators. 
Selecting a menu item will display the Parameters Dialog for the selected Item.  

 

Time 
Scale 

Chart 
Type 

Add 
Overlay 

Add 
Study 

Replace 
Study 
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Study 

Study 
Parameter



 
o Remove Study – Opens a Drop-Down Menu containing the indicators and charts in 

the window. Selecting an item from the menu removes it. 

o Remove All Overlays – Removes all the overlay indicators on the chart and leaves the 
underlying chart in place. 

o Remove Split – Removes the selected split window. 

o Table – Displays chart data as a table. 

o Properties – Displays the Chart Properties Dialog. 
 

 
o Trend Mode – Toggles Trend mode for drawing trend lines, Gann and Fibonacci 

features.  

o Add Layer – Adds a layer to the chart. 

o Remove Layer – Removes the selected layer from the chart. 

o Rotate Layers – Rotates the display of layers bringing layers from the back to the 
front.  

o Make Layers Transparent – Enables viewing off all the current chart layers. 

o Synchronize Layers- Opens a Drop-Down Menu containing items that can be 
synchronized between layers. 
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Chart Elements 

 
 

Cursor 
Window 

Current 
Price 

Time Scale Time Frame 

Price Scale 

Symbol Description 

Cursor 



Chart Properties Dialog 

 
 

o Symbol – Contains the current symbol on the chart. Symbols and formulas can be 
entered here. 

o Prefix – Contains any feed specific country prefixes.  

o Display Current Price – Enabling this option highlights the current price on the 
chart. 

o Display Title Bar – Toggles the display of title bars on chart windows. 

o Display Horizontal Scrollbars – Toggles the display of horizontal scrollbars.  

o Display Vertical Scrollbars – Toggles the display of vertical scrollbars. 

o Hide Grid Lines – Toggles the display of the background gridlines. 

o Display Horizontal Cursor – Toggles the display of the crosshair cursor.  

o Save As Default – Sets the current options as the default display for each new 
chart created.  

 



 
 

o Linear – The price scale is set by an instrument’s trading units, and the bar plots 
linearly along the scale. 

o Log – Compares percentage price changes rater than absolute price changes. 

o Percent Change – Compares the percent change in price from the close of the left-
most bar on the chart. 

o Width – Controls the database used to calculate the data. 

o Modifier – Controls the number of items selected in the Width option when 
calculating a bar. Not all Width options enable the Modifier Option.  

o Save As Default - Sets the current options as the default display for each new 
chart created.  

 



 
 

o Display bars for day session – Toggles the display of day session bars. 

o Display bars for night session – Toggles the display of night session bars for 
instruments that have a night session. 

o Remove gaps in chart – Toggles the display of any weekend or holiday gaps in 
the chart. 

o Include data outside market hours – Toggles the display of after hours market data 
for instruments that may be traded outside of market hours. 

o Calculate on each Tick – Enabling this causes Aspen to rebuild the current bar 
with each Tick. Disabling it causes Aspen to wait until the bar is completely built 
before updating the bar. 

o Span gaps with Last Price Used – Toggles the display of the last bars data over 
weekends and holiday gaps. 

o Display all of the trading times of all of the symbols – Creates a time scale that is 
an “intersection” of trading hours, or a period when the trading hours of the 
instruments in the formula overlap.  

o Save As Default - Sets the current options as the default display for each new 
chart created.  

 



 
 

o Background – Displays the color picker for changing the Background color. 

o Grid Lines – Displays the color picker for changing the Grid Lines color. 

o Scale – Displays the color picker for changing the Price and Time scale colors. 

o Border – Displays the color picker for changing the border color of the chart. 

o Description – Displays the color picker for changing the symbol name on the 
chart. 

o Label – Displays the color picker for changing the color of the current price 
highlight. 

o Cursor Date/Time – Displays the color picker for changing the color of the 
cursor’s date and time field. 

o Cursor Background – Displays the color picker for changing the background color 
of the cursor window. 

o  Save As Default - Sets the current options as the default display for each new 
chart created.  

 

 



 
 

o Method 1 Rollover – Changes roll over options for continuation ‘C1.  

o Method 1 Days – Specifies the number of days prior to expiration to roll the contract 
over for the ‘C1 continuation.  

o Method 1 Adjust – Toggles adjustment of gaps between old and new contracts for 
the ‘C1 continuation. 

o Method 2 Rollover – Changes roll over options for continuation ‘C2. 

o Method 2 Days – Specifies the number of days prior to expiration to roll the 
contract over for the ‘C2 continuation.  

o Method 2 Adjust – Toggles adjustment of gaps between old and new contracts for 
the ‘C2 continuation.  

o Save As Default - Sets the current options as the default display for each new 
chart created.  

 

 



 
 

o # of Cycles – Represents the number of seasons to break the chart into and display 
on the screen.  

o Cycle Length – Specifies the length of the cycle. 

o Cycle Units – Specifies the type of units used to break the chart into seasons.  

o Save As Default - Sets the current options as the default display for each new 
chart created.  

 

Entering Symbols 
 

Before any symbols can be entered it is important that the correct window has 
focus and if symbols are to be added to a quote list, then the cell into which the symbol 
needs to go is clicked.  If no cell in a quote list is selected then it will be entered into the 
first cell, overwriting whatever is there. 
 

To enter a symbol, simply begin typing. A textbox will appear containing the text 
you are typing. After typing the symbol press the enter key on your keyboard and Aspen 
will contact the server and begin to download data.  



 
 

Alternatively, the Add Symbol to Chart Icon or the Edit Symbols Icons can be used to 
enter symbols. Left-Click the appropriate icon, type in the symbol and press enter on your 
keyboard to add the instrument to the chart.  

 
 
A third method for entering symbols can be used on charts. Right-Click the chart and 
select Properties from the new menu. In the Chart Properties Dialog select the General 
Tab. Left-Click into the Symbol: Text Box and left-click on Apply and Ok when finished.  

 

Add Symbol to 
Chart Icon 

Edit Symbols Icon 



 
 

 
Calculations such as a spread or a multiplication to give weight to an instrument may also 
be entered as a symbol. In this case it is important to remember that some symbols use 
mathematical functions as part of the symbol code, and as such there is a danger of 
causing confusion in Aspen.  To avoid problems it is recommended that any symbols 
which contain such functions be enclosed in quotation marks and, in the case of Reuters 
RICs, made uppercase. Holding down the shift key while pressing the enter key 
automatically wraps the symbol string with quotation marks. This process does not work 
however, when performing math on two different symbols.  
 

“%EU30YT=RR”-“%EU10YT=RR”  
“HGX.X” 

 
 “%EU30YT=RR”-“%EU10YT=RR”  will display the difference between the Euro 30 year 
and 10 year government bond yields. 

 
To enter similar spreads (10’s 5’s, 10’s 2’s etc) onto different charts, rather than 
re-enter the whole string from scratch use the F12 function key to recall the last 
command typed and simply edit it. 

 
 
 



If a scroll region has been created then the symbols themselves cannot be typed directly 
into the quote page, instead they need to be entered into a list.  To add items to a list 
right-click the quote page and choose Edit Symbols.  The following dialog will appear: 
 

 
 
To enter the symbols type them into the input box and then click Add until all symbols 
are entered, then select Done. 
 

Handling Futures Contracts 
 
Given the ever-changing nature of futures contacts in terms of the month and year codes, 
maintaining these symbols manually on quote pages and charts would be a time-
consuming process. Aspen Graphics has a means of automating the process. Typically a 
futures contract has a symbol root followed by month and year code extensions. For 
Reuters and ComStock data there is a month code and a single digit year code, Bridge 
symbols have a double-digit year code followed by the month. 
 
Reuters and ComStock Bridge 
USmy – e.g USZ4 USyym – e.g. US04Z 
 
When automating the process in Aspen, we take the symbol root and then attach one of 
the following characters: 
 
#  - By itself this code will give us the front (nearest to expiration) contract irrespective 
of whether the contract is drawing to a close and the next month has higher volume. 
 
C# - This macro returns the front month for corn. 
 



#number – This will not look at the front month but the contract x number of months 
away, depending on whether a contract trades every month (serial contracts) or only 
quarterly. 
 
US#2 - Assuming the current contract is Sep06 and given that the 30 Year Long Bond 
trades quarterly this will give us prices for two quarters out i.e. Mar06 
 
@ - By itself this code will give us a chain of all currently traded contracts starting with 
the nearest to expiration. 
 
@HU – This macro returns all the contracts for unleaded beginning with the month nearest 
to expiration.  
 
@number – This will provide a chain of the next x number of contracts.  This is 
particularly useful when a contract trades many months into the future (for example 
Eurodollar and Crude Light) 
 
CL@8 – This will give us the next 8 Crude Light contracts. 
 

Continuing Contracts 
When looking at a long-term futures chart it is often not sufficient to simply look at the 
currently traded contract; there may be little or no activity in the current month. What is 
of more use is to see how the contract that was the front month at the time performed.  
For this we use continuous contracts. Continuations simply chart each contract, end-to-
end, based upon the expiration date of the contract.  
 
Depending on data vendor there are one or two types of Continuation Contract available 
to users of Aspen Graphics. Subscribers to Bridge, Reuters and to a limited extent 
PLATTS can make use of those data vendors proprietary continuous contracts.  
Irrespective of data vendor all Aspen Graphics users can use the Aspen Continuation 
charts. 
 
The continuous contracts offered by some data vendors are assigned a separate symbol – 
symbol root followed by ‘c1’ for Reuters and by ‘.1’ for Bridge. The data for the current 
contract is used as the source data for this symbol and updates at the same time, rolling to 
the next month upon expiration. 
 
For many users this will be sufficient; however there are a number of drawbacks to these 
proprietary contracts. First, the market often considers the next contract to be the front 
month several days prior to expiration of the current contract; and, secondly it may be 
desirable to exclude certain serial contracts and only include the quarterly ones, or 
specify exactly which months are used. 
 
By making use of the Aspen continuations both the above can be remedied.  The way in 
which Aspen builds its continuation charts is to take the underlying futures contract and 



string them together in a chain.  Because each contract has an expiration date, we can 
reference this and set the contracts to roll early; either by a fixed number of days, on the 
first trading day of expiration week, or the first trading day of expiration month.  Further, 
because we are referencing the underlying contracts we can state exactly which ones are 
to be used.  The sole disadvantage of using the Aspen continuation method is that the 
data cannot be plotted on an intra-day basis. 
 
Different types of futures may require separate handling in this regard and to that end we 
have two methods of continuous contracts available in Aspen. Again the symbol root is 
used followed by either ‘c1 (apostrophe c1) or ‘c2, for method one or method two.  
Exactly how methods one and two differ is controlled by the Continuations Settings 
menu option. 
 

 
 
For each method we can specify when to roll contracts and whether or not we want them 
adjusted.  To change the rollover method, click the drop-down list and make the 
selection.  When # Days before Expiration is selected the Days input box can be used to 
specify the number of days.  If Prior Month or Prior Week is used then any value in here 
is ignored. 
 
The Adjust option is used to ‘smooth’ any vertical price gaps that may appear when 
switching from one contract to another.  What Aspen does is to take the difference 
between the closing price of the out-going contract and the opening price of the incoming 
contract to obtain either a positive or negative value.  This value is then applied to the 
preceding bars, effectively smoothing out these price jumps. 
 
Having specified which continuation method to use, we can then specify which months 
are to be included in the continuation chart by simply typing the month codes. 
 



In the examples below continuation method 1 is set to 3 days before expiration without 
adjust and method 2 is set to Prior Month with adjust. 
 
ED’c1 – will produce a continuous chart of all Eurodollar contracts rolling 3 days before 
expiration. 
 
ED’c1HMUZ – will produce a Eurodollar continuous contract built from the quarterly 
(Mar, Jun, Sep and Dec) contracts, again rolling 3 days before expiration. 
 
PL’c2FJNV – will produce a Platinum continuation contract using its major months (Jan, 
Apr, Jul, and Oct) rolling on the first day of expiration month and adjusting for any price 
jumps 
 
One final advantage of using the Aspen continuations is that we are not limited to using 
the front month for the currently-used contract.  By suffixing a number to the end of the 
string we can take contracts x number of months (or quarters) in the future and have that 
popular the current bar. 
 
FEI’c1HMUZ2 – Given that the current nearest to expiration month is August 04 (the 
Euribor trades serially), this string will give us a continuation chart built only from the 
quarterly contracts, but looking two quarters in advance, so the current bar will be 
populated by March 05’s data.  Again because we have set continuation method 1 to roll 
three days early this will roll to take Jun 05 data on Friday 10 Sep 04 (September’s 
contract expires on 13 Sep). 
 

Entering Multiple Symbols 
 
A second symbol may be added to a chart either by entering the second symbol prefixed 
by a comma, or selecting the Add Symbol button from the Chart Toolbar. 
 
Further symbols can be added in exactly the same way for each one required, or to add 
them all at once, right-click the chart and select Properties.  In the Symbol input box of 
the general tab, the symbols required can all be added with commas between them. 
 
 



 
 
If multiple symbols for a futures contract are required then they should be entered as 
described in the section on Handling Futures Contracts above. 
 

Editing Symbols 
Once a symbol is entered onto a quote page, it can be changed simply by clicking on the 
symbol and amending the code.  If the quote page is a scroll region then the list of items 
can be modified by choosing Edit Symbols from the quick menu and either add additional 
symbols or remove them by clicking them on the left and column and choosing Delete 
 

 



Copy and Paste Symbols 
 
If the same (or similar) symbols need to be used on multiple windows, we saw above 
how using F12 enabled the last thing typed to be displayed.  However this will only work 
for the current session.  If Aspen is closed and then re-opened none of these will be 
remembered. 
 
We therefore have the ability to copy and paste symbols between windows. Simply place 
focus on the window from which you wish to copy, click the copy button (or CTRL+C), 
and then place focus on the new window.  Now click the paste button (or CTRL+V) and 
the symbol(s) will be copied. 
 
 

To apply the same codes to all open windows, prefix the code with a backslash 
\. 
 

 
\FGBL# - This will place the current German Bund in all open windows in the current 
Aspen session.  
 
 

 



Changing Timeframes 
 
Aspen has the ability to chart any intra-day timeframe plus daily, multi-day, weekly, 
monthly quarterly and yearly charts.  The smallest timeframe that Aspen can chart is a 
tick chart.  As each tick (bid, offer, trade etc) is received this is displayed as a single dot, 
with the high, low, open and close all of equal value.  To make a chart display ticks we 
set the timeframe to zero by either typing the number 0 <Enter> , clicking on the 
timeframe button or going through the menu, choosing Time Frame and selecting tick 
from the list: 
 

 
 
 

 - Timeframe Icon 
 
Due to the nature of ticks, it is important to note that the times on the x –axis will be non-
linear, one minute may contain no ticks and the next may have huge activity.  The more 
common time periods are listed in the drop-down list of times, but this is by no means 
exhaustive.  If a time period not listed is required simply type the number of minutes for 
each bar onto a chart.  Aspen can chart any time period from 0 minutes (ticks) to 1439 
minutes (one minute short of a day, but not recommended for the reasons given below).  
For daily-based charts the following commands should be used if typing: 
 
.DAY - For a daily chart 
 
.WEEK - For a weekly chart 
 
.MONTH - For a monthly chart 



 
.QUARTER - For a quarterly hart 
 
.YEAR - For a yearly chart 
 
Notice that there is a period before each of these commands. While not always absolutely 
necessary it is advisable to prefix commands with this. DAY is actually listed on NYSE, 
and, if entitled for this exchange, a user may find that opposed to changing the timeframe, 
it is actually the instrument being charted that gets changed! 
 

Aspen has the ability to display multi-day charts. To change the chart to a multi-
day chart, right-click the chart and choose Scale from the quick menu. In the 
dialog box choose Multi-Day from the width drop-down list and then enter the 

number of days in the input box: 
 

 
 
 

Timeframes and Performance 
 
Aspen is capable of displaying data in many customizable time frames. To increase 
performance, Aspen uses databases that are designed around three different time periods. 
These time periods are daily, 15 minutes and ticks. Daily, weekly, monthly and yearly 
time frames are built using the data from the Daily database. Intraday time frames that are 



multiples of 15 are built using the 15 minute database. Any other intraday timeframe is 
built using the tick database. 
 Using timeframes that pull from the tick database can be very resource intensive. 
User timeframes that fall close to a multiple of 15 should be specified as a multiple of 15. 
A 14 minute time frame is a good example of a user specified timeframe that should be 
specified as 15 minutes. In the case of a 14 minute chart, the Aspen Workstation must 
query the server for every tick in a 14 minute period and calculate the high, low, open 
and close price from that data. For heavily traded instruments this translates into tens of 
thousands of calculations and if a chart is attempting to display months of historical data 
this can translate into millions of calculations that must be performed prior to any data 
being sent. A 14 minute time frame will cause Aspen to run poorly. In contrast, if a 
workstation requests 15 minute data, the server simply replies with the high, low, open 
and close prices. No math calculations need to be performed. While any timeframe is 
possible in Aspen, some will perform better than others.  
 

Navigating Charts 
Aspen offers a number of methods for navigating charts. Moving forward or backward 
along the Time Scale and expanding or contracting the Time Scale can be accomplished 
in two ways.  
 
1. Use the Time Scale Navigation Icons.  
2. Place the Mouse Cursor over the Chart’s Time Scale and use the Mouse Wheel.  
 Simply rotating the Mouse Wheel will move the chart forward and backward in time. 
Rotating the Wheel Button while rotating the Wheel Button will expand or contract the 
Time Scale.  
 
The Price Scale can be navigated in a similar fashion.  
 
1. Use the Price Scale Navigation Icons. 
2. Place the Mouse Cursor over the Chart’s Price Scale and use the Mouse Wheel. 
Rotating the Mouse Wheel will move the chart up and down. Rotating the Wheel Button 
while rotating the Wheel Button will expand or contract the Price Scale.  
 

Chart Types 
Bar Charts 
 
By default, Aspen charts display bars. A bar is a line representing the trading range, with 
a hash mark on either side representing the open and last (or close): 
Traditionally, bars are created temporally--that is, the time base of the chart controls bar 
formation. In a fifteen minute chart, the trading day is sliced into fifteen minute periods, 



and the ticks that occur in a given fifteen minute period form the bar for that period. 
When the fifteen minute period ends, a new bar begins. 
There are several ways to display a bar chart in Aspen: 
 

Using Icons 
1. Select the chart by Left-Clicking on the Numerical Scale. 
2. Left –Click the Chart Type Icon  
3. Select Bar Chart: 

   

Using the Context Sensitive Menu 
4. Right Click the chart. 
5. Select Replace Study. 
6. Select Bar Chart. 

Using the Main Menu 
7. Left-Click Study in the Main Menu. 
8. Select Study. 
9. Left-Click Bar Chart. 

Using a Dot Command 
10. Type .bar <enter> 

 

Candlestick Charts  
 
Candlestick charts are an ancient Japanese price prediction methodology. Candlesticks 
date back to the 1700's, when they were used for analyzing rice markets. At that time, 
Munehisa Homma, a legendary rice trader, gained a huge fortune using candlestick 
analysis and established candlestick popularity. 
Aspen supports candlestick charting. Candles offer an alternate perspective on market 
data. 
  



Up Day Down Day 

  
  
The body of the candlestick is called the real body and represents the range between the 
open and closing prices. A "black," or filled-in, body represents that the close during that 
time period was lower than the open. When the body is "white," or hollow, the close is 
higher than the open.   
The thin vertical line above and/or below the real body is called the upper/lower shadow, 
representing the high/low price extremes for the period. 
 

Displaying Candlesticks 
 
There are several ways to display a Candlestick Chart in Aspen: 
 

Using Icons 
11. Select the chart by Left-Clicking on the Numerical Scale. 
12. Left-Click on the Chart Type Icon. 
13. Select the Candlesticks item from the Drop-Down Menu. 

   

Using the Context Sensitive Menu 
14. Right-Click on the chart. 
15. Select Replace Study. 
16. Select Candlesticks. 

Using the Main Menu 
17. Left-Click Study in the Main Menu. 
18. Select Replace Study in the Study Menu. 
19. Left-Click Candlesticks in the new menu. 



Using a Dot Command 
20. Type .cand <enter> 

 

Candlesticks Colors 
 
There are two methods for displaying the Candlesticks Parameters Dialog: 
 

Using Icons 
21. Select the chart by Left-Clicking on the Numerical Scale. 
22. Select the Parameters Icon.  
23. Select Candlesticks from the Drop-Down Menu.  

 

Using the Context Sensitive Menu     
  

24. Right Click the Candlestick Chart. 
25. Select Parameters… 

Using the Main Menu 
26. Left-Click Study in the Main Menu. 
27. Left-Click Parameters… in the Study Menu.  

Candlesticks Parameter Dialog 
 



 
 
 
The body of the Candlestick is represented by the Up and Down options. To change the 
color: 

28. Left-Click on the Item. 
29. Left-Click on the Color Box that appears.  
30. Left-Click on the new color in the Color Picker. 

 
31. Click Apply.  
32. Click Ok. 

 

Save as Default… 
The save as default option will store user preferences in Aspen. By selecting this option, 
all future Candlestick chart will automatically be configured with the specified color 
options.  
 
 



Point and Figure Charts 
Point and Figure Charts present another method for analyzing market data. Point and 
Figure charts display trend reversals through the use of X’s and O’s. An X is drawn on 
the chart to record upward price movements and an O is displayed for downward price 
movement. Each time a trend reverses, a new column is started. The user has control over 
sensitivity to trend reversal through choice of box size and reversal amount.  
 

 

Displaying a Point and Figure Chart 
Aspen offer three methods for displaying Point and Figure Charts.  
 

Using Icons 
33. Select the chart by Left-Clicking on the Numerical Scale. 
34. Left-Click the Chart Icon. 
35. Select Point & Figure.  

Box Size Reversal 



 
 

Using the Context Sensitive Menu 
36. Right –Click the chart. 
37. Select Replace Study. 
38. Left-Click Point Figure 

Using the Main Menu 
39. Left-Click Study in the Main Menu. 
40. Select Replace Study in the Study Menu. 
41. Left-Click Point Figure in the new menu.  

Using a Dot Command 
42. Type .p&f <enter> 

 
 

Point and Figure Parameters 
 
There are two methods for displaying the Parameters Dialog for a Point and Figure Chart: 

Using Icons 
43. Select the chart by Left-Clicking on the Numerical Scale. 
44. Left-Click on the Parameters Icon. 
45. Select the Point Figure option from the Drop-Down Menu. 

   

Using the Context Sensitive Menu 
46. Right-Click on the Point and Figure Chart. 
47. Select Parameters… 

 



 
 

o Box Size – Specifies the minimum price move which will draw either an X or O. 
A box size of 0.20 will draw an X every time the price gains 0.20 and an O every 
time the price drops 0.20.  

o Color – Specifies the colors of the X and O columns. 

o Reversal – Specifies the number of boxes necessary to reverse a trend. A reversal 
of 2 and a Box Size of 0.20 means that the price has to move 0.40 (2 x 0.20) 
opposite of the existing trend to plot a new column of X’s or O’s on the chart. 

o Method – There are three types of Point and Figure charts: Standard, Original and 
Daily. Standard and Original are very similar. Standard allows a minimum 
reversal amount of one, while Original allows a minimum reversal amount of two. 
Daily Point and Figure charts allow you to analyze historical data on a Point and 
Figure chart.  

o Save As Default - Sets the current options as the default display for each new 
chart created.  

 

Tic Charts 
 
Aspen offers two types of Tic Charts: 

48. Tic Over Time Charts 
49. Zero Minute Charts 



 

Tic Over Time Charts 
Tic charts differ from Bar and Candle Stick charts in that they plot a point at each price 
the instrument traded at during the specified interval.  
 

 
 

Displaying a Tic Over Time Chart 
Aspen offers three methods for displaying a Tic Over Time Chart: 
 

Using Icons 
50. Select the chart by Left-Clicking on the Numerical Scale. 
51. Left-Click the Chart Type Icon. 



52. Select Tic Chart from the Drop-Down Menu. 

 
 

Using the Context Sensitive Menu 
53. Right-Click the Chart. 
54. Select Replace Study 
55. Left-Click Tic Chart. 

Using the Main Menu 
56. Left-Click Study in the Main Menu. 
57. Select Replace Study. 
58. Left-Click Tic Chart 

Using a Dot Command 
59. Type .tic <enter> 

 

Zero Minute Charts 
Zero Minute Charts plot each trade at the time and price they occur. Zero Minute Charts 
do not have a regular time scale.  
 



 
 

Displaying a Zero Minute Chart 
 

Using Icons 
60. Select the chart by Left-Clicking on the Numerical Scale. 
61. Left-Click the Time Frame Icon. 
62. Select Tick from the Drop-Down Menu. 

 
 



Using a Dot Command 
63. Type 0 <enter> on any Bar, Tic or Candle Chart. 

 

Line Chart 
 
Line charts present another method for analyzing market data in Aspen. A line chart plots 
the closing prices for the underlying symbol and connects consecutive bars with a line.  
 

 
 

Displaying a Line Chart 
 
Aspen offers three methods for displaying a Line Chart: 
 

Using Icons 
64. Select the Chart by Left-Clicking on the Numerical Scale.  
65. Left-Click the Chart Type Icon. 
66. Select Line from the Drop-Down Menu. 



 
 

Using the Context Sensitive Menu 
67. Right-Click the Chart. 
68. Select Replace Study. 
69. Select Line Chart. 

Using the Main Menu 
70. Left-Click Study in the Main Menu. 
71. Select Replace Study in the Study Menu. 
72. Left-click Line chart in the new menu. 

Using a Dot Command 
73. Type .line <enter> 

 

Equitick Charts 
 
Aspen Graphics enables you to display bars that consist of a fixed number of trades per 
bar, in contrast to a bar chart which displays a fixed time frame for each bar.  Charts of 
this type are called Equi-tick charts. 
 



 
 

To Display an Equitick Chart 
Aspen offers three methods for displaying an Equitick chart. 
 

Using Icons 
74. Select the Chart by Left-Clicking on the Numerical Scale. 
75. Left-Click the Chart Type Icon. 
76. Select Equitick Bars from the Drop-Down Menu. 

 

 
 

Using the Context Sensitive Menu 
77. Right-Click the Chart. 
78. Select Replace Study. 



79. Select Equitick Bars. 

Using the Main Menu 
80. Left-Click Study in the Main Menu. 
81. Select Replace Study in the Study Menu. 
82. Left-Click Equitic Bars. 

Using a Dot Command 
83. Type .eqtick <enter> 

 

Equitick Settings 
Equitick users specify the number of ticks in a bar rather than a specific time frame. Type 
the number of ticks and press the enter key on the key board. Any positive integer may be 
entered to construct custom tick based bars.  
 

Layer Charts 
Layer Charts allow users to display multiple symbols on the same chart even when the 
price scales do not match. Layer charts allow users to analyze price movements of two or 
more related symbols that normally would have to be displayed in separate charts.  
 
The following example charts July ’06 contracts for heating oil, unleaded and sweet 
crude.  

 



 
 
To Display a Layered Chart 

84. Create a chart with the correct time scale and add the first instrument.   
85. Click the Add Layer Icon , the chart appears to go blank but what has 

happened is another chart with an identical timeframe has been placed on top of 
the first one. 

86. A second instrument can now be added and, if required, more layers and more 
instruments can also be added.  If too many layers are added then they can be 

deleted using the Remove Layer Icon . 
 

Navigating Layers 
 
 

 
 

o Add Layer – Adds a new layer to the chart. 

o Remove Layer – Removes the current active layer from the chart. 

o Rotate Layers – Rotates the active layer. Hidden layers can be made visible with 
this icon.  

o Make Layers Transparent – If different instruments are placed on each layer then 
their relative price movement can be viewed – irrespective of price ranges 

o Synchronize Layers – Locks price or time scales between layers. This allows all 
layers to be navigated simultaneously. 

 

Rotating Layers 
The instrument descriptions at the top of the chart appear in different colors, and the 
vertical price axis is color-coded to that instrument.  Clicking on a symbol name on the 
chart will change the price and color displayed on the price axis.  In the chart below, the 
Euro/Dollar spot rate is being compared with the Bund and the Euro 10 Year Yield Price. 
 

Add Layer 

Remove Layer 

Rotate Layers 

Make Layers 
Transparent 

Synchronize 
Layers 



 

Modifying Layers 
Individual layers can be modified similar to any chart in Aspen. Changes made to one 
layer can be made independent to the other layers being displayed. By left-clicking the 
appropriate description on the chart to select that layer, time frames, scaling and similar 
adjustments can be made to the selected layer.  
 
 

Synchronizing Layers 
By default all layers are independent of each other. If the chart is rescaled either 
horizontally or vertically, then the layer which has focus (indicated by the color of the 
vertical axis) will be changed.  Similarly if the time frame is changed, only the current 
layer will be affected. To ensure that all layers change simultaneously layers must be 
‘locked’. Options for locking are found by selecting the Synchronize Layers Icon. These 
options include: 

o Lock Time Frames 

o Lock Price Scale 

o Lock Date/Time 

o Lock Bar Spacing 

o Lock Study Type 
 
To unlock any of these, simply remove the check mark from the option. 
 



Layered Chart Limitations 
Although powerful, layered charts do have limitations. Layered charts cannot display 
indicators in Aspen Split Windows. Also, Aspen cannot display custom color rules when 
using Layered charts. Also, any color configured for Overlay Studies are lost when using 
Layered Charts. This can make Layered Charts with Overlays Studies difficult to read.  
 
Seasonal Charts 
<< INSERT BLOOMBERG CHANGES >>> 
 

Indicators 
 
Aspen offers many industry standard indicators. Indicators are separated into two types - 
Overlays and Studies. Overlays typically perform calculations whose value is similar to 
that of the price of the instrument being charted, for instance, averages and price 
envelopes. Studies on the other hand return values which work between certain levels, 
oscillate around zero, or contain values that are completely disparate to the price of the 
instrument. Typically Study Indicators are displayed in a Split Window; however, it is 
possible to layer both Overlay and Study Indicators in the same Split Window.  
 
Indicators can be used with any chart type.  
 
As with anything in Aspen, it is vital that the window to which the Overlay or Study is to 
be added has focus, the simplest way of doing this is to left-click the price scale. 
 
A complete list of Indicators and descriptions, their applications and Aspen’s calculation 
methods can be found in Appendix A. 
 

Indicator Related Icons 
 
 

 
 

Add 
Overlay 

Add 
Study 

Replace 
Study 

Add Study 
to New 

Add Study 
to New 



o Add Overlay – Displays a list of Overlay Indicators to overlay on top of the chart. 

o Add Study – Displays of list of Study Indicators designed to be displayed in a 
Split Window.  

o Replace Study – Displays a list of Study Indicators designed to be displayed in a 
Split Window. Selecting an Indicator will replace the current Indicator on the 
chart. 

o Add Study to New Split – Displays a list of Study Indicators designed to be 
displayed in a Split Window. Selecting a Study Indicator splits the window and 
adds the study to the new Split Window. 

o Add Study to New Layer – Displays a list of Study Indicators. Selecting an 
Indicator adds a transparent layer to the chart and overlays the Indicator on the 
chart, regardless of its status as an Overlay or a Study.  

 

 
 

 

o Study Parameters – Displays the Parameters Dialog for the selected Indicator. 

o Remove Study – Removes the selected Indicator. 

o Remove All Overlays – Removes all Overlays in the selected Window. 

o Remove Split – Removes the selected Split Window. 

o Split Chart – Adds a new Split Window to the chart. 
 

Adding an Overlay 
Aspen offers three methods for adding and displaying an indicator Overlay to a chart: 
 

Using Icons 
1. Select the chart by Left-Clicking on the Numerical Scale.  
2. Left-Click the Add Overlay Icon.  
3. From the Drop-Down Menu Left-Click the desired Indicator.  
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Using the Context Sensitive Menu 
1. Right-Click the chart. 
2. Select Add Overlay. 
3. Left-Click the desired Indicator. 

Using the Main Menu 
1. Left-Click Study in the Main Menu. 
2. Select Add Overlay in the Study Menu. 
3. Left-Click the appropriate Study name. 

Using a Dot Command 
1. Type the proper dot command and hit enter. The dot commands for each 

Indicator can be found in Appendix A. 
 

Adding a Study to a Split Window 
 
Study indicators are designed to be used primarily in a Split Window. Because of the 
difference in the numerical scale between many Studies and underlying price scales, 
Study Indicators do not always display well as an overlay. Popular Studies include the 
MACD, Stochastics and Volume Studies.  
 
Aspen offers a number of methods for displaying an indicator in a Split Window: 
 

Using Icons I 
1. Left-Click the Add Study to New Split icon. 



2. Select the appropriate Study from the Drop-Down Menu.  

3.  

Using Icons II 
1. Left-Click the Split Chart Icon.  
2. By default the new Split Window is selected. 

3. Left-Click the Add Study icon.  
4. Select the appropriate study. 

Using the Context Sensitive Menu 
1. Right-Click the Chart.  
2. Select Add Split for Study. 
3. Right-Click inside the new Split Window. 
4. Select Add Study. 
5. Left-Click the Appropriate Study. 



Using the Main Menu 
1. Left-Click Study in the Main Menu.  
2. Select Add Study in the Study Menu. 
3. Left-Click the appropriate Study name in the new menu. 

Using a Dot Command 
1. Type .split <enter> 
2. Type the proper dot command and hit enter. The dot commands for each 

Indicator can be found in Appendix A. 
 

Removing Indicators 
The processes for removing Studies and Overlays are similar. Aspen offers a couple of 
methods for removing Indicators: 
 

Using Icons 
1. Select the Chart or Split Window by Left-Clicking the Numerical Scale. 
2. Left-Click the Remove Study icon.  
3. Left-Click the appropriate study name to remove it. 

  

Using the Context Sensitive Menu 
1. Right-Click the Chart or Split Window. 
2. Select Remove Study. 
3. Select the appropriate study name from the new panel. 

Using the Main Menu 
1. Left-Click Study in the Main Menu. 
2. Select Remove Study in the Study Menu. 
3. Left-Click the appropriate Study name in the new menu. 

Removing Split Windows 
Split Windows can also be removed. When a Split Window is removed, all of the Studies 
contained in the Split Window are also removed. Aspen offers two methods for removing 
split windows: 
 



Using Icons 
1. Select the Split Window by Left-Clicking its Numerical Scale.  
2. Left-Click the Remove Split icon.  

Using the Context Sensitive Menu 
1. Right-Click the Split Window. 
2. Select Remove Split. 

Using the Main Menu 
1. Left-Click Chart in the Main Menu. 
2. Left-Click Remove Split in the Chart Menu. 

The Study Dialog 
The Study Dialog presents a convenient organization of indicators. The Study Dialog 
provides a user friendly method for managing Study and Overlay indicators. All available 
indicators are conveniently located and easily managed. The Study Dialog features an 
Explorer Style Navigation Panel and Filter controls. 
 



 
 

Displaying the Study Dialog 

Using the Context Sensitive Menu 
1. Right-Click the Chart. 
2. Left-Click Study Dialog… 

Using the Main Menu 
1. Left-Click Study in the Main Menu.  
2. Left-Click Study Dialog … in the Study Menu. 
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Using the Study Dialog 
The Study Dialog is a powerful and versatile tool. Like many operations in Aspen 
Graphics, the Study Dialog offers several methods to accomplish the same task. At the 
heart of this functionality lies the Study Explorer Panel. This panel displays a list of 
studies in a fashion that is similar to Windows Explorer. Each item category in the Study 
Explorer contains one or more studies.  
 
To display the list of studies associated with a category simply Left-Click the category 
name. Items with a + icon indicate the category contains sub-categories. Simply Left-
Click the + icon to expand these sub-categories and Left-Click the – icon to retract these 
sub-categories. The list of studies associated with a category or sub-category are 
displayed in the Study List Panel.  
 

Adding Studies and Overlays 
The Study Dialog offers three methods for adding an Overlay or Study to a chart: 
 

Using Icons 
1. Left-Click a Category in the Study Explorer to display a list of studies.  
2. Left-Click an indicator in the Study List Panel. 
3. Add the Selected Study. 

4. To Add an Overlay Left-Click the Add Study icon.  

5. To Replace a Study Left-Click the Replace Study icon.  
6. To Add the Study in a new Split Window Left-Click the Add Study to New 

Split Icon.  
7. To Add the Study to a new Layer Left-Click the Add Study to New Layer icon. 

 

Using the Context Sensitive Menu 
1. Left-Click a Category in the Study Explorer Panel. 
2. Right-Click a Study from the Study List Panel.  
3. Select Add a Study 
4. To Add an Overlay Left-Click on Add Study.  
5. To Replace a Study Left-Click on Replace Study. 
6. To Add the Study in a new Split Window Left-Click on Add Study to New 

Split. 
7. To Add the Study to a new Layer Left-Click the Add Study on New Layer. 

Using Point and Click 
1. Left-Click a Category in the Study Explorer Panel. 
2. Double Left-Click the appropriate Study in the Study List to add it. 



 

Trendlines 
Trendlines are another way of adding analytical displays to a chart. Unlike Overlays and 
Studies they are not constructed from mathematical functions, they are drawn on the chart 
itself, and the angle of the line used to produce values on subsequent bars. 
 

Entering and Exit ing Trend Mode 
In order to add Trendlines to a chart we must be in trend mode. Aspen offers several 
methods to switch to Trend Mode. Once in Trend Mode the Trend Mode Tool Bar 
appears. Trend Mode is a toggle mode. Trend Mode must be enabled to begin drawing 
Trendlines and Trend Mode must be exited to return to normal Aspen functionality. 
Actions that enable Trend Mode will also exit it if repeated while in Trend Mode.  
 
Trend Mode is also sensitive to the selected chart or Split Window. When entering Trend 
Mode, only the selected chart or Split Window is placed into Trend Mode. This allows 
users to draw trend lines on studies in Split Windows such as the MACD as well as the 
actual chart. Once in Trend Mode the mouse pointer graphic turns into a pencil. This 
graphic will only display for charts or Split Window.  
 

Using Icons 
1. Left-Click the Trend Mode Icon to enter or exit Trend Mode.  

 

Using the Context Sensitive Menu 
1. Right-Click on the Chart. 
2. Select Draw Trendlines. 
3. Left-Click Trend Mode. 

 

Using the Main Menu 
1. Left-Click Trend Lines. 
2. Left-Click Trend Mode.  

 

 The Trend Mode Tool Bar 
 



  
o Trend Line – Default mode for drawing point-to-point lines.  

o Horizontal – Draws a horizontal line at the selected point. 

o Horizontal Fibonacci – Draws Fibonacci retracements by selecting a high and low 
point. 

o Speed Lines – Draws speed lines by selecting a starting and ending point. 

o Gann Time/Price – Draws Gann Time and Price Lines by selecting two points. 

o Gann Square – Draws a Gann Square by selecting a high or low point. 

o Andrew’s Pitchfork – Draws an Andrew’s Pitchfork using points that form 
intersecting lines.  

 

  
o TD Rel – Draws a Thom DeMark Relative trend line study.  

o TD Abs – Draws a Thom DeMark Absolute trend line study. 

o TD Factor – Draws a Thom DeMark Trend Factor study. 

o TD Arc – Draws a Thom Demark Arc study. 
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o Pivot Trend Line – Toggles the ability to rotate the selected trend line. 

o Add Fibonacci Lines - Adds Fibonacci lines to the selected line by selecting a 
point above or below the trend line.  

o Add Parallel Line – Adds a parallel line by selecting a point above or below the 
trend line. 

o Add Linked Parallel Line – Adds a linked parallel line by selecting a point above 
or below the trend line. Changes made to one line will affect the other.  

o Extend Line – Extends the indefinitely into the future or past. 

  

  
o Truncate Line- Truncates lines that have been expanded.  

o Delete Line – Deletes the selected line. 

o Delete Trend Lines in a Group – Deletes all the lines in a selected group. 

o Delete All Lines – Deletes all trend lines on the chart. 

o Labels On/Off – Toggles the display of trend line labels. 
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o Snap On/Off – Toggles the price snap feature for drawing trend lines. Enabling 
this option will snap drawn lines to the closest price on a bar.  

o Trend Line Status Window – The Trend Line Status Window displays the exact 
price and time values for the end points of a trend line.  

o Fibonacci Options – Displays the Fibonacci Options Dialog.  

o Gann Options – Displays the Gann Options Dialog.  

o TD Options – Displays the Thom Demark Trend Studies Dialog. 
 

Freehand Mode 
By default, Aspen is in freehand trend mode, meaning that lines can be freely drawn 
between points.  The way in which a trend line is drawn, is to identify just two significant 
points. These can be two highs, two lows or a low and a high for example. Click and drag 
the pencil tip (not the eraser end) between the points and release the mouse button what 
must not be done is to drag the line through the second significant point and extend it on 
through to the price axis, this can cause problems when re-scaling as the second point has 
not been anchored on the chart itself. 
 

Drawing Horizontal Lines 
Aspen offers several methods for drawing horizontal lines. These methods are outlined 
below: 
 

Using Icons 
1. Enter Trend Mode. 

2. Left-Click the Horizontal icon.  
3. Left-Click a point on the chart to draw the line.  
4. Exit Trend Mode. 
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Using the Context Sensitive Menu 
1. Enter Trend Mode. 
2. Right-Click the chart. 
3. Select Horizontal. 
4. Left-Click a point on the chart to draw the line. 
5. Exit Trend Mode. 

Using the Main Menu 
1. Enter Trend Mode. 
2. Left-Click Trendlines in the Main Menu.  
3. Left-Click Horizontal in the Trendlines Menu. 
4. Left-Click a point on the chart to draw the line. 
5. Exit Trend Mode. 

Drawing Horizontal Fibonacci Retracements 
Aspen includes a number of configuration and drawing options for Fibonacci lines. Not 
only can Fibonacci lines be drawn in the more typical horizontal layout but also in 
diagonal formats.  
 
By default, Fibonacci lines are drawn with five lines. These five lines are at the 0%, 
38.20%, 50%, 61.80% and 100% ranges. However, these percentages may be configured 
and Fibonacci Extensions may be included as well.  

 

Using Icons 
1. Enter Trend Mode. 



2. Left-Click the Horizontal Fibonacci icon to toggle the Fibonacci drawing on. 

 
3. Left-Click a point to place the 0% line. Typically this is a low point.  
4. Left-Click a point to place the 100% line. Typically this is a high point.  
5. Exit Trend Mode. 

Using the Context Sensitive Menu 
1. Enter Trend Mode. 
2. Right-Click the Chart and Select Fibonacci to toggle the Fibonacci drawing on. 
3. Left-Click a point for the 0% line. Typically this is low point. 
4. Left-Click a point for the 100% line. Typically this is a high point.  
5. Exit Trend Mode. 

Using the Main Menu 
1. Enter Trend Mode. 
2. Left-Click Trendlines in the Main Menu. 
3. Left-Click Fibonacci to toggle the Fibonacci drawing on.  
4. Left-Click a point for the 0% line. Typically this is a low point. 
5. Left-Click a point for the 100% line. Typically this is a high point. 
6. Exit Trend Mode. 

Drawing Diagonal Fibonacci Retracements 
The process for drawing a diagonal Fibonacci begins by defining a 0% line. This is done 
by drawing a regular trend line. This new trend line will become the 0% line for the 
Fibonacci lines.  
 

Using Icons 
1. Enter Trend Mode. 
2. Draw the 0% Trend Line. 

3. Left-Click the Add Fibonacci Lines icon.  
4. Left-Click the point on the chart where the 100% line should be.  
5. Exit Trend Mode. 

Using the Context Sensitive Menu 
1. Enter Trend Mode. 
2. Draw the 0% Trend Line. 
3. Right-Click the new Trend Line.  
4. Left -Click on Fibonacci. 
5. Left-Click a point on the chart to place the 100% line. 
6. Exit Trend Mode. 

 



Fibonacci Options 
Fibonacci line percentages are completely customizable in Aspen. The Fibonacci Options 
dialog is used to customize these features. 0% and 100% lines are defined and drawn 
automatically. To remove a line, enter the value of 0.0. To add an extension, enter the 
extension value in the Line 4% and/or Line 5% text boxes. 
 
 

 
 

  
Predefined: Fibonacci -  
 

Line 1% defaults to 38.2 
Line 2% defaults to 50.0 
Line 3% defaults to 61.8 
Line 4% defaults to 0.0 
Line 5% defaults to 0.0 

Predefined: 1/3rds Line 1% defaults to 33.33 
Line 2% defaults to 66.66 
Line 3% defaults to 0.0 
Line 4% defaults to 0.0 
Line 5% defaults to 0.0 

Predefined: Custom Specify custom settings for percent levels. 
o Line % 1 - Reflects the value of Predefined setting. 

o Line % 2 - Reflects the value of Predefined setting. 



o Line % 3 - Reflects the value of Predefined setting.  

o Line % 4 - Reflects the value of Predefined setting.  

o Line % 5 - Reflects the value of Predefined setting.  

o Mirror - Reflects the line values to extend the Fibonacci retracements.  

Displaying the Fibonacci Options Dialog 
The following methods can be used to display the Fibonacci Options Dialog: 
 

Using Icons 
1. Enter Trend Mode. 

2. Left-Click the Fibonacci Options Icon.  
3. Apply the changes. 
4. Exit Trend Mode. 

Using the Context Sensitive Menu 
1. Enter Trend Mode. 
2. Right-Click the chart. 
3. Select Options. 
4. Select Fibonacci… 
5. Apply the changes. 
6. Exit Trend Mode. 

Using the Main Menu 
1. Enter Trend Mode. 
2. Left-Click Trendlines in the Main Menu. 
3. Left-Click Options. 
4. Left-Click Fibonacci… 
5. Apply the changes. 
6. Exit Trend Mode. 

 

Drawing Speed Lines 
Speed Lines help identify the rate of ascent or descent or a trend. The following methods 
can be used to draw Speed Lines: 



 

Using Icons 
1. Enter Trend Mode. 

2. Left-Click the Speed Lines icon.  
3. Left-Click the beginning of a trend on a chart.  
4. Left-Click the end of a trend on a chart.  
5. Exit Trend Mode. 

Using the Context Sensitive Menu 
1. Enter Trend Mode. 
2. Right-Click the Chart.  
3. Select Speed Lines. 
4. Left-Click the beginning of a trend on the chart. 
5. Left-Click the end of a trend on the chart.  
6. Exit Trend Mode. 

Using the Main Menu 
1. Enter Trend Mode. 
2. Left-Click Trendlines in the Main Menu. 
3. Left-Click Speed Lines in the Trendlines Menu. 
4. Left-Click at the beginning of a trend on the chart. 
5. Left-Click the end of a trend on the chart. 
6. Exit Trend Mode. 



Drawing Gann Time/Price Angles 
The Gann Time/Price Angles command displays a Gann fan. W. D. Gann used price and 
time to forecast market turns.  First, a market high is identified. The dollar amount of the 
high is converted into a calendar unit (i.e., days, weeks, months, or years). The calendar 
unit is projected forward to identify dates on which market turns may occur. 

 

Using Icons 
1. Enter Trend Mode.   
2. Left-Click the Gann Time/Price icon. 
3. Left-Click a low or high on the chart to define the beginning of the fan.  
4. Left-Click a high or a low to draw the fan. 
5. Exit Trend Mode. 

Using the Context Sensitive Menu 
1. Enter Trend Mode. 
2. Right-Click the chart. 
3. Left-Click Gann Time/Price. 
4. Left-Click a low or high on the chart to define the beginning of the fan. 
5. Left-Click a high or a low to draw the fan.  
6. Exit Trend Mode. 

Using the Main Menu 
1. Enter Trend Mode. 



2. Left-Click Trendlines in the Main Menu. 
3. Left-Click Gann Time/Price in the Trendlines menu. 
4. Left-Click a low or high on the chart to define the beginning of the fan. 
5. Left-Click a high or a low to draw the fan.  
6. Exit Trend Mode. 

Gann Time/Price Options 
The Gann Time/Price Options Dialog controls the display, angles and origins of the 
Angles. The following methods can be used to display the Gann Time/Price Options 
dialog: 
 

Using Icons 
1. Left-Click the Gann Options icon.  
2. Left-Click the Gann Angles tab in the Gann Options Dialog. 

Using the Context Sensitive Menu 
1. Right-Click the chart. 
2. Select Options. 
3. Left-Click Gann… 
4. Left-Click the Gann Angles tab in the Gann Options Dialog. 

Using the Main Menu 
1. Left-Click Trendlines in the Main Menu.  
2. Select Options in the Trendlines Menu. 
3. Left-Click in Gann… in the Options Menu.  
4. Left-Click the Gann Angles tab in the Gann Options Dialog. 

 
 



 
o  

o 1 x 8 – Toggles the display for 1 price unit for every 8 time units. 

o 1 x 4 – Toggles the display for 1 price unit for every 4 time units. 

o 1 x 2 – Toggles the display for 1 price unit for every 2 time units. 

o 1 x 1 – Toggles the display for 1 price unit for every 1 time units. 

o 2 x 1 – Toggles the display for 2 price units for each time unit. 

o 3 x 1 - Toggles the display for 3 price units for each time unit. 

o 4 x 1 – Toggles the display for 4 price units for each time unit. 

o 8 x 1 – Toggles the display for 8 price units for each time unit.  

o Upper Left – Toggles the upper left corner origin. 

o Upper Right – Toggles the upper right corner origin. 

o Lower Left – Toggles the lower left corner origin. 

o Lower Right – Toggles the lower right corner origin. 

o All – Select all Gann Angle toggles. 

o 8 x 8 Grid – Toggles a 8 x 8 grid. 

o 3 x 3 Grid – Toggles a 3 x 3 grid. 

o 1 Point Grid – Toggles a 1 point grid. 



o Border – Toggles the border display. 

 Drawing Gann Squares 
 A Gann square is a method of forecasting future support or resistance levels by counting 
forward from the all-time low or all-time high price of an instrument.  
 

 
The methods below can be used to display a Gann Square: 

Using Icons 
1. Enter Trend Mode. 

2. Left-Click the Gann Square icon.  
3. Left-Click a point on the chart to draw the square from. 
4. Exit Trend Mode. 

Using the Context Sensitive Menu 
1. Enter Trend Mode. 
2. Right-Click the chart. 
3. Left-Click Define Gann Square. 
4. Left-Click a point on the chart to draw the square from. 
5. Exit Trend Mode. 

Using the Main Menu 
1. Enter Trend Mode. 
2. Left-Click Trendlines in the Main Menu. 



3. Left-Click Define Gann Square in the Trendlines Menu. 
4. Left-Click a point on the chart to draw the square from. 
5. Exit Trend Mode. 

Gann Squares Options Dialog 
Use the Gann Squares option to set various Gann Square properties including Display 
Mode, Mesh Size, Time and Price Units. 

  
 

Display the Gann Squares Options Dialog using one of the following methods: 

Using Icons 
1. Enter Text Mode. 

2. Left-Click the Gann Options icon.  
3. Apply changes. 
4. Exit Trend Mode. 

Using the Context Sensitive Menu 
1. Enter Trend Mode. 
2. Right-Click the Chart. 
3. Select Options… 
4. Select Gann. 
5. Apply Changes. 



6. Exit Trend Mode. 

Using the Main Menu 
1. Enter Trend Mode. 
2. Left-Click Trendlines in the Main Menu. 
3. Select Options… 
4. Left-Click Gann… 
5. Apply Changes. 
6. Exit Trend Mode. 

Drawing Andrew’s Pitchfork 
Andrew’s Pitchfork was developed by Dr. Alan Andrews and employs three points. First, 
a line is drawn between a significant high and a significant low. This line is bisected, and 
the median of this line forms a base point for the second line, known as the median line. 
The fork is completed by identifying the second base point for the median line.  

 
 

Using Icons 
1. Enter Trend Mode. 

2. Left-Click the Andrew’s Pitchfork icon.  
3. Left-Click a high point. 
4. Left-Click the next low point.  
5. Left-Click a previous significant low. 
6. Exit Trend Mode. 



Using the Context Sensitive Menu 
1. Enter Trend Mode. 
2. Right-Click the chart. 
3. Left-Click Andrew’s Pitchfork. 
4. Left-Click a high point. 
5. Left-Click the next low point. 
6. Left-Click a previous significant low. 
7. Exit Trend Mode. 

Using the Main Menu 
1. Enter Trend Mode. 
2. Left-Click Trendlines in the Main Menu. 
3. Left-Click Andrew’s Pitchfork in the Trendlines Menu. 
4. Left-Click a high point. 
5. Left-Click the next low point. 
6. Left-Click a previous significant low. 
7. Exit Trend Mode. 

Drawing Thom Demark Relative Retracement 
TD relative Retracement is a purely objective or mechanical method for displaying 
Fibonacci retracement levels from designated lows and highs. These levels define areas 
of support or resistance. Retracement levels will appears as dashed lines until price 
penetrates them and is preceded by a qualified bar. Retracement levels are calculated as 
follows: from a low bar, refer to the last time a lower bar appeared and select the highest 
high between these two points and subtract the difference between those two points or 
from a high bar, refer to the last time a higher bar appeared and select the lowest low 
between these two points. By placing the cursor on these lows or highs and by selecting 
the desired Retracement settings, the levels are presented graphically.  
 

The Thom Demark Relative Retracement is an add-on subscription feature. This 
feature will appear as disabled unless it is purchased. 
 
A Left-Click is assumed to refer to the high, low, open or close of a displayed bar. Aspen 
locates the nearest such point and uses it as the exact reference point. Aspen finds the 
horizontally nearest bar column, then chooses the vertically nearest reference point within 
that column.  



 
 

Using Icons 
1. Enter Trend Mode. 

2. Left-Click the TD Rel icon.  
3. Left-Click the bar to draw the retracement from. 
4. Exit Trend Mode. 

Using the Context Sensitive Menu 
1. Enter Trend Mode. 
2. Right-Click the chart. 
3. Left-Click TD Rel Retracement. 
4. Left-Click the bar to draw the retracement from. 
5. Exit Trend Mode. 

Using the Main Menu 
1. Enter Trend Mode. 
2. Left-Click Trendlines in the Main Menu. 
3. Left-Click TD Rel Retracement in the Trendlines Menu. 
4. Left-Click the bar to draw the retracement from. 
5. Exit Trend Mode. 



Qualifying Relative Retracement 
By qualifying a retracement level, the probability of identifying a successful intraday 
breakout is enhanced if any of the following occur: 
 

1. The close of the prior bar to the upside (downside) penetration is down (up) 
versus the close two bars ago, OR 

2. The open of the first bar exceeds upside (downside) the retracement level, OR 
3. The difference between the previous bar’s close and its true low (true high and 

close) added to (subtracted from) the previous bar’s close is less than (greater 
than) the retracement level. A true high is that bar’s high or the close of the 
previous bar, whichever is greater. A true low is that bar’s low or the close of the 
previous bar, whichever is lesser.  

 
For further information on Thom DeMark Relative Retracement, please refer to Thomas 
R. DemMark, The Science of Technical Analysis, Ney York: John Wiley & Sons, 1994, 
Chapter 2. 
 

Drawing Thom DeMark Absolute Retracement 
Absolute Retracement is applied once a market’s price advance is at an all-time high or 
low. Consequently, Relative Retracement cannot be used since there is no reference point 
historically. Absolute Retracement is applied to the high bar or low bar. Retracement 
ratios will be displayed to the downside or upside and are used as support or resistance 
levels.  
 

The Thom Demark Relative Retracement is an add-on subscription feature. This 
feature will appear as disabled unless it is purchased. 
 
A Left-Click is assumed to refer to the high, low, open or close of a displayed bar. Aspen 
locates the nearest such point and uses it as the exact reference point. Aspen finds the 
horizontally nearest bar column, then chooses the vertically nearest reference point within 
that column.  



 
 

Using Icons 
1. Enter Trend Mode. 

2. Left-Click the TD Abs icon.  
3. Left-Click an all-time high or all-time low. 
4. Exit Trend Mode. 

Using the Context Sensitive Menu 
1. Enter Trend Mode. 
2. Right-Click the chart. 
3. Left-Click TD Abs Retracement. 
4. Left-Click an all-time high or all-time low. 
5. Exit Trend Mode. 

Using the Main Menu 
1. Enter Trend Mode. 
2. Left-Click Trendlines in the Main Menu. 
3. Left-Click TD Abs Retracement. 
4. Left-Click an all-time high or all-time low. 
5. Exit Trend Mode. 



Drawing Thom DeMark Trend Factors 
Trend Factors is designed to project upside resistance levels and downside support levels 
by multiplying qualified highs, lows, or closes by series of prescribed rations. 
 
Once the market has moved up approximately 1.0556 in price from a low, a reference 
high is identified. Place the study cross-reference on that high or high day close. The 
Trend Factors projects down to the support area of .9444, as well as secondary levels. 
Conversely, once a market has mobbed down to approximately .944 in price from a high, 
a reference low is identified. Place the study cross-reference on that low or low day close. 
The Trend Factors will project up to the resistance area of 1.0566, as well as secondary 
levels.  
 

The Thom Demark Relative Retracement is an add-on subscription feature. This 
feature will appear as disabled unless it is purchased. 
 
A Left-Click is assumed to refer to the high, low, open or close of a displayed bar. Aspen 
locates the nearest such point and uses it as the exact reference point. Aspen finds the 
horizontally nearest bar column, then chooses the vertically nearest reference point within 
that column.  
 

 
 

Using Icons 
1. Enter Trend Mode. 



2. Left Click the TD Fac icon.  
3. Left-Click a qualifying high or low.  
4. Exit Trend Mode. 

Using the Context Menu 
1. Enter Trend Mode. 
2. Right-Click the chart. 
3. Left-Click Trend Factor. 
4. Left-click a qualifying high or low. 
5. Exit Trend Mode. 

Using the Main Menu 
1. Enter Trend Mode. 
2. Left-Click Trendlines in the Main Menu. 
3. Left-Click Trend Factors. 
4. Left-Click a qualifying high or low. 
5. Exit Trend Mode. 

Drawing Thom DeMark Retracement Arcs  
TD Retracement Arc displays graphically, support and resistance levels which are 
defined by incorporating both price and time to establish retracement levels. TD 
Retracement Arc draws elliptical trendline curves .The anchor point and magnet price are 
determined in the same way as Relative Retracement. Also, the software calculates the 
distance (number of bars) from the anchor bar to the high or low bar whose close 
determines the magnet price. Then, the trendline curve for fraction F is a segment of a 
quarter ellipse starting horizontally at the anchor point, and ending vertically at price. The 
trendline curve terminates early if it touches a price bar before reaching the end point.  
 

The Thom Demark Relative Retracement is an add-on subscription feature. This 
feature will appear as disabled unless it is purchased. 
 
A Left-Click is assumed to refer to the high, low, open or close of a displayed bar. Aspen 
locates the nearest such point and uses it as the exact reference point. Aspen finds the 
horizontally nearest bar column, then chooses the vertically nearest reference point within 
that column.  



 
 

Using Icons 
1. Enter Trend Mode. 

2. Left-Click the TD Arc icon.  
3. Left-Click a bar to use as an anchor point. 
4. Exit Trend Mode. 

Using the Context Menu 
1. Enter Trend Mode. 
2. Right-Click the chart. 
3. Left-Click TD Arc. 
4. Left-Click a bar to use as an anchor point. 
5. Exit Trend Mode. 

Using the Main Menu 
1. Enter Trend Mode. 
2. Left-Click Trendlines in the Main Menu. 
3. Left-Click TD Arc. 
4. Left-Click a bar to use as an anchor point. 
5. Exit Trend Mode. 



Thom DeMark Trendline Property Dialog 
The properties for the various DeMark Trendline studies are managed from one dialog. 
Retracement and Factor values are enabled or disabled from this dialog. 

 

 
o Rel Retrace – Checking any item in this group enables the retracement level. 

Removing a check beside any item disables the level. 

o Abs Retrace- Checking any item in this group enables the retracement level. 
Removing a check beside any item disables the level. 

o TD Arc – Checking any item in this group enables the retracement level. 
Removing a check beside any item disables the level. 

o TD Factor – The Drop-Down boxes associated with the 1.0556 and .9444 values 
allows the High, Low, Open or Close price to be specified. Checking any item in 
this group enables the retracement level. Removing a check beside any item 
disables the level. 

Manipulating Trendlines 
Once drawn, Trendlines can be moved, resized and rotated. Paralel lines can be added 
and associated with a selected trend and Fibonacci lines can be added well. 

Moving Trendlines 

Using Icons 
1. Enter Trend Mode. 
2. Left-Click a Trendline to select it. 

3. Left-Click the Move Line icon.  
4. Use the mouse pointer to reposition the line. 
5. Left-Click to place the line. 
6. Exit Trend Mode. 



Using the Context Sensitive Menu 
1. Enter Trend Mode 
2. Right-Click a trendline to select it and display the menu. 
3. Left-Click Move. 
4. Use the mouse pointer to reposition the line. 
5. Left-Click to place the line. 
6. Exit trend mode. 

Using the Main Menu 
1. Enter Trend Mode. 
2. Left-Click a trendline to select it.  
3. Left-Click Trendlines in the Main Menu. 
4. Select Edit in the Trendlines Menu. 
5. Left-Click Move in the new menu. 
6. Use the mouse pointer to reposition the line. 
7. Left-Click to place the line. 
8. Exit Trend Mode. 

Using the Mouse 
1. Enter Trend Mode. 
2. Place the mouse over the line until the cursor changes into a hand. 
3. Left-Click and Drag the line to its new position 
4. Release the Left-Mouse button.  
5. Exit Trend Mode. 

Pivoting Trendlines 
Trendlines in Aspen can be rotated about points. This process is called Pivoting.  
 

Using Icons 
1. Enter Trend Mode. 
2. Left-Click the Trendline to select it.  
3. Left-Click the Pivot Trend Line icon.  
4. Left-Click a new point on the chart to redraw the line. 
5. Exit Trend Mode.  

Extending and Retracting Trendlines 
Trendlines in Aspen can be extended to be drawn indefinitely into the past or future. 
Trendlines that have been extended may also be retracted. Aspen offers several methods 
to accomplish both of these tasks. These methods are outlined below: 
 



Using Icons 
1. Left-Click the appropriate line to select it.  
2. Left-Click the Extend or Retract Trendline Icon to perform the operation. 

 

Using the Context Sensitive Menu 
1. Enter Trend Mode. 
2. Right-Click the Trendline.  
3. Select Extend to extend the line.  
4. Select Truncate to retract the line.  
5. The selection point on the line dictates which side of the line will be changed. If 

the selection is closer to the right hand point of the line, the right hand side will 
be extended or retracted. The same is true for selections that are nearer to the 
left hand side.  

6. Right-Click the Chart and Left-Click Exit Trend Mode.  
7. Exit Trend Mode. 

Using the Main Menu 
1. Enter Trend Mode. 
2. Left-Click the appropriate line to select it.  
3. Left-Click Trendlines in the Main Menu.  
4. Select Edit. 
5. Left-Click Extend to extend the line.  
6. Left-Click Truncate to retract the line.  
7. Left-Click Trendlines in the Main Menu. 
8. Left-Click Exit Trend Mode in the Trendlines Menu. 
9. Exit Trend Mode. 

Using the Mouse 
1. Enter Trend Mode. 
2. Double-Click the end of the line you wish to Extend or Truncate.  
3. Exit Trend Mode. 

Adding Parallel Lines 
Using the Parallel Line feature will draw a line parallel to the selected line. These lines 
can be moved independently.  

Using Icons 
1. Enter Trend Mode. 
2. Left-Click a trendline to select it.  

3. Left-Click the Parallel Lines icon to activate it.  
4. Left-Click a position on the chart to draw the new line.  
5. Exit Trend Mode.  



Using the Context Sensitive Menu 
1. Enter Trend Mode. 
2. Right-Click a trendline to select and display the menu.  
3. Left-Click Parallel. 
4. Left-Click a position on the chart to draw the new line. 
5. Exit Trend Mode. 

Using the Main Menu 
1. Enter Trend Mode. 
2. Left-Click a trendline to select it. 
3. Left-Click Trendlines in the Main Menu. 
4. Select Edit. 
5. Left-Click Parallel. 
6. Left-Click a position on the chart to draw the new line. 
7. Exit Trend Mode. 

Adding Linked Parallel Lines 
Using the Linked Parallel Line feature will draw a line parallel to the selected line. These 
lines cannot be moved independently.  

Using Icons 
1. Enter Trend Mode. 
2. Left-Click a trendline to select it.  

3. Left-Click the Parallel Lines icon to activate it.  
4. Left-Click a position on the chart to draw the new line.  
5. Exit Trend Mode.  

Using the Context Sensitive Menu 
1. Enter Trend Mode. 
2. Right-Click a trendline to select and display the menu.  
3. Left-Click Parallel. 
4. Left-Click a position on the chart to draw the new line. 
5. Exit Trend Mode. 

Using the Main Menu 
1. Enter Trend Mode. 
2. Left-Click a trendline to select it. 
3. Left-Click Trendlines in the Main Menu. 
4. Select Edit. 
5. Left-Click Parallel. 
6. Left-Click a position on the chart to draw the new line. 
7. Exit Trend Mode. 

 



Deleting Lines 
Aspen Graphics offers a number of techniques for removing trendlines. Both individual 
and groups of trendlines may be removed. This allows the user to have both control and 
efficiency.  
 

Deleting a Single Line 
This command deletes the selected trendline. In the case of grouped lines such as 
Fibonacci or Speed Lines, the selected line is deleted, not the entire group.  
 

Using Icons 
1. Enter Trend Mode. 
2. Left-Click the trendline to select it. 
3. Left-Click the Delete Line Icon. 
4. Exit Trend Mode. 

Using the Context Sensitive Menu 
1. Enter Trend Mode. 
2. Right-Click the trendline to select it and display the menu. 
3. Left-Click Delete Line. 
4. Exit Trend Mode. 

Using the Main Menu 
1. Enter Trend Mode. 
2. Left-Click Trendlines in the Main Menu. 
3. Select Edit in the Trendlines Menu. 
4. Left-Click Delete from the new menu. 
5. Exit Trend Mode. 

Delete a Group of Lines 
This command deletes an entire group of lines. This is useful for removeing entire 
Fibonacci retracements, speed lines and any trendline that is displayed as a group of lines. 
 

Using Icons 
1. Enter Trend Mode. 
2. Left-Click a trendline in the group to select it. 
3. Left-Click the Delete Trend Lines in a Group icon. 
4. Exit Trend Mode. 

Using the Context Sensitive Menu 
1. Enter Trend Mode. 



2. Right-Click a line in the group to select it and display the menu. 
3. Left-Click Delete Trend Group. 
4. Exit Trend Mode. 

Delete All Trend Lines 
This command quickly removes all the trendlines currently displayed on the chart. 
 

Using Icons 
1. Enter Trend Mode. 
2. Left-Click the Delete All Lines icon. 
3. Exit Trend Mode. 

Using the Context Sensitive Menu 
1. Enter Trend Mode. 
2. Right-Click the chart. 
3. Left-Click Delete All. 
4. Exit Trend Mode. 

Using the Main Menu 
1. Enter Trend Mode. 
2. Left-Click Trendlines in the Main Menu. 
3. Left-Click Delete All in the Trendlines Menu. 
4. Exit Trend Mode. 

 

Annotating Charts 
Aspen Graphics allows users to add their own annotations to charts. This is particularly 
useful if the charts are being used for publication or distribution. Aspen offers a number 
of options when displaying text on a chart. These include textbox graphics, font colors 
and more.  



 
 

Entering Text Mode 
In the same way that Aspen needs to be in trend mode to add trendlines, Aspen also needs 
to be in text mode to add text.  

Using the Context Sensitive Menu 
1. Right-Click the chart. 
2. Select Draw Text. 
3. Left-Click Text Mode. 

Using the Main Menu 
1. Left-Click Text in the Main Menu. 
2. Left-Click Text Mode in the Text Menu. 

 

Adding Text 
Text Mode in Aspen Graphics will place the text inside a textbox. The textbox is 
anchored to a position in the chart during creation. The position may be on a bar or any 
other position in the chart.  

Using the Context Sensitive Menu 
1. Enter Text Mode. 
2. Right-Click the chart. 



3. Left-Click Add Text. 
4. Left-Click a bar to attach the text to.  
5. Enter the Text. 
6. Press the Enter key to add the text. 
7. Exit Text Mode. 
8. Right-Click the chart. 
9. Select Draw Text. 
10. Left-Click Show Text. 

Using the Main Menu 
1. Enter Text Mode. 
2. Left-Click Text in the Main Menu. 
3. Left-Click Add Text in the Text Menu. 
4. Left-Click a bar to attach the text to.  
5. Enter the Text. 
6. Press the Enter key to add the text. 
7. Exit Trend Mode. 
8. Left-Click Text in the Main Menu. 
9. Left-Click Show Text. 

 

Changing Text Parameters 
The Text Parameters Dialog is used to control the look of text annotations on a chart.  

 
 

o Border – Toggles the display of a border around the textbox. 



o Fill Color – Sets the background color for the textbox. 

o Line Color- Sets the color for the line attached to a point. 

o Text Color – Sets the color for the text. 

o Line Style – Sets the display format of the line. 

o Line Width – Sets the Width of the line in pixels. 

o Price – Indicates the price at the point the textbox was initially positioned. This 
price may be changed here. 

o Time – Indicates the time at the point the textbox was initially positioned. This 
time may be changed here. 

o Save As Default - Sets the current options as the default display for each new 
chart created.  

 

 

Displaying the Text Parameters 

Using the Context Sensitive Menu 
1. Enter Text Mode. 
2. Right-Click a Text item. 
3. Left-Click Parameters… 
4. Apply changes. 
5. Exit Text Mode. 

Using the Main Menu 
1. Enter Trend Mode. 
2. Left-Click a Text item to select it. 
3. Left-Click Text in the Main Menu. 
4. Left-Click Parameters… in the Text Menu. 
5. Apply changes. 
6. Exit Trend Mode. 

 

Quotes 
Quotes differ from charts in that the offer no historical data. Unlike charts however, 
quotes are capable of displaying more information than simple high, low, open and close 
values. Quotes can also be configured to display in a ticker type display. Quotes are not 
limited to the codes directly supported by Aspen. Formulas can also be displayed in quote 
windows.  



Quote Properties Dialog 

 
 

o Display Title Bar – Toggles the display of the Title Bar for the selected Quote 
Window. 



 
 

o Background – Displays the Color Picker for changing the Background color of the 
Quote Window.  

o Alternate BG – Displays the Color Picker for changing the Alternate Background 
color of the Quote Window. 

o Grid Lines – Displays the Color Picker for changing the Grid Lines color when in 
Modify Layout mode. 

o Cursor – Displays the Color Picker for changing the Cursor color. 

o Text – Displays the Color Picker for changing the Text color.  

o Highlight Cell – Displays the Color Picker for changing the Highlight Cell color. 
Cells are highlighted when values change.  

o Highlight Text – Displays the Color Picker for changing the Highlight Text color. 
Text is highlighted when the associated value changes. 

o Label – Displays the Color Picker for changing the Label color. 

o Symbol – Displays the Color Picker for changing the Symbol color. 

o Locked – Displays the Color Picker for changing the Locked color. Locked fields 
cannot be changed by a user. 

o High – Displays the Color Picker for changing the High color. Fields such as Net 
Change use High to indicate a positive change in value. 



o Low – Displays the Color Picker for changing the Low color. Fields such as Net 
Change use Low to indicate a negative change in value. 

o True – Displays the Color Picker for changing the True color. 

o True – Displays the Color Picker for changing the False color.  

o Restore Default Colors – Returns all changed color parameters to the system 
defaults.  

 

Understanding Quotes in Aspen 
Quotes in Aspen are usually displayed in white. When quotes appear in another color, it 
is a signal that something is special about that quote.  
 

Quote Type Description 
Yellow New Tick 
A Red Last Price A New Daily Low 
A Green Last Price A New Daily High 
A Red Net Change Down from yesterday’s close 
A Green Net Change Up from yesterday’s close 
Highlighted (displayed on a black 
background) 

New or just recalculated 

 
Last prices are followed by symbols that provide additional information about the price: 

Symbol Example Definition 
A 98.60a Ask 
B 98.60b Bid 
↑ 98.60↑ Up Tick 
↓ 98.60↓ Down Tick 

Quote Code Variables 
Aspen Graphics uses Quote Code Variables as place holders. These variables appear in 
the $1, $2, $3… format. A variable in Aspen is a reference to the symbol. Code 
Codes can be used to pull specific information from the underlying symbol. The variable 
$1 and the Code .Last, used as $1.Last, will display the price for the last trade on the 
symbol.  
 
Quote pages are used to display information relating to multiple symbols simultaneously. 
The Quote Code Variables facilitate this behavior. These variables, or place holders, may 
only be seen in Free Form Quote Window while in Modify Layout mode. A variable is 
usually associated with a row or a column in a Quote Window. Each Row or Column is 
associated with a Quote Code Variable.  
 



 
 

 
 
 

Opening Pre-Defined Quote Windows 
A number of pre-defined quote windows ship with Aspen Graphics. These windows are 
data vendor specific and relate to specific industries. Aspen also offers methods for 
creating blank Quote Windows pre-formatted with popular fields. Aspen features three 
types of quote windows: Quote Grids, Quote Boards and Free Form Quote Windows. 
Quotes Grids and Quote Boards are preconfigured with elements that are commonly used 
in Quote Windows. Outside of symbols, Quote Grids and Quote Boards cannot be 
modified.  

Using Icons 
1. Left-Click the Open Window Icon.  
2. Left-Click the Quotes folder in the Window Manager to open it. 
3. Double-Click the appropriate Aspen Window file to open it. 
4. Close the Window Manager. 

Using the Context Sensitive Menu 
1. Clear the screen by Left-Clicking the Clear Screen icon.  
2. Right-Click the Aspen Workspace. 



3. Left-Click Open Window… 
4. Left-Click the Quotes folder in the Window Manager to open it. 
5. Double-Click the appropriate Aspen Window file to open it. 
6. Close the Window Manager. 

Using the Main Menu 
1. Left-Click File on the Main Menu. 
2. Left-Click Open Window… 
3. Left-Click the Quotes folder in the Window Manager to open it. 
4. Double-Click the appropriate Aspen Window file to open it.  
5. Close the Window Manager. 

Displaying a Quote Grid Window 
Quote Grid Windows displays quote information in rows. Each row contains the Open, 
High, Low, Net Change and Last for each symbol entered. A Quote Grid Window uses 
the Format Rows format.  
 

 

Using Icons 
1. Left-Click the Quote icon.  
2. Left-Click Quote Grid from the Quote Drop-Down Menu. 

Using the Context Sensitive Menu 
1. Right-Click a portion in the Aspen Graphics Workspace that does not currently 

contain an Aspen Window. 
2. Select New Window… 
3. Select Quote… 
4. Left-Click Quote Grid. 

Using the Main Menu 
1. Left-Click File from the Main Menu. 
2. Select New Window… 
3. Select Quote… 
4. Left-Click Quote Grid. 



Displaying a Quote Board Window 
Quote Grid Windows displays quote information in columns from left to right. Each 
column displays the symbol’s Open, High, Low, Net Change and Last for each symbol 
entered. A Quote Board Window uses the Format Columns format.  

 

Using Icons 
1. Left-Click the Quote icon.  
2. Left-Click Quote Board from the Drop-Down Menu.  

Using the Context Sensitive Menu 
1. Right-Click a portion in the Aspen Graphics Workspace that does not currently 

contain an Aspen Window. 
2. Select New Window… 
3. Select Quote… 
4. Left-Click Quote Board. 

Using the Main Menu 
1. Left-Click File from the Main Menu. 
2. Select New Window… 
3. Select Quote… 
4. Left-Click Quote Board. 

 

Entering Symbols 
Adding symbols to an Aspen Quote Window works similarly to the methods used to add 
symbols to a chart. The exception is that a .Symbol field must be selected and the Quote 
Window must not be in Modify Layout mode. 
 



 
 
 

Using Icons 
1. Left-Click the Edit Symbols icon.  
2. Type the symbol. 
3. Press the <Enter> key on the keyboard to add the symbol and automatically 

move to the next row or column. 

Using the Context Sensitive Menu 
1. Right-Click a quote window. 
2. Left-Click Edit Symbols. 
3. Type the symbol. 
4. Press the <Enter> key on the keyboard to add the symbol and automatically 

move to the next row or column.  

Using the Main Menu 
1. Left-Click Quote in the Main Menu. 
2. Left-Click Edit Symbols in the Quote Window. 
3. Type the symbol. 
4. Press the <Enter> key on the keyboard to add the symbol and automatically 

move to the next row or column.  

Using the Mouse 
o If the format is Format Columns:  

1. Left-Click a row under a Symbol column to select the row to edit. 
2. Type the symbol. 
3. Press the <Enter> key on the keyboard to add the symbol and automatically 

move to the next row.  



o If the format is Format Rows:  
1. Left-Click a column beside a Symbol row to select the column to edit. 
2. Type the symbol. 
3. Press the <Enter> key on the keyboard to add the symbol and automatically 

move to the next column.  

 

Creating a Free Format Quote Window 
Aspen Free Format Quote Windows offer the most control of the Quote Window types. 
Aspen Fee Format offers greater flexibility in the arrangement of data and offers fields 
that are not available in Quote Grid or Quote Board Windows.  
 
Free Form Quote Windows are initially displayed in Modify Mode. Cells in a Free 
Format Quote Window are represented by a grid. Left-Click a square in the grid to select 
a cell to select it. 

 
 

Using Icons 
1. Left-Click the Quote icon.  
2. Left-Click Free Format Quote from the Drop-Down Menu. 

Using the Context Sensitive Menu 
1. Right-Click a portion in the Aspen Graphics Workspace that does not currently 

contain an Aspen Window. 
2. Select New Window… 
3. Select Quote… 
4. Left-Click Free Format Quote. 

Using the Main Menu 
1. Left-Click File from the Main Menu. 
2. Select New Window… 
3. Select Quote… 
4. Left-Click Free Format Quote. 



 

The Quote Code Dialog 
The Quote Code Dialog contains the quote codes that are appended to a symbol place 
holder. The Quote Code Dialog features a Windows Explorer like Pane and Description 
Panel. The Quote Code Dialog may include codes that are vendor specific.  
 

Displaying the Quote Code Dialog 
The Quote Code Dialog automatically displays when creating a Free Form Quote 
Window. The methods below can be used to display the Quote Code Dialog when 
modifying an existing Free Form Quote Window. Quote Grid and Quote Board Windows 
cannot be modified.  

Using Icons 

1. Left-Click the Modify Layout icon.  

2. Left-Click the Quote Codes icon.  

Using the Context Sensitive Menu 
1. Right-Click the Free Form Quote Window. 
2. Left-Click Modify Layout. 
3. Right-Click the Free Form Quote Window. 
4. Left-Click Quote Code List… 

Using the Main Menu 
1. Left-Click Quote in the Main Menu. 
2. Left-Click Modify Layout in the Quote Menu. 
3. Left-Click Quote in the Main Menu. 
4. Select Modify Layout in the Quote Menu. 
5. Left-Click Quote Code List… in the new menu. 



Using the Quote Code Dialog 

 
 

o Quote Code List – Displays the Quote Codes associated with a selected category 
in the Quote Code Explorer. 

o Quote Code Explorer – Displays a list of Quote Code Categories. Categories may 
be data vendor specific.  

o Variable Field – Increments or decrements the variable place holder for symbols. 

o Label – Toggles adding a label when adding a quote code. 

o Symbol – Toggles adding a symbol when adding a quote code.  

o Custom – Adds a custom label or formula. 

o Edit Filter – Enables a field for filtering quote codes in the Quote Code Explorer 
using text. 

o Filter – Enables or disables filtering of the items in the Quote Code Explorer. 

 

Using Icons 
1. Left-Click a Cell on the Free Form Quote Window to select the cell. 
2. Left-Click a Category in the Quote Code Explorer to display a list of Quote 

Codes.  
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3. Left-Click a Quote Code in the Quote Code List Panel to select a code. 

4. Left-Click the Add to Quote icon.  

Using the Context Sensitive Menu 
1. Left-Click a Cell on the Free Form Quote Window to select the cell.  
2. Left-Click a Category in the Quote Code Explorer Panel. 
3. Right-Click a Quote Code from the Quote List Panel.  
4. Let-Click Add Symbol or Add Label & Symbol 

Using Point and Click 
1. Left-Click a Cell on the Free Form Quote Window to select the cell. 
2. Left-Click a Category in the Quote Code Explorer Panel. 
3. Double Left-Click the appropriate Study in the Study List to add it. 

 
 

The Quote Window Toolbar 
 
 

 
o Edit Symbols – Opens the first cell in the page for symbol editing. Available 

outside of Modify Layout mode. 

o Delete All Quote Codes – Removes all the Quote Codes on the window. 
Available in Modify Layout mode. 

o Edit Cells – Selects and opens the first cell for editing. Available outside of 
Modify Layout Mode. 

o Align Strikes – Centers Option Strike prices At the Money. Available outside of 
Modify Layout Mode.  
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o Lock Volatility –  

o Volatility Skews- 

o Options Books – Opens the Options Books Dialogs. Available in all Quote 
modes. 

o Option Parameters – Opens the Options Parameters Dialog. Available in all Quote 
modes. 

 

 
 

o Parameters – Opens the Parameters Dialog. Available in all Quote modes. 

o Modify Layout – Toggles Modify Layout mode. Available only for Free Form 
Quote Windows. 

o Clear Cell – Deletes the cell contents. Available only in Modify Layout mode.  

o Clear Group- Deletes a related set of cell contents. Available only in Modify 
Layout mode. 
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o Clear All Symbols – Removes all symbols from the window. Available outside of 
Modify Layout mode. 

o Right Justify – Aligns codes to the left. Available in Modify Layout mode. 

o Left Justify – Aligns codes to the right. Available in Modify Layout mode. 

o Fill Down – Creates new rows below the lowest numerically valued variable. 
Available in Modify Layout mode. 

 

 
o Fill Right – Creates new columns to the right of the lowest numerically valued 

variable. Available in Modify Layout mode. 

o Scroll Down – Creates a ticker like vertical scrolling action. Available in Modify 
Layout mode. 

o Scroll Right – Creates a ticker like horizontal scrolling action. Available in 
Modify Layout mode. 

o Format Rows – Newly added Quote Codes will be added from top to bottom. 
Available in Modify Layout mode.  

 

 

Clear All 
Symbols 

Left 
Justify 

Right 
Justify 

Fill 
Down 

Fill 
Right

Scroll 
Down 

Scroll 
Right 

Format 
Rows 



 
 

o Format Columns – Newly added Quote Codes will be added from left to right. 
Available in Modify Layout mode. 

o Quote Code List – Toggles displaying the Quote Codes Dialog. Available only in 
Modify Layout mode. 

o Auto Column Width – Automatically formats column widths. Available in Quote 
Grid and Quote Board Windows. 

o Grid Lines – Displays a grid outlining row and column borders. Available in 
Quote Grid and Quote Board Windows.  

 

Adding Formulas or Text to a Quote Window 
Free Format Quote Windows are not limited to the quote codes found in the Quote Code 
Dialog. User defined text and formulas may also be displayed in a cell. Custom text 
based headers must be wrapped in quotation marks. Formulas must be wrapped in a 
chart() function. More information concerning the chart() function can be found in the 
chapter on Formulas. Text and Formulas are entered into a cell using the Cell Insert 
Window.  
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Using Icons 
1. Enter Modify Layout mode. 
2. Left-Click the cell in which the field should appear.  
3. Left-Click the Custom icon.  
4. Enter the custom text header or formula. 
5. Press the <enter> key on the keyboard.  
6. Exit Modify Layout mode. 

 

Using the Keyboard 
1. Enter Modify Layout mode. 
2. Left-Click the cell in which the field should appear. 
3. Press the <enter> key on the keyboard. 
4. Enter the custom text header of formula. 
5. Press <enter> on the keyboard. 
6. Exit Modify Layout mode.  

 

Fil l  Down and Fil l  Right 
The Fill Down and Fill Right commands populate the remaining portions of a Free Form 
Quote window. By default these commands begin the process with the lowest valued 
variable and fill the page down or to the right. A Fill Down or Fill Right duplicates an 
row or column (typically the $1 variable) until the window if full. 
 
These commands only fill the window according to its dimensions. Resizing a window 
will not automatically fill the rows or columns. The layout created using the Fill Down or 
Fill Right commands will be preserved. Likewise, Fill Down and Fill Right commands 
will duplicate information until the entire window is full. For windows using the Format 



Columns format, if there is enough space, all of the columns will be duplicated to the 
right of the original row. Fill Right has similar behavior, but with rows. Therefore, the 
dimensions of a window are important when applying a Fill Down or Fill Right 
command. In the window below, the rows from $12 thru $22 are continued to the right of 
the intended layouts dimensions. 
 

 
 
 
Fill Down and Fill Right commands can be repeated. Each subsequent command 
overwrites previous layouts. Sizing of windows and display issues are easily remedied 
using these commands. Simply reissue the Fill Down or Fill Right command after 
resizing a window to correct these issues. The window below shows the bad Fill Down 
from above after resizing the window and repeating the Fill Down.  
 

 
 

 Simply resizing a window with too many quote code codes can affect the 
performance of Aspen. This is especially true when using Futures or Options macros. 
Instruments may be hidden from view due to the resize. Despite this, Aspen still 
downloads all the information for the instruments. To prevent this behavior, Resize the 
window and repeat the Fill Down or Fill Right command.  
 



Fill Down – Using Icons 
1. Create a Free Form Quote Window. 
2. Enter Modify Layout mode. 
3. Populate a Free Form Quote Window row with the appropriate Quote Codes.  
4. Left-Click the Fill Down Icon.  
5. Exit Modify Layout mode.  

Fill Down – Using the Context Sensitive Menu 
1. Create a Free Form Quote Window. 
2. Enter Modify Layout mode. 
3. Populate a Free Form Quote Window row with the appropriate Quote Codes. 
4. Right-Click the Quote Window 
5. Left-Click Fill Down in the menu. 
6. Exit Modify layout mode.  

Fill Down – Using the Main Menu 
1. Create a Free Form Quote Window. 
2. Enter Modify Layout mode.  
3. Populate a Free Form Quote Window row with the appropriate Quote Codes. 
4. Left-Click Quote in the Main Menu. 
5. Select Modify Layout in the Quote Menu. 
6. Left-Click Fill Down in the new menu. 
7. Exit Modify mode. 

Fill Down – Using Dot Commands 
1. Create a Free Form Quote Window. 
2. Enter Modify Layout mode. 
3. Populate a Free Form Quote Window row with the appropriate Quote Codes. 
4. Type .filldn  
5. Press the <Enter> key. 
6. Exit Modify mode. 

Fill Right – Using Icons 
1. Create a Free Form Quote Window. 
2. Populate a Free Form Quote Window column with the appropriate Quote 

Codes. 
3. Enter Modify Layout Mode.  
4. Left-Click the Fill Right icon.  
5. Exit Modify layout mode. 

Fill Right – Using the Context Sensitive Menu 
1. Create a Free Form Quote Window. 
2. Enter Modify Layout Mode. 



3. Populate a Free Form Quote Window Column with the appropriate Quote 
Codes. 

4. Right-Click the Quote Window. 
5. Left-Click Fill Right.  
6. Exit Modify Mode. 

Fill Right – Using the Main Menu 
1. Create a Free Form Quote Window. 
2. Enter Modify Layout Mode. 
3. Populate a Free Form Quote Window column with the appropriate Quote 

Codes. 
4. Left-Click Quote in the Main Menu. 
5. Select Modify Layout in the Quote Menu. 
6. Left-Click Fill Right. 
7. Exit Modify Mode. 

Fill Right – Using Dot Commands.  
1. Create a Free Form Quote Window. 
2. Enter Modify Layout Mode. 
3. Populate a Free Form Quote Window column with the appropriate Quote 

Codes. 
4. Type .fillrt 
5. Press the <Enter> key. 
6. Exit Modify Mode.  

 
 

Fill ing a Specified Range 
Many common formats require Fill Down and Fill Right to specify a range of values. 
Filling a specified range is useful for breaking up information and arranging it logically. 
The following window illustrates filling a specified range when displaying NYSE issues 
and NASDAQ issues. Notice how the numerical sequence between variables is broken 
between text labels and column headers. If a regular Fill Down were used, all of the text 
labels and symbol headers appearing after the $1 variable would be replaced with 
variables.  
 



 
 
This layout was created by specifying starting and ending variable values when executing 
the Fill Down command. The portion dedicated to the NYSE Gainers was filled using the 
.filldn 1 5 command. For the remaining sections the Quote codes were created 
normally. However, the new Quote Codes begin with the variable $1 by default. These 
values were edited by Left-Clicking the cell and replacing each $1 with $6 for the new 
section. Then the .filldn command was called specifying variables 6 and 10. The 
sequence is similar to continue the Nasdaq Gainers and Losers.  

Using a Dot Command – Fil l  Down 
1. Create a Free Form Quote Window. 
2. Enter Modify Layout Mode. 
3. Populate a Free Form Quote Window row with the appropriate quote codes. 
4. Type the following command. Where n represents the starting number and m 

represents the ending number. 
.filldn n m 

5. Press the <Enter> key on the keyboard. 
6. Exit Modify Layout mode. 

 

Using a Dot Command – Fil l Right 
1. Create a Free Form Quote Window. 
2. Enter Modify Layout Mode. 
3. Populate a Free Form Quote Window column with the appropriate quote codes. 
4. Type the following command. Where n represents the starting number and m 

represents the ending number.  
.fillrt n m 
 

Quote Code Definit ions 
 



Code Description 
.Ask The most recent Ask. 

.Ask2 - .Ask7 Ask2 is the second most recent Ask. Ask7 
is the seventh most recent Ask. 

.Asksize The volume size of the most recent Ask. 
.Asksize2 - .Asksize7 Asksize2 is the volume of the second most 

recent Ask. Asksize7 is the volume of the 
seventh most recent Ask. 

.Asktime The time of the Ask. 
.Asktime2 - .Asktime7 Asktime2 is the time of the second most 

recent Ask. Asktime7 is the time of the 
seventh most recent Ask. 

.Askx The source of the Ask. 
.Askx2 -.Askx7 Askx2 is the source of the second most 

recent Ask. Askx7 is the source of the 
seventh most recent Ask. 

.Bask Best Ask of the day. 
.Basksize Volume of the Best Ask. 
.Basktime Time of the Best Ask. 

.Baskx Source of the Best Ask. 
.Bate Bid, Ask, Trade, Exception. A single letter 

identifier.  

o B = bid 

o R = recent 

o S = settle 

o L = last 

o Mm = midpoint 

o P = prev 

o O = open 

o H = high 

o C = close 
.Bbid Best Bid of the day. 

.Bbidsize Volume of the Best Bid. 
.Bbidtime Time of the Best Bid. 

.Bbidx Source of the Best Bid. 
.Bid The most recent Bid. 

.Bid2 - .Bid7 Bid is the second most recent Bid. Bid7 is 
the seventh most recent Bid. 

.Bidsize Volume of the most recent Bid. 
.Bidsize2 - .Bidsize7 Bidsize2 is the volume of the second most 

recent Bid. Bidsize7 is the seventh most 
recent Bid. 

.Bidx Source of the most recent Bid. 



.Bidx2 - .Bidx7 Bidx2 is the source of the second most 
recent Bid. Bidx7 is the source of the 
seventh most recent Bid. 

.Change The trend of the most recent trade. 
.Close The closing price of the day. 

.Close1 - .Close2 Close1 is the close of the previous day. 
Close2 is the close of the second previous 
day. 

.Clr1 - .Clr2 Clr1 is the initial closing range. Clr2 is the 
initial closing range of the previous day.  

.Cltime Time of the closing price. 
.Cltime1- .Cltime4 Cltime1 is the closing time of the previous 

day. Cltime4 is the closing time of the 
fourth previous day. 

.Cond Trade condition. 
.Currency Type of currency the instrument trades in. 

.Desc A description of the symbol as sent down 
by the data feed. 

.Dollars Currency value for one full point. 
.Dvol Number of down tics or stock volume on 

down trades. 
.Exch The exchange on which the instrument 

trades. 
.Exdesc The full name of the exchange. 
.Expire Contract expiration date. 
.High The high price of the day. 
.Last The price of the last trade. 

.Last1 - .Last8 Last1 is the price of the previous trade. 
Last8 is the price of the eight previous 
trade. 

.Lastx Source of the last price. 
.Low The low price of the day. 
.Net The net change value for the day. 
.OI Open Interest. 

.Open The opening price of the day. 
.Open1 and .Open2 Open1 is the opening price of the previous 

day. Open2 is the adjusted opening price (if 
any). 

.Opr1 and .Opr2 Opr1 is the initial opening range. Opr2 is 
the secondary opening range. 

.Optime The time of the opening. 
.Optime1 - .Optime4 Optime1 is the time of the previous 

opening. Optime4 is the time of the fourth 
previous opening. 

.Prev The previous day’s settle price. 
.Recent The most recent trade. 



.Sbase Instrument symbol Base or Root. 
.Sext Instrument symbol Extension. 

.Strike Option strike price. 

.Symb The instrument you are quoting on the 
quote page. 

.TicVol Volume of the last tic. 
.TicVol1 -.TicVol8 TicVol1 is the volume of the previous tic. 

TicVol8 is the volume of the eighth most 
previous tic. 

.Time Time of the last trade.  
.Time1 - .Time8 Time1 is the time of the previous trade. 

Time8 is the time of the eight most 
previous trade. 

.Trade Value of the last trade. 
.TradeSize Volume of the last trade. 
.Tradetime Time of the last trade. 

.Tradex Source of the last trade. 
.Trend Trend of the last trade. 
.Tvol Total volume of the instrument today. 
.Type Instrument type. 
.Tzone Time zone in which the instrument trades. 
.Units Trading units of the instrument. 
.Uvol Number of upticks or stock volume on up 

trades. 
.Volume Number of tics or shares of stock traded 

during the period. 
.XMonth The month the contract expires.  

 
 

Clocks 
Aspen offers sever clock features. Clocks in Aspen are treated as any other Aspen 
Window and can be displayed in Analog, Digital and Text modes.  
 

Clock Toolbar 
 



 
 

o 12 Hour Format – Modifies the selected clock to display in a 12 hour format. 

o 24 Hour Format – Modifies the selected clock to display in a 24 hour format. 

o Analog Clock – Modifies the selected to clock to display as an analog clock with 
hands.  

o Digital Clock – Modifies the selected clock to display as a digital clock. 

o Text Clock – Modifies the selected clock to display using the default font.  

 

 
 

o New York – Sets the selected clock’s time zone to New York time. 

o Chicago – Sets the selected clock’s time zone to Chicago time. 

o Los Angeles – Sets the selected clock’s time zone to Los Angeles time. 

o London – Sets the selected clock’s time zone to London time. 

o Paris - Sets the selected clock’s time zone to Paris time.  
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o Frankfurt – Sets the selected clock’s time zone to Frankfurt time. 

o Singapore – Sets the selected clock’s time zone to Singapore time. 

o Bangkok – Sets the selected clock’s time zone to Bangkok time. 

o Tokyo – Sets the selected clock’s time zone to Tokyo time. 

o Sydney – Sets the selected clock’s time zone to Sydney time. 

o Properties – Displays the Clock Properties dialog.  

 

Clock Properties Dialog 
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o Display title bar – toggles the display of title bars for the selected clock.  

 

 
 

o Background – Displays the Color Picker for changing the Background color. 

o Lines – Displays the Color Picker for changing the line color. 

o Shadow – Displays the Color Picker for changing the color of the Shadow. 

o Numbers – Displays the Color Picker for changing the color of the numbers for 
Analog clocks. 

o Hands – Displays the Color Picker for changing the color of the clock hands for 
Analog clocks. 

o Text – Displays the Color Picker for changing the text floor for digital and text 
clocks. 

Changing the Time Zone  

Using Icons 
1. Left-Click the Clock Window to select it. 
2. Left-Click the appropriate Time Zone icon in the Clock Toolbar.  

 



Using the Context Sensitive Menu 
1. Right-Click the Clock Window. 
2. Select the Time Zone from the new menu. 

 

Using Dot Commands 
1. Left-Click the Clock Window to select it. 
2. Type z and the Time Zone Code. (example: z32) 
3. Press Enter. 

 

Time Zone Codes 
 

Code Time Zone Code Time Zone 

1 Honolulu, 
Anchorage 

21 Hong Kong 

2 Yakutat Bay, 
Alaska 

22 Tokyo 

3 Los Angeles 23 Darwin, Australia 

4 Denver 24 Sydney 

5 Chicago 25 New Caledonia 

6 New York 26 Wellington, New 
Zealand 

7 Caracas 27 Samoa 

8 Rio De Janeiro 28 PST/PDT 

9 Eastern Brazil 29 MST/MDT 

10 Reykjavik 30 CST/CDT 

11 London 31 EST/EDT 

12 Paris 32 AST/ADT 

13 Spitzbergen 33 GMT/BST 

14 Moscow 34 Europe 

15 Tehran 35 Western Australia 

16 Baghdad 36 Central Australia 

17 Dubai 37 Sydney, Australia 

18 Bombay 38 Paris 



19 Calcutta 39 Amsterdam 

20 Bangkok 40 Customer Defined 

    

 

 

Price/Volume 
Price/Volume is Aspen’s implementation of Market Profile. Price/Volume requires a 
subscription. This fee is charged by the CBOT for use of Market Profile. Market Profile + 
includes volume bars as well as TPOs. Please contact your Aspen Sales representative for 
information regarding Market Profile subscription fees.  
 

 
 



Market Profi le Anatomy 

 
 

 

o Close/Last Price – This green arrow indicates the close or last price. 

o Equivolume Line – Represents the halfway point in the profile’s volume.  

o Initial Balance Range – Indicates the first two half-hour periods. The result of the 
pit exploring a range within which trade will take place. This is configurable in 
the Price/Volume Properties. 

o Open Price – This green arrow indicates the daily open price. 
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o Price Scale – Indicates the trading values for the symbol. 

o Spectrum Profile – Histogram indicating the percentage of ticks at each price 
within the trading range of the instrument. A horizontal bar is drawn at each price 
level. The total length of this bar reflects the total tick volume at a price.  

o Value Area – Represents the prices at which approximately seventy percent of the 
volume of the completed day’s activity occurred. 

o Volume Scale – Indicates the number of ticks relative to the nearest grid line.  

 

Price Volume Cursor 

 
 

o Price – Indicates the price at the cursor’s location. 

o Volume – Indicates the volume at the cursor’s location. 

o Upper 70% - Indicates the upper limit 70% value area.  

o Lower 70% - Indicates the lower limit 70% value area. 

o Lower Volume – Indicates the tick volume below the cursor location. 

o Upper Volume – Indicates the tick volume above the cursor location. 

o Lower TPOs – Indicates the number of TPOs below the cursor location. 

o Upper TPOs – Indicates the number of TPOs above the cursor location. 

 

Displaying a Market Profi le 

Using Icons 
1. Left-Click the Time and Sales icon.  
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2. Left-Click the Market Profile window and enter the symbol. 

Using the Context Sensitive Menu 
1. Right-Click in an empty Aspen workspace. 
2. Left-Click Price/Volume in the new menu. 
3. Left-Click the Market Profile window and enter the symbol. 

Using the Main Menu 
1. Left-Click File in the Main Menu.  
2. Select New Window. 
3. Left-Click Price/Volume in the new window.  
4. Left-Click the Market Profile window and enter the symbol. 

 

Market Profi le Toolbar 

 
 

o Refresh Data – Refreshes historical data for sites running an Aspen server. 

o Properties – Displays the Market Profile Properties dialog. 

o Expand Price Scale – Increases the number of digits between prices. 

o Compress Price Scale – Decreases the number of digits between prices. 

o Move Chart Up – Moves the entire chat up. 

o Move Chart Down – Moves the entire chart down. 
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o Auto Scale Price – Returns the price scale to the default scaling. 

o Shift Left – Moves the chart to the left. 

o Shift Right – Moves the chart to the right. 

o Auto Scale Time – Returns the time scale to the default scaling. 

o Merge Left – Merges the selected Profile to the next profile to the left. 

o Restore Default Splits – Removes any splits or merges and returns the profiles to 
the default view. 

The Market Profi le Menu 

 
o Profile – Toggles the display of the Profile 

o Bar Based Data –  

o Volume – If checked, Spectrum Profile is displayed. The Spectrum Profile 
displays the tick volume at each price. 

o Volume Scale – Toggles the display of the Volume Scale. 

o New Lettering – Toggles between the New and Old CBOT TPO schemes.  

o Open Align – Toggles between Open Market align and the default alignment on 
the half hour. 
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o Auto Splitter – Enables or disables the use of the Auto Split feature. The Auto 
Split feature may be configured in the Market Profile Properties dialog. 

o Monochrome – Toggles between a multi-color and single color display.  

o Baskets – Displays the Market Profile+ Basket menu. 

o Properties… - Displays the Market Profile Properties dialog.  

 

Profi le Properties Dialog  

 
 

o Symbol – Contains the current symbol for the profile. The symbol may also be 
changed here. 

o Prefix – Contains any feed specific country prefixes. Not applicable for all for all 
feeds. 

o IBR Count – Initial Balance Range. The number of TPO’s used to calculate the 
Initial Balance.  

o Display IBR – Toggles the display of the line that indicates the Initial Balance.  

o Hide Grid Lines – Toggles the display of the profile’s grid lines. 

o Current Price Highlight – Toggles the display of the Current Price Highlight. 

o Value Area Shading – Toggles the display of Value Area Shading. Includes the 



TPO’s and Market Spectrum. 

o Display Title Bar – Toggles the display of the Windows Title Bar. 

o Display horizontal scrollbar – Toggles the display of the horizontal scrollbars.  

o Display vertical scrollbars – Toggles the display of the vertical scrollbars.  

o Save As Default - Sets the current options as the default display for each new 
chart created.  

o Old Color Scheme – Toggles the TPO and Market Spectrum colors between the 
old and new color schemes. 

 

 
 

o Minimum – Specifies the minimum size (number of bars of some time unit) for 
each profile. Any profile formed will have at least this many bars. The Minimum 
parameter must be greater than zero. 

o Break Periods - Specifies the number of periods back from the most recent bar to 
consider to determine if a new profile has formed, and the current profile is 
complete. 

o Days History - The Minimum Increment value determines what is a valid price 
for the contract. 

 



 
 

o Background – Displays the Color Picker for changing the Market Profile 
Background color. 

o Grid Lines – Displays the Color Picker for changing the background Grid Lines 
for the Market Profile.  

o Scale – Displays the Color Picker for changing the colors of the numerical and 
time scales. 

o Border – Displays the Color Picker for changing the color of the borders.  

o Description – Displays the Color Picker for changing the color of the symbol 
description. 

o Equivolume Line – Displays the Color Picker for changing the color of the 
Equivolume Line. 

o Cursor Values – Displays the Color Picker for changing the color of the values 
displayed in the Market Profile cursor window. 

o Cursor Background – Displays the Color Picker for changing the color of the 
Market Profile cursor window.  

o Locked Scale – Displays the Color Picker for changing the color of the numerical 
scales when the scales have been changed from their default values. 

o Monochrome TPO’s – Displays the Color Picker for changing the color when 



displaying Monochrome (single color) TPO’s. 

o Value Area – Displays the Color Picker for changing the color of the Value Area 
shading.  

o OP/CL Arrows – Displays the Color Picker for changing the color of the Open 
and Close price arrow indicators.  

o Price Highlight – Displays the Color Picker for changing the color of the Current 
Price Highlight.  

o Init. Bal. Range – Displays the Color Picker for changing the color of the Init. 
Bal. Range indicator. 

o Restore Default Colors – Returns the color configurations to the system defaults. 

 

 
 

o A – z – Selecting any lettered box will display the Color Picker for changing the color 
of the related TPO.  

o Restore Default Colors – Returns the color configurations to the system defaults. 

 



Displaying the Market Profile Properties Dialog 

Using Icons 
1. Left-Click a Market Profile window to select it. 

2. Left-Click the Properties icon.  

Using the Context Sensitive Menu 
1. Right-Click a Market Profile window. 
2. Left-Click Properties… in the new menu.  

Using the Main Menu 
1. Left-Click a Market Profile window to select it. 
2. Left-Click Price/Volume in the Main Menu. 
3. Left-Click Properties… 

Merging Profi les 
Daily profiles can be Merged to create multi-day profiles. There is no limit to the number 
of merges that can be used to create a profile. This feature is useful when analyzing a 
market over several days in a single profile. 
 

Using Icons 
1. Left-Click the profile that will be merged to select it. 
2. Left-Click the Merge Left icon to merge the selected profile to the left. 

Using the Mouse 
1. Left-Click a profile.  
2. Hold the Left mouse button until a box appears. 
3. Drag the mouse onto another profile. 
4. Release the mouse button to merge the profiles.  

 

Removing Merged Profiles 

Using Icons 
1. Left-Click a Merged profile to select it.  
2. Left-Click the Restore default splits icon to return the profiles to their default 

state.  

 

 



TPO’s  
Letters appearing on a profile are assigned to each half-hour period of trading time during 
the day. A profile is created as letters appear at the prices traded during each of the 
respective time periods. Each letter within the profile is referred to as a Time Price 
Opportunity, or TPO. As the day progresses the letters form a profile of the acceptance 
and rejection of prices by buyers and sellers. Aspen offers two TPO naming schemes.  
 

Old TPO Alphanumeric Assignments 
Letter Time Color Letter Time Color 

A 09:00 Yellow a 20:00 Yellow 
B 09:30 Dark Blue b 20:30 Dark Blue 
C 10:00 Pink c 21:00 Pink 
D 10:30 Green d 21:30 Green 
E 11:00 Orange e 22:00 Orange 
F 11:30 Light Blue f 22:30 Light Blue 
G 12:00 Dark Purple g 23:00 Dark Purple 
H 12:30 White h 23:30 White 
I 13:00 Red i 24:00 Red 
J 13:30 Light Grey j 24:30 Light Grey 
K 14:00 Light Purple k 01:00 Light Purple 
L 14:30 Yellow l 01:30 Yellow 
M 15:00 Dark Blue m 02:00 Dark Blue 
N 15:30 Pink n 02:30 Pink 
O 16:00 Green o 03:00 Green 
P 16:30 Orange p 03:30 Orange 
Q 17:00 Light Blue q 04:00 Light Blue 
R 17:30 Purple r 04:30 Dark Purple 
S N/A N/A s 05:00 White 
T N/A N/A t 05:30 Red 
U N/A N/A u 06:00 Light Grey 
V N/A N/A v 06:30 Light Purple 
W 18:00 White w 07:00 Yellow 
X 18:30 Red x 07:30 Dark Blue 
Y 19:00 Light Grey y 08:00 Pink 
Z 19:30 Purple z 08:30 Green 

 

 

New TPO Alphanumeric Assignments 
Letter Time Color Letter Time Color 

A 01:00 Yellow a 13:00 Pink 
B 01:30 Dark Blue b 13:30 Green 
C 02:00 Pink c 14:00 Orange 



D 02:30 Green d 14:30 Light Blue 
E 03:00 Orange e 15:00 Dark Purple 
F 03:30 Light Blue f 15:30  White 
G 04:00 Dark Purple g 16:00 Red 
H 04:30 White h 16:30 Light Grey 
I 05:00 Red i 17:00 Light Purple 
J 05:30 Light Grey j 17:30 Yellow 
K 06:00 Light Purple k 18:00 Dark Blue 
L 06:30 Yellow l 18:30 Pink 
M 07:00 Dark Blue m 19:00 Green 
N 07:30 Pink n 19:30 Orange 
O 08:00 Green o 20:00 Light Blue 
P 08:30 Orange p 20:30 Dark Purple 
Q 09:00 Light Blue q 21:00 White 
R 09:30 Dark Purple r 21:30 Red 
S 10:00 White s 22:00 Light Grey 
T 10:30 Red t 22:30 Light Purple 
U 11:00 Light Grey u 23:00 Yellow 
V 11:30 Light Purple v 23:30 Dark Blue 
W 12:00 Yellow w 24:00 Pink 
X 12:30 Dark Blue x 24:30 Green 

 
 

News 
Aspen News windows offer real time breaking news stories. Aspen News windows are 
searchable and incoming stories may be filtered to display items relating to specific 
markets and/or issues. Aspen works with several data vendors who offer news services. 
Contact your Aspen Sales representative for pricing and subscription information.  

 



 

Displaying a News Window 
 

Using Icons 
1. Left-Click the New News Window Icon.  
2. Left-Click a Headline to display the full story. 

 

Using the Context Sensitive Menu 
1. Right-Click a blank Aspen Workspace. 
2. Select New Window. 
3. Left-Click News. 
4. Left-Click a Headline to display the full story. 

 

Using the Main Menu 
1. Left-Click File in the Main Menu. 
2. Select New Window. 
3. Left-Click News. 
4. Left-Click a Headline to display the full story. 

 

Using Dot Commands 
1. Type .news <enter> 

 

News Window Toolbar 

 
o Up 1 Line – Moves the News Window text up one line. 

o Down 1 Line – Moves the News Window text down one line. 
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o Page Up – Moves the News Window text up one page. 

o Page Down – Moves the News Window text down one page. 

o Back to Top – Moves the News Window text to the top where the most current 
News Headlines are displayed.  

o Show All Headlines – Disables any categorical or keyword searches.  

 

 
o Display Categories – Displays a list of News Categories. Categories limit the 

incoming News to Headlines related to the category. 

o Search Headlines – Opens a textbox for searching News Stories for specified text. 

o Properties – Displays the News Window Properties Dialog. 

o Print Story – Sends the current news story to the default printer for printing. 

o Copy Story to Clipboard – Copies the current news story to the clipboard for 
pasting in other applications. 

 

News Search 
Your data provider may send down thousands of news headlines during the course of a 
day.  To scroll through these looking for a particular subject could take a long time. The 
Aspen Graphics News Search function allows you to streamline the search process. 

Display by Category 
All headlines are displayed in the News Window when it is created. The list of headlines 
can be narrowed to specific topics by right-clicking to display a News Menu, selecting 
Categories and choosing a subject from this list.  
 
Note: The list of Categories available is dependent upon the news services supplied by 
your data provider 
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Using Icons 
1. Left-Click the Display Category Icon in the News Toolbar.  
2. Left-Click a Category to filter the News.  

Using the Context Sensitive Menu 
1. Open a News Window.  
2. Right-Click the News Window. 
3. Select Categories. 
4. Left-Click the Category in the new menu to filter the News. 

 

Keyword Search 
Searching the list of headlines for specific words or symbols is also possible, by 
executing a keyword query. The search is literal. If you ask for headlines with the symbol 
MSFT by typing msft in the “Search For:” window you will receive only those news 
stories that contain MSFT, not those that refer to the entire company name of Microsoft. 
To remove the query and return to the entire list of headlines, select the  button on the 
toolbar. 
 
 

Using Icons 
1. Left-Click the Search Headlines Icon.  
2. In the Search For text box, enter the keyword(s) you wish to search for. 

Using the Mouse 
1. Select the word in the headline that you want to search for with your mouse. 
2.  Hold the left mouse button down on the word until a rectangle appears next to 

the mouse pointer.   
3. Release the mouse button and the query will be performed.   

 

Multiple Keyword Queries 
Queries can include multiple keywords using the following operators:  
& - Separating keywords with an ampersand will list headlines which include all 
keywords.  For example, typing soybean&meal will list all news headlines which 
contain both the word soybean and the word meal. 

 
, - A comma will list any headline that contains either keyword.  For example, typing 
soybean,oil,meal will list all headlines which contain the word soybean, or the word 
oil, or the word meal. 
 



% - The percent sign will list headlines which have one word but not another.  For 
example, typing the query oil%crude will list all headlines which contain the word oil 
but not the word crude. 

Combine Operators for Multiple Keyword Queries 
These operators can be combined to do more complex searches: 
 

Example:  bean&oil%crude will list all headlines which contain the words bean and oil 
but not the word crude. 
 
Using parentheses will establish priority in calculating, just as in math operations.   
 

Example:  bean&oil%crude) would first evaluate the command “oil but not crude”, 
then add bean to that subcategory. 
 
 

Addit ional News Window Tips 
o When using abbreviations or incomplete words in your search, Aspen Graphics 

will return all occurrences of the textual string. For example, if you wanted to 
search for any headlines which referenced the month of December and typed in 
Dec, you may get a list containing decline, decimate, decry as well as December 
or Dec. To limit your list, use the exclamation point (!) limiter after your query.  
Dec! returns a list of which includes only the occurrences of Dec. 

o You can recall your previous queries by entering // at the command line.  

o News queries are not case sensitive. ENERGY would yield the same results as 
energy. 

o Terms which include the ampersand character must be enclosed in double quotes 
to be used in a keyword search. Ex:  “S&P”.  Otherwise, it will be interpreted as 
the logical AND operator. 

o There are certain keywords on which Aspen Graphics will not perform a search.  
This exclusion list includes all pure numeric characters, common words, adverbs 
and prepositions that generally would not be used as keywords. Removing these 
from consideration saves an enormous amount of processing time and disk space 
usage.  

Exclusions: 
a.m. Bln ago etc if said up 
am Inc all etc. in say use 
cdt inc. an for into says versus 
cst Ltd and from is she was 
edt ltd. as go it some what 
est Min at goes its than when 



et Pct be had might that where 
mdt Per but has not the while 
mst Pts by he of them why 
p.m. via can her off they will 
pdt vs. did his only till yes 
pst down how or to told  

 
There is also an inclusion list for keyword searches, which is composed primarily of 
alphanumeric combinations that would normally be excluded from indexing.   
 

Inclusions: 
1day 28day 1week 3mo 1year 10year 1st  
2day 30day 1wk 3month 1yr 10yr 2nd 
3day 45day 2week 6mo 2year 15year 3rd 
4day 60day 2wk 6month 2yr 15yr 4th 
5day 90day 4week 9mo 3year 20year 5th 
6day 91day 4wk 9month 3yr 20yr 10th 
7day 120day 6week 12mo 4year 30year 13th 
10day 180day 6wk 12month 4yr 30yr 15th 
14day 270day 8week 18mo 5year  20th 
15day  8wk 18month 5yr  25th 
   24mo 7year 401 30th 
   24month 7yr 401k  

 
 

Time and Sales 
The Time and Sales Windows in Aspen Graphics displays the individual incoming, Bids, 
Asks, Trades and Settles for an instrument. 
 

 
 



Displaying a Time and Sales Window 

Using Icons 
1. Left-Click the Time and Sales Icon.  
2. Enter a valid symbol. 

Using the Context Sensitive Menu 
1. Right-Click an empty Aspen Workspace. 
2. Select New Window. 
3. Left-Click Time and Sales. 
4. Enter a valid symbol. 

Using the Main Menu 
1. Left-Click File in the Main Menu. 
2. Select New Window. 
3. Left-Click Time and Sales. 
4. Enter a valid symbol. 

Using Dot Commands 
1. Type .t&s <enter> 
2. Enter a valid symbol. 

 

Time and Sales Property Dialog 
The Time and Sales Property Dialog configures properties such as colors, symbols and 
the types of transactions to display.  
 



 
 

o Symbol – Displays the symbol monitored by the Time and Sales Window. The 
symbol may be changed here. 

o Prefix – Used for data vendors that require a prefix based on the country the 
market is located in. The prefix may be changed here. 

o Display title bar – Toggles the display of Title Bars on the Time and Sales 
Window. 

 



 
 

o Bids – Toggles the display of Bids. 

o Asks – Toggles the display of Asks. 

o Trades – Toggles the display of Trades. 

o Settles – Toggles the display of Settles. 

o Volumes – Offers Not Displayed, All, Large and Range values for volumes. 

o Minimum – Specifies the minimum Volume value required for it volumes to be 
displayed. 

o Maximum – Specifies the maximum Volume value required for volumes to be 
displayed. 

 



 
 

o Background – Specifies the Background Color.  

o Text – Specifies the Text Color. 

o Cursor Background – Specifies the color for the Cursor. 

o Cursor Text – Specifies the text color for the Cursor. The Cursor is the time 
containing trades. 

o Highlight Shadow – Specifies the color for shadowing text. 

o Heading – Specifies the text color for the Heading. 

o Lines – Specifies the line color. 

o Strike – Specifies the color of any canceled trades. 

 

Displaying the Time and Sales Property Dialog 

Using Icons 
1. Left-Click the Properties Icon.  

Using the Context Sensitive Menu 
1. Right-Click a Time and Sales Window. 



o Left-Click Properties… 

Using the Main Menu 
1. Left-Click on Time and Sales in the Main  Menu.  
2. Left-Click on Properties… in the Time and Sales Menu.  

 

Formulas 
Formulas allow users to create their own studies where the do not exist by default, and 
can also be used in writing complex alarms, and color rules. They can also be used to 
replace complex syntax when entering multiple symbols on a chart. A final use would be 
to have text appear either on a chart to indicate Candlestick formations or on a quote page 
advising of Buy, Sell or Hold conditions. 
 

The Parts of a Formula 
 
Formulas have three parts: a name, an equal sign and an expression. 
 
Example:            21DayHigh = rmax($1.high,21) 
          
 
 Formula Name Equal Sign    Expression 
 
Formula Names can be as descriptive as you like. You may use up to 19 characters, 
and an underscore (“_”) can be used to add a space to your formula name, as in 
3month_strip.  
 

 Aspen Graphics formula names are not case sensitive. 
 
Do not name your formula any of the following: 
1.  A symbol name 
2.  A number, such as 15 
3.  A command, such as .bye 
 
 

 
 



Expressions 
Expressions are where the calculations take place.  Expressions can contain: 

 

o constants (CLZ8, ibm, 42,etc.) 

o operators (+,-,*,/,>=,= = etc.) 

o variables ($1, $1.low, cl#, etc.) 

o functions (rmax( ), dev( ), if( ), etc.) 
 

Constants  
Constants can be any number or symbol sent by your datafeed. 
 

Operators  
Math operators used in Aspen Graphics are shown below. The Order of Evaluation 
specifies the operator in the formula that will be calculated first. 
 

Operator What it Does Order of 
Evaluation 

^ Exponentiation 1 
- Negative 2 
+ Positive 2 
* Multiplication  3 
/ Division 3 
+ Addition 4 
- Subtraction 4 

= = Equals 5 
!= Does Not Equal 5 
> Greater Than 5 
<  Less Than 5 

>= Greater Than or Equal To 5 
<= Less Than or Equal To 5 

 
 



Parenthesis  
Parenthesis can be used to specify that a particular operation should be performed 
before other operations in the formula. For example:  

 
(ng#+ng#1+ng#2)/3 

 
First, add the three front months of Natural Gas, and then divide the sum by three. 

 

Variables  
Variables are placeholders. They stand for a quantity or an instrument that will be 
specified later when the formula is implemented. Types of variables include: 
 

 

Instrument Variables 
The advantage of using instrument variables ($1, $2, $3, etc) in a formula instead 
of a specific symbol (such as OEX, MSFT or CLZ8) is that it allows you to use 
the formula with any symbol you like. In other words, it makes the formula 
generic. The $1 saves a place for a symbol that will later be supplied. 

 
Example:   A spread formula written as: 

 
Spread=cn8-ck8  

 
This formula will be useful only as long as cn8 and ck8 are both trading; it will 
be useless after one of the contracts expires. A generic formula which could be 
used for any two instruments would be: 

 
Spread=$1-$2 

 
To chart this formula or to display this formula in a quote page, enter: 

 
Spread(cn8,ck8)



 
The # macro is another type of variable for instruments, like futures, which 
expire. It is used in place of a symbol’s month and year codes to specify which of 
the currently trading contracts you want to evaluate. After the symbol root (sp for 
the S&P 500, cl for crude light, etc.), a # specifies the front month, #1 specifies 
the first month out, etc. 

 
The # macro allows you to write a formula for futures which doesn’t have to be 
edited when one of the contracts expires. 

 
Example: In October of 2006, a strip formula for the first three months of natural 
gas could be written:  

 
NatGasStrip=(ngv6+ngx6+ngz6)/3 

 
This would work, however, only as long as all three contracts were trading. After 
that, the formula would need to be changed to reflect the current three front 
months. For example: 

 
NatGasStrip=(ngx6+ngz6+ngf77)/3 

 
A more useful formula could be written: 

 
NatGasStrip=(ng#+ng#1+ng#2)/3 

 
This formula could be used anytime, and the first three months of natural gas, 
whatever they happened to be at the time, would be averaged. 

 
Price Variables  

Price Variables such as spz7.high and $1.avg, are used to designate which of 
the many possible prices and values associated with an instrument are to be used 
in the formula. These variables, or quote codes, are placed after the symbol and 
separated from it by a period, as shown in the previous examples. Below is a list 
of quote codes which may be used in formulas. 

 
 

Quote code Description 
.avg Average of the high, low and close prices for 

a bar 
.avgtick Average of the ticks on an EquiTick bar 
.close Closing price for the period 
.high Highest price hit during the period 
.last Last price reported (includes bids, asks, trades 

and settles) 
.low Lowest price hit during the period 

.midpt Midpoint of the high and low prices for the 
period 



.open Opening price for the period 

.prev Closing price for the previous period 
.thigh “True High;” the higher of the current period 

high or the previous close 
.tlow “True Low;” the lower of the current period 

low or the previous close 
 

Flow Control 
Aspen includes functionality for controlling the flow of a formula. This includes 
branching and looping controls. 
 

Branching 
Aspen uses If statements as one method to control formula flow. If statements allow users 
to take two or more paths of execution based on the evaluation of the If statement. If 
statements can be written as single line commands or multi-line commands.  
  

Single Line If Statement Example 
If $1.high > $1.high[1] then retval = SomeValue 

 

Multi-Line If Statement Example 
If $1.high > $1.high[1] then begin 

  <Add Additional Logic Here> 
End 

 

Looping 
Aspen offers looping mechanisms as another method of flow control. Loops are useful 
for counting and iterative operations. Aspen uses For and While statements for looping 
control. 
 

While Example  
while (currpeak>diverge-peaklen) do begin 

 
if $1.high[currpeak-1]<$1.high[currpeak] then 

peakmade=peakmade+1 
 

if sstoch($1,9,3)[currpeak-1]<sstoch($1,9,3)[currpeak] 
then speakmade=speakmade+1 

 
  currpeak=currpeak-1 

end 
 



For Example 
fact5(n)=begin 

result=1 
 
for i=1 to n result=result*i 
 
result 

end 
 

  Looping in Aspen can be very resource intensive. Care should be taken to avoid 
unnecessary iterations. Care should also be taken to avoid writing infinite loops.  
 
 

Functions  
Functions perform different types of calculations on the data. Aspen Graphics includes a 
variety of pre-programmed functions and gives you the ability to write your own 
formulas as necessary. 
 
Each function needs to be told what data to examine: a specific instrument, a variable like 
$1, a formula, number or some other series of data. In addition, there may be other 
parameters you need to specify as well depending on the type of function. 
 
The tables below list the functions that are programmed in Aspen Graphics, along with 
their required and optional parameters. 
 
 
 

Function What It 
Calculates 

Syntax Example Required Parameters 
(Optional Parameters follow 

in parenthesis) 
Abs( ) Absolute Value abs($1.qty) Instrument  
Dev( ) Standard Deviation dev(spm8,10) Instrument, periods (shift) 
Disttomax( ) Distance (in bars) to 

the highest value in 
a range 

disttomax(ibm.high,1,9) Instrument, starting bar of 
range, ending bar 

Disttomin( ) Distance (in bars) to 
the lowest value in 
a range 

disttomin(ibm.low,1,9) Instrument, starting bar of 
range, ending bar 

Exp( )  Exponentiation exp($1.rate) Instrument 
Floor( ) Returns the integer 

portion of a number 
Floor(number or 

expression) 
A number, or an expression that 
evaluations to a number 

Frac( ) Returns the 
fractional portion of 
a number 

Frac(number or 
expression) 

A number, or an expression that 
evaluations to a number 

Log( )  Natural Logarithm log($1/($1.last)) Instrument 
Log10( )  Base 10 Logarithm log10($1.xtime) Instrument 



Max()  Highest value in 
group 

max(us#,us#1,us#2) All instruments to be evaluated 

Min( )  Lowest value in 
group 

min(us#,us#1,us#2) All instruments to be evaluated 

Rangemax( ) Highest value in a 
defined range 

Rangemax(ch8,2,14) Instrument, starting bar of 
range, ending bar 

Rangemin( ) Lowest value in a 
defined range 

rangemin(ch8,2,14) Instrument, starting bar of 
range, ending bar 

Rmax( )  Highest value over 
the last (number) 
periods 

rmax(spm8.high,50) Instrument, periods (shift) 

Rmin( )  Lowest value over 
the last (number) 
periods 

rmin(spm8.low,50) Instrument, periods, (shift) 

Rsum( )  Sum of the values 
over the last 
(number) periods 

rsum(spm8,50) Instrument, periods, (shift) 

Scale( )  Units/number of 
decimal places in 
which a quote is 
displayed 

scale(jy#,100) Instrument, units or other 
instrument with the same units 
you want to use 

NOTE: The Scale ( ) function is used in quote windows or quote pages, but not in charts. 
SQRT( )  Square Root sqrt($1.xdays) Instrument 
SUM( )  Sums all values 

listed 
sum(ibm,msft,mu)/3 All Instruments 

IF( )  Conditional 
Statement (If, then, 
else) 

if($1.prev<$1.low, 
$1.tlow,$1.low) 

Desired criteria, value if TRUE, 
value if FALSE (Boolean 
operators AND and OR) 

 

Study Functions 
Function What It 

Calculates 
Syntax Example Required Parameters 

(Optional Parameters follow 
in parenthesis) 

ADX( )  Average 
Directional Index 

adx(ch8,20) Instrument, periods 

BB( )  Bollinger Bands bb($1,20,2,1) (top)  
bb($1,20,-2,1) (btm) 

Instrument, Moving avg. 
length, Std. Devs, Envelope 
length (Shift) 

Cci( )  Commodity 
Channel Index 

cci(sk8,10) Instrument, periods 

Dio( )  Directional 
Indicator 

dio($1,14) Instrument, periods 

Dmineg( )  DI- line of the 
Directional 
Indicator 

dmineg(smk8,14) Instrument, periods 



Dmipos( )  DI+ line of the 
Directional 
Indicator 

dmipos(smk8,14) Instrument, periods 

Eavg( )  Exponential 
Moving Average 

eavg($1,30) Instrument, periods, (shift) 

Fstoch( )  Fast Stochastic 
(Fast K line 

fstoch($1,9) Instrument, periods 

Havg( )  Hamming Moving 
Average 

havg($1,30) Instrument, periods, (shift) 

Hvol( )  Historical 
Volatility 

hvol(gm,10) 
(default parameters: 10 
periods, 1 Std. dev) 

Instrument, (Periods, Std. devs., 
Trading Periods/Year, Base 
100) 

Keltner( )  Keltner Channel keltner($1,20,1) (top) 
keltner($1,20,-1) 
(bottom) 

Instrument, periods, multiplier 
(shift) 

Lr() Linear Regression 
line 

Lr($1,200,3) Instrument, periods, (regression 
type) 

Mavg( )  Modified Moving 
Avg 

mavg($1,30) Instrument, periods (shift) 

Mbestcycle( 
)  

MESA Best Fit  mbestcycle(cl#,6) Instrument, periods 

Mdomcycle( 
)  

MESA Standard 
Prediction 

mdomcycle(cl#) Instrument 

Mom( )  Momentum mom(gcz8,10) Instrument, periods 
Mphase( )  MESA Phase mphase(ngz7) Instrument 
Mtrend( )  MESA Trend mtrend(ngz7,1) Instrument, cycle factor 
Rsi( )  Relative Strength 

Index 
rsi($1,14) Instrument, periods 

Savg( )  Simple Moving 
Average 

savg($1,30) Instrument, periods (shift) 

Sstoch( )  FastD/SlowK 
Stochastic Line 

sstoch(us#,9,3) Instrument, periods for the 
FastK, periods for the 
FastD/SlowK  

Ssstoch( ) Slow Stochastic 
(Slow D Line)  

ssstoch(us#,9,3,3) Instrument, periods for the 
FastK, periods for 
FastD/SlowK, periods for the 
SlowD 

Wavg( ) Weighted Moving 
Average  

wavg($1,30) Instrument, periods, (shift) 

 

Chart Functions 
Function What it Calculates Syntax Example Required Parameters 

(Optional Parameters) 
Chart( )  Provides a formula with a 

frame-of-reference 
similar to that of a chart 

chart(rsi(ip,14)[-
1],15, 1,100,1,3) 

Formula or function, bar-
width, bartype, numbars, 
nogaps, night session (Calc 
On/Off[-1]) 



Gapfill( )  Value with which to fill 
gaps on a chart 

gapfill(cl#,cl#.thigh) Instrument, formula, function 
or value to fill gap 

Quote( )  Most recent value of the 
requested quote, 
displayed as a  horizontal 
line in a chart 

quote(csco.ask) Instrument Quote Code 

 



Trig Functions 
Function What it Calculates Syntax Example Required Parameters 

(Optional Parameters) 
Cosine() Returns the cosine, in 

degrees, of an angle in 
degrees 

Cosine(degrees) Angle 
An angle in degrees. 

Sine() Gives the sine, in 
degrees, of an angle in 
degrees 

Sine(angle0 Angle 
An angle in degrees. 

Tangent() Returns the tangent, in 
degrees, of a given 
angle 

Tangent(angle) Angle 
An angle in degrees. 

arcCosine() Returns the arccosine 
(the angle whose cosine 
is a number) in degrees 
in the range of 0° to 
180° 

ArcCosine(Cosine(deg
rees)) 

Cosine 
The cosine in degrees 
(cosine()) of an angle.  
This value must be 
between -1 and 1. 

 
 

Special Functions 
 

The Chart Function 
The chart function is a very powerful and unique feature of Aspen Graphics. It is a 
function, just like rmin( ) or max( ), but it allows the user to create a “virtual chart”, 
setting a time frame and other chart settings for the formula.   

When Is the Chart Function Used?   

There are three instances when you need to use the chart function in a formula:  

o To display formula values in a quote window.      

o To set alarms on formulas or studies that include functions calculated over more 
than the current bar. The chart function allows the user to reference historical 
data, and therefore set alarms on formulas and studies that reference past bars. 

o To use more than one time base in a chart. The chart function allows the user to 
display studies with different time bases, such as a 60-minute RSI and a daily 
RSI, together in one chart.   

 



What Parameters does the Chart Function pass on to a 
Formula?  
When a study or formula is charted, some of the inputs for the study are defined by the 
chart in which it is displayed. These parameters are not available on a quote page or an 
alarm unless the chart function is used. 

 

How is the Chart Function Used? 
The chart function is a shell which surrounds an expression or formula, providing that 
formula with a chart’s parameters. The chart function is essentially the same as any other 
programmed function in Aspen Graphics: it requires calling the function by name and 
then listing the parameters, separated by commas and enclosed in parentheses.  The chart 
function has seven elements: 

 chart((function or formula) [-1], Bar Width, Bar Type, # of Bars, NoGaps, Session) 
 
Write your function or 
formula, including all 
parameters 

Calc On If you 
don’t want the 
chart to 
recalculate after 
each trade omit 
this, and the 
chart() function 
will recalculate 
when the bar is 
completed 

How Many tics, 
minutes, or days 
you want in each 
bar. 
Tics = 1 – 10,000 
Min = 1 – 1439 
Days = 1 – 7, 30, 
90, 365 
 

Type of 
bar 
Tic = 0 
Min = 1 
Day = 2 

How many 
bars to be 
used in the 
chart.  100 is 
optimal 

No gaps  
Off = 0 
On = 1 

Which 
Session? 
All = 1 
Night only = 2 
Days only = 3 
Use setting 
from setup.txt 
file = 0 

 
 A quote page or alarm has no way of knowing this information unless the chart 

function is used to define these parameters. 

Display or 
close up gaps 
for holidays? 

Which sessions are included? 

How many 
bars are on 
the chart for 
calculation? 

What is the study’s time frame? 



Examples of Formulas Util izing the Chart Function 

To display a study value on a quote page: 
Suppose you want to have the current values of an ADX study displayed on a quote page 
and you want to specify the following parameters: 

o 14 periods in the ADX study 

o CalcOn 

o Closing price on a daily bar 

o Nogaps On 

o Day session only 

 
In the Formula Editor, enter this formula: 

 
ADX_DAY(series)=chart(adx($1,14)[-1],1,2,100,1,3) 

 
Now go to your quote page or window and format the appropriate cell with the following: 
 

ADX_DAY($1) 
 

More details about formatting a formula in a quote page can be found in the following 
section. 
 

To set an alarm on a study: 
Suppose you want to be alerted when the momentum on SPZ7 is greater 
than 0.5 or less than -.5, using the parameters below:   

o 10 periods in the momentum study 

o CalcOn 

o Closing price of a 60 minute bar 

o Nogaps off 

o All trading sessions displayed 

 
 Enter an alarm for these conditions as: 

 
chart((mom(spz4,10)>0.5 or mom(spz4,10)<-0.5)[-1],60,1,100,0,1) 

 

Using more than one time base in a chart: 



If you want to view a study in two different time frames (e.g. - to "screen out" minor 
trend reversals), you can write a study using the chart( ) function and overlay it on the 
study in your chart. 
 

To view both an hourly and a daily RSI on the same hourly bar chart: 
1. Bring up an hourly bar chart. 
2. Add a Split For Study. 
3. Add a RSI study in the new Split Window. 
4. Enter the following formula in the Formula Editor and save it to a folder. 

RSI_Day(series)=chart(rsi($1,14)[-1],1,2,100,1,1) 
5.  
6.  Right-click in the new Split Window of the chart. 
7.  Select Add Study. 
8.  Select Formula Study. 
9.  Select (Folder Name) 
10.  Left-Click RSI_DAY.  

 
When you enter a symbol in the quote window, you will see the daily RSI value for that 
symbol. 
 

 

The Scale Function 
Sometimes it is useful to change the units in which an instrument is quoted. The Scale 
function allows users to control how a value is displayed in a quote window or quote 
page. 
 
For example, a formula in Aspen will normally be displayed in decimals. If you use a 
formula to evaluate Bonds, which trade in 32nd’s, you may also want to use the Scale 
function to display the result of the formula in 32nd’s. 
 
The Scale function has two parameters. The first parameter identifies what you want to 
modify; this can be a price, quote code, formula or variable. The second parameter tells 
the Scale function what the units should be modified to resemble; this can be a number, 
instrument or variable. 
 
For example, both scale($1.high,us#) and scale($1.high,32) will display the 
high value of any instrument in 32nd’s.   
 



The Scale function can be used to: 
 

Modify a Price … Example Syntax 
Using a number Display Bonds to three 

decimal places 

scale(usz8,1000) 

Using an instrument  Display 10-yr notes like 5-
year notes 

scale(ty#,fv#) 

Using a variable Display corn like another 
instrument 

scale(cn8,$1) 

Modify a Quote Code Example Syntax 
Using a number Display a bid in 64th’s scale($1.bid,64) 

Using an instrument Display the last price like a 
stock 

scale($1.last,ibm) 

Using a variable Display the net like another 
instrument 

scale(ibm.net,$2) 

Modify a Formula Example Syntax 
Using a number Display percent change in 

32nd’s 
scale(pchg($1),32) 

Using an instrument Display P&L in increments 
like the S&P’s 

scale(PandL($1),sp#
) 

Using a variable Display a spread in the first 
symbol’s units 

scale(spread1($1,$2
),$1) 

Modify a Variable Example Syntax 
Using a number Display an instrument in 

8th’s 
scale($1,8) 

Using an instrument Display an instrument like 
the S&P’s 

scale($1,sp#) 

Using a variable Display an instrument in 
other units 

scale($1,$2) 

 

Rounding and the Scale Function 
Cell width is important when using the SCALE() function to modify the number of 
decimal places of any value. If a cell’s width will not accommodate a decimal value 
rendered by the SCALE() function, the value returned may not be the value expected. 
 
When using the SCALE() function to display an instrument quote value in decimals, and 
its cell is too short to display all decimal places, Aspen Graphics drops off the decimal 
places it cannot display. The numbers are there, but the display width is too short, so the 
numbers are not visible on the page. 
 



In formula quotes, the SCALE() function truncates values modified by numbers and 
rounds values modified by instruments and quote groups when the display width is too 
short. 
 
To avoid problems caused by inadequate cell width, remember to allot extra space when 
using the SCALE() function. A cell can always be made smaller, but it is often difficult 
to make cells larger in a quote window. 
 

Writing a Formula 
Formulas are written in Aspen using two methods: by entering them directly on the chart 
and by using the Formula Editor. Directly entry is the ideal methods for one line formulas 
such as spreads. The Formula Editor is best used for complex multi-line formulas.  

Entering Formulas Directly on a Chart 
1. Create a Default Chart. 
2. Type the formula directly onto the chart. 
3. Press <enter>. 

 
Example Formulas: 
CH7 – CZ6 
SP# *.5 

The Formula Editor 
Complex, Multi-Line formulas are written using the formula editor. The Formula Editor 
and the Formula Manager are tools that complement each other. The Formula Manager is 
used to Manage Formulas and folder. The Formula Editor is used to create the formulas.  
 



The Formula Manager 

 
 

o New – Opens the Formula Editor Window for creating a new formula. 

o Open – Opens a selected Formula File for editing. 

o Convert – Converts existing formulas that use the Aspen 3.71 file format. 

o Rename – Renames the Formula file or folder. 

o Delete File – Deletes the selected file. 

o New Folder – Creates a new Formula folder named New Folder. 

o Delete Folder – Deletes the selected Formula folder. 

o Refresh – Recompiles the existing formulas. 

 

Displaying the Formula Manager 
 

Using the Context Sensitive Menu 
1. Right-Click an empty Aspen Workspace. 
2. Select Tools. 
3. Left-Click Formulas… 

 

Folders 

New 

Open 

Formula 
Files 

New 
Folder 

Refresh Rename 

Convert Delete 
File 

Delete 
Folder 



Using the Main Menu 
1. Left-Click Tools in the Main Menu. 
2. Left-Click Formulas… in the Tools Menu. 

 

Using Dot Commands 
1. Type .form <enter> 

 

The Formula Editor 

 
 

o New – Clears the current formula from the screen. 

o Save and Compile – Opens the Save Dialog and compiles the formula. 

o Delete File – Deletes the formula from the file folder. 

o Reset – Resets the cursor position in the Formula Editor.  

 

Example Formula 
The following example outlines the steps used to write a generic formula (one that can be 
used with any symbol) for an instrument’s average true range over 10 periods. 
 

New 
Save and 
Compile 

Delete 
File Reset 



To enter a new formula using the Formula Editor, 
follow these steps: 

1. Display the Formula Manager. 
2. Left-Click the New Formula Icon to display the Formula Editor. 
3. Enter the name for the formula. 
4. AvgTrueRange 
5. Press the = key. 
6. Select a function to use for the average. This example uses a Simple Moving 

Average. Enter the following: 
7. Now, enter the parameters for the savg() function. Remember to surround the 

parameters with parenthesis. Use the true range quote code .trange, and 
specify 10 for the number of periods. 

8.   AvgTrueRange=savg($1.trange,10) 
9. Left-Click the Save icon.  
10. Left-Click a folder name to save the formula in. 
11. Name the file AvgTrueRange. 
12. Click Ok.  

 

Embedded Formulas 
This shows how a previously defined formula called AvgTrueRange can 
be used, or embedded, in another formula (in this case, AvgTrueRange is 
embedded in a formula called range_form). 

 
range_form=(AvgTrueRange($1)+$1.recent)/2 

 

Reference to Past Bars  
This shows how a past value can be used in a formula using the square 
brackets []. Within the brackets, type the desired number of bars back that 
you want to use in the calculation.  [1] is the value one bar back, [2] is the 
value two bars back, etc. 

 
avg_volume=($1.volume + $1.volume[1] + $1.volume[2]) / 3 
 

Self-Referencing Formulas 
This shows how a formula can make reference to itself.  In this case, the current volume 
is added to the formula’s previous value. 
 
volAccumulator=$1.volume+volAccumulator[1] 
 



Formulas to be Charted (Custom Indicators)  
The following are examples of formulas you intend to chart, or custom indicators. 
 

MidTickAvg(input)=eavg($1.avgtick,14)    Overlay 
MFI_(series)=($1.high-$1.low)/$1.volume    Study 

 
Aspen Graphics has two categories of indicators: Overlays and Studies. 
 
Overlays are indicators which share the same scale as the price data. Moving averages 
are a good example of an overlay indicator. It makes sense to “overlay” a moving average 
on a bar chart or candlesticks because its values are related and very close to the price 
data.  
 
Studies refer to the group of indicators which have their own scale.  Volume is a good 
example of such an indicator. An instrument’s volume is usually very different from the 
underlying symbol’s price, as in the case of an equity which trades in the $17 to $18 price 
range and has a volume of several hundred thousand shares. If study is placed in the same 
window as a chart, in most cases this will flatten the chart making it difficult to read.   

 
A custom indicator is written in the same manner as writing a formula using the Formula 
Editor with one exception. The category the indicator will be used in must be specified as 
an overlay or a study. 

 
If the indicator is to be viewed as an overlay, insert the word input in parenthesis after 
the formula’s name, as in this example: 
 

MidTickAvg(input)=eavg($1.avgtick,14) 
 
If the indicator is to be viewed as a study, insert the word series in parenthesis after the 
formula’s name, as in this example: 

 
MFI_(series)=($1.high-$1.low)/$1.volume 

 

Displaying a Formula on a Chart 
There are two approaches used when charting a formula. Formulas with the input or 
series keywords are used with a chart of an instrument. Formulas with neither keyword 
may be charted without placing an instrument on the chart. 
  

Formulas with No Keywords 
1.  Bring up a chart. 
2.  Type the name of the formula. 
3.  Press <enter>. 



 If the formula was written using the $1 variable, you need to specify the name of the 
formula and the instrument to be used in place of the variable.  For example: 
My_Formula(ibm) and press <enter>. 

Formulas Using the Input Keyword 

Using Icons 
1. Create a chart. 
2. Add a symbol. 
3. Left-Click the Add Overlay icon in the Chart Toolbar.  
4. Select Formula Overlay 
5. Select the sub-folder the formula resides in. 
6. Left-Click the formula name to apply it. 

 

Using the Context Sensitive Menu 
1. Create a chart. 
2. Add a symbol. 
3. Right-Click the chart. 
4. Select Add Overlay. 
5. Select Formula Overlay. 
6. Select the sub-folder the formula resides in. 
7. Left-Click the formula name to apply it. 
 

Using the Main Menu 
1. Create a chart. 
2. Add a symbol. 
3. Left-Click Study in the Main Menu. 
4. Select Add Overlay. 
5. Select Formula Overlay. 
6. Select the sub-folder the formula resides in. 
7. Left-Click the formula name to apply it. 
 

Formulas Using the Series Keyword 

Using Icons 
1. Create a chart. 
2. Add a symbol. 

3. Left-Click the Add Study to New Split Icon.  
4. Select Formula Study. 
5. Select the sub-folder the formula resides in. 
6. Left-Click the formula name to apply it.  



Using the Context Sensitive Menu 
1. Create a chart. 
2. Add a symbol. 
3. Right-Click the Chart. 
4. Left-Click Add Split for Study. 
5. Right-Click the New Split Window. 
6. Left-Click Add Study. 
7. Select Formula Study. 
8. Select the sub-folder the formula resides in. 
9. Left-Click the formula name to apply it. 
 

Using the Main Menu 
1. Create a chart. 
2. Add a symbol. 
3. Left-Click Chart in the Main Menu. 
4. Left-Click Add Split for Study in the Chart Menu. 
5. Left-Click Study in the Main Menu. 
6. Select Add Study in the Study Menu.  
7. Select Formula Study. 
8. Select the sub-folder the formula resides in. 
9. Left-Click the formula name to apply it.  

 

Displaying a Formula in a Quote Window  
The value of a formula can be displayed in a Quote Window by formatting the name of 
the formula in a quote window. For instructions on how to format a quote window, see 
the Quotes chapter of this manual. Some examples of formatting a formula in a quote 
window are shown below.  

 
 

The formula 
appears as: 

Formula should be 
formatted as: 

Because: 

Weekhigh= 
chart(ibm.high,7
,2,100,1,1) 

weekhigh All the information necessary to 
calculate the formula is present; 
there are no variables. 

Pchg=($1.recent-
$1.prev)/$1.prev
*100 

pchg($1) The $1 is a variable, holding the 
place for an instrument that will be 
specified later. 

SPREAD=$1-$2 SPREAD($1,$2) There are two variables in the 
formula, so we leave room for the 
two variables we’ll be specifying 
later. 

21DayHi=rmax 
($1.high,21) 

Chart(21DayHi($1)
[-1],1,2,100,1,1)

The formula needs the same frame 
of reference as a chart.  This is 



supplied by the chart( ) function. 
 

 Some formulas require the chart function chart( ) when being formatted in a quote 
window. 

Studies-on-Studies 
Formulas can be written so that a study is performed on another study. In the previous 
example, a three-period RSI is performed on a one-period Momentum study. For 
example: 

 
RSI_Momentum(series)=rsi(mom($1,1),3) 

 
 

Multi Line Formula Writing 
Up to this point all of the formulas in this manual have been single line formulas. Much 
more advanced and organized formulas are possible by using multiple lines. In a multi 
line formula it is possible declare any number of simple variables, use Aspen functions 
and use embedded formulas.  

Expression Blocks 
Multi line formula writing requires the use of expression blocks. These 
statements tell the formula writer where an expression begins and ends. 
They can be written in two ways, Begin … End or {….}. All multi line 
formulas start with a Begin statement (or { ) after the equals sign and 
terminate with an End (or } )statement as their last line. Expression blocks 
can also be used in logical statements such as If.... Begin… End to 
create multi-line, boolean logic statements.  
 

Multi-Line Formula Structure 
myFormula(series) = begin 
 
 <Formula Logic> 
End 
 

Multi-Line If Statements 
myFormula(series) = begin 
 if $1.high < $1.high[1] then begin 
  <Execute some logic> 
 end 
 
 if $1.high > $1.high[1] then begin 
  <Execute some logic> 



 end 
end 
 

 
 

Declaring Variables 
Multi-line formulas support variables, which are place holders for data. A formula will 
return the last variable listed before exiting. Variables are declared using the following 
syntax: 
 
 Identifier = Value 
 
Identifiers must abide by naming rules. Identifiers cannot be named an existing Aspen 
function, ticker symbol or formula name. Identifiers must use alpha-numeric characters.  
 
 In many pre-defined Aspen Graphics formulas we use the variable retval, short for 
return value. Retval is given a starting value, often 0, and then calculations are done in 
the formula to change that value which is then returned. Here is an example of a simple 
multi-line formula using retval as a variable. Retval begins equal to 0. If the high of 
the period is greater than the top Bollinger band then retval is equal to 1. If the low of 
the period is less than the lower Bollinger band then retval is equal to -1. 
 

 

Drawing Text Values on the Screen 
Multi-line formulas allow greater scope for formula writing as they contain functions for 
looping and multi-line If statements than single line formula. Also the ability to have text 
returned as a result of a formula as well as numeric values is not available to single line 
formulas. This can be useful for identifying candlestick formations or indicating where 
averages cross without the need for the lines themselves to be drawn. When used with 
Quote windows we can have buy, sell or hold indications appear dependent on market 
conditions. 
 
Displaying text instead of values as the result of a formula is achieved by enclosing the 
text in single quotation marks: 
 



 “My Text” 
 
There are a number of additional parameters which can follow the text, each separated by 
the pipe ( | ) symbol.  The parameters are: 
 

Parameter Result 
Above Draws the Text above the chart 
Below Draws the Text below the chart 

Horizontal Draws the Text horizontally 
Vertical Draws the Text vertically 
FTiny Sets the font size to Tiny 
FSmall Sets the font size to Small 
FNomal Sets the font size to Normal 

FBig Sets the font size to Big 
Arrow Displays an arrow indicating the bar the 

text is associated with. 
Clr_Black Displays Black Text. 
Clr_Blue Displays Blue Text. 
Clr_Cyan Displays Cyan Text. 
Clr_Gray Displays Grey Text. 
Clr_Green Displays Green Text. 
Clr_Orange Displays Orange Text. 

Clr_Pink Displays Pink Text. 
Clr_Purple Displays Purple Text. 

Clr_Red Displays Red Text. 
Clr_Violet Displays Violet Text. 
Clr_White Displays White Text. 
Clr_Yellow Displays Yellow Text. 

 
Examples: 
 “Sell”|clr_green|ftiny|below|arrow|vertical 
 
 “Sell“|clr_red|ftiny|above|arrow|horizontal 
 

Multi-Line Formula Examples 
In the first example, we need to display the points at which a short-term moving average 
crosses a long-term one. At first the point at which lines cross might appear to be when 
the values are equal, but this is not the case. In the vast majority of cases the point at 
which the lines actually touch and are of the same value is between two successive bars, 
therefore to determine if the lines have crossed we need to check whether the value of 
line 1 was previously below line 2 and is now greater than line 2. 
 
Given that the periods in our averages are 10 and 100, we need to write an IF statement 
comparing their relative values on the two bars: 
 



IF SAVG($1,10)[1]<SAVG($1,100)[1] AND SAVG($1,10)>SAVG($1,100) 
THEN….. 
 
When using multi-line formulae, the basic format is the same as for single line formulae 
i.e. formulaname=expression, however to indicate that a multi-line formula is being 
written, the word begin follows the = and the rest of the formula goes on subsequent 
lines. At the end of the formula, because we have ‘begun’ it we must also end it. 
 
The name of the formula will be 10x100 (10 crossing 100), and is written as follows: 
 
10x100(input)=begin 

if savg($1,10)>savg($1,100) and 
savg($1,10)[1]<savg($1,100)[1] then begin 

‘Av X’d’|clr_cyan|fsmall|above|arrow|horizontal 
end 

end 
 
This formula can be applied to the chart by adding a formula overlay: 

 
 
 
The example below introduces the concept of looping use the While…End statements. 
The entire formula is written out with a description of each section. The premise is that 
we are looking for a peak to be made by both the price and the slow stochastic; a peak 
being defined as x number of days with successive higher highs followed by a similar 
number of days with successive lower highs. The x being a parameter called PEAKLEN.  
Further, we then look y number of days into the future and check to see if the price has 
gone up on the peak price and the stochastic is lower than the peak stochastic, or visa 



versa. This would indicate a divergence. Again the number of days is a parameter, this 
time called DIVERGE.  
 
This section establishes the name of the overlay formula, the default values for the two 
parameters, and defines four variables peakmade (checks the rising then falling prices), 
speakmade (checks the rising then falling stochastics), 2Peaks (whether both price and 
stochastic make a peak), and divsig (checks whether a divergence occurs) 
 
MyDiverge(input,peaklen=2,Diverge=5)=begin 

peakmade=0 
speakmade=0 
2peaks=0 
divsig=0 

 
This line sets the start point to be divergence-plus-peak-length bars back (initially seven 
bars) 
 
currpeak=peaklen+diverge 
 
We now have the loop when checks for the successive higher highs for both the price and 
stochastic, each time a new high is set then the peakmade and speakmade variables 
increase by one, and the CURRPEAK value decreases by one until the number of rising 
highs have been checked for. 
 
while (currpeak>diverge) do begin  
 if $1.high[currpeak-1]>$1.high[currpeak] then 
peakmade=peakmade+1 
 if sstoch($1,9,3)[currpeak-1]>sstoch($1,9,3)[currpeak] then 
speakmade=speakmade+1 
 currpeak=currpeak-1 
end 
 
 
while (currpeak>diverge-peaklen) do begin 
if $1.high[currpeak-1]<$1.high[currpeak] then peakmade=peakmade+1 

if sstoch($1,9,3)[currpeak-1]<sstoch($1,9,3)[currpeak] then  
 speakmade=speakmade+1 

  currpeak=currpeak-1 
end 

 
The successive lower highs are now checked and again, if made, the appropriate variable 
is increased, until the requisite number of PEAKLEN bars has been checked. 
 
if speakmade == peaklen*2 and peakmade == peaklen*2 then 2peaks=1 
 
If a peak has been made for either the price or the stochastic then the PEAKMADE and 
SPEAKMADE values will be twice the number of the PEAKLEN. The line above checks to 



see if both these are twice the length, at which point the 2PEAK variable is assigned a 
value of 1. 
 
if 2peaks == 1 then begin 
 
The values of the price and the stochastic at the peak are now compared with the current 
values and if the divergence has occurred then the DIVSIG variable is assigned a value of 
1 and the appropriate text is displayed. 
 
if ($1[diverge]>$1 and sstoch($1,9,3)[diverge]<sstoch($1,9,3)) or 
($1[diverge]<$1 and sstoch($1,9,3)[diverge]>sstoch($1,9,3)) then  
 divsig=1 
end 
 
if divsig==1 then begin 

'Diverge'|ftiny|clr_green|vertical|below|arrow 
end 
end 
 

 
 
Again because we have defined Diverge and PeakLen as parameters, they can be changed 
through the menu. 
 

Entire Formula Listing: 
MyDiverge(input,peaklen=2,Diverge=5)=begin 

peakmade=0 
speakmade=0 
2peaks=0 



divsig=0 
 

currpeak=peaklen+diverge 
 
 

while (currpeak>diverge) do begin  
if $1.high[currpeak-1]>$1.high[currpeak] then 
peakmade=peakmade+1 

 
if sstoch($1,9,3)[currpeak-1]>sstoch($1,9,3)[currpeak] 
then speakmade=speakmade+1 

  
currpeak=currpeak-1 

end 
 

while (currpeak>diverge-peaklen) do begin 
if $1.high[currpeak-1]<$1.high[currpeak] then 
peakmade=peakmade+1 

 
if sstoch($1,9,3)[currpeak-1]<sstoch($1,9,3)[currpeak] 
then speakmade=speakmade+1 
 

  currpeak=currpeak-1 
end 

 
if speakmade == peaklen*2 and peakmade == peaklen*2 then 
2peaks=1 

 
if 2peaks == 1 then begin 

if ($1[diverge]> $1 and sstoch($1,9,3)[diverge] < 
sstoch($1,9,3)) or ($1[diverge] < $1 and 
sstoch($1,9,3)[diverge] > sstoch($1,9,3)) then  

  divsig=1 
end 

 
if divsig==1 then begin 

'Diverge'|ftiny|clr_green|vertical|below|arrow 
end 

end 

 

Color Rules 
By default, the bars in Aspen Graphics charts are yellow. In addition to being able to 
change the color of the bars from the Bar Chart parameter menu, Aspen Graphics has a 
Color Rule capability. Color rules act as a visual alarm on a bar chart, coloring certain 
bars which meet user-defined criteria. For example, a color rule can be written so that 
each bar that hits a 21-day high will be colored red, while all other bars will remain 
yellow. 



 

Color Rule Dialog 

 
 

o Close – Closes the Color Rule Dialog. 

o Add – Opens the New Color Rule Dialog. 

o Edit – Opens the Edit Color Rule Dialog. 

o Delete – Deletes the selected Color Rule. 

o Import – Imports Color Rules from Previous Versions of Aspen. 

 

Displaying the Color Rule Dialog 

Using the Context Sensitive Menu 
1. Right-Click an empty Aspen Workspace. 
2. Select Tools. 
3. Left-Click Color Rules… 
 

Using the Main Menu 
1. Left-Click Tools in the Main Menu. 
2. Left-Click Color Rules in the Tools Menu.  
 

Using Dot Commands 
1. Type .color <enter> 
 



Creating a Custom Color Rule 
Display the New Color Rule Dialog by Left-Clicking the Add Button in the Color Rule 
Dialog. 

 
 

o Name - A unique name for the color rule must be entered in this field.  This is one 
of the few instances where spaces can be used in the name. Up to 39 characters 
can be used for the color rule name. 

o Formula – The condition for the color rule must be entered here, using formula 
language.  Color rules are limited to 255 characters. 

o Memorandum – Allows the user to enter a description of the color rule.  Up to 39 
characters may be entered in the Memorandum field. 

o Status – This field is not editable; it displays information about the color rule.  If 
the syntax of your formula is correct, the status field will display OK.  If an error 
has been made in writing the color rule, an error message will be displayed. 

o Ok – Adds the color rule to memory and displays the Color Rule menu. 

o Cancel – Aborts the color rule; it is not saved in memory. 

o Delete - Deletes the selected color rule from memory. 
 
 

Color Rule Syntax 
Color Rule syntax closely resembles single-line formula syntax. Color Rules cannot use 
multi-line syntax by themselves. Also, the syntax for IF statements is slightly different. 
The Boolean test syntax remains the same, however, the statements that should be 
executed when the Boolean statement is true or false are separated by commas.  
 



If (<Boolean statement>, <True command>, <False Command>) 
 
if(pchg ($1)>5,clr_green,clr_red) 
 
If – Then, Else-If and Else statements are written by placing Else-If Boolean 
tests following the command that is executed when the initial If statement is evaluated: 
 
IF (<Boolean Statement>, <True Command>, If(<Else-If Statement>, 
<Else-If True Command>, <False Command for BOTH Boolean 
statements> )) 
 
If(pchg ($1) > 5, clr_green, if (pchg($1) < 0, clr_red, 
clr_yellow)) 
 
The above statement says that if PCHG is greater than 5, color the bar green. If PCHG is 
less than 0, then color the bar red. Otherwise color the bar yellow.  
 
Color rules are not case sensitive; upper and lower case letters can be used 
interchangeably. Using both upper and lower case letters in the name can make it easier 
to read from the Color Rules menu. 
 

Color Rule Example 
The following steps will take you through the process of writing a generic color rule. This 
color rule alerts you when the current bar of the charted instrument has increased 5% 
from the previous bar, using the pchg formula already entered in the Formula Listing. 
 
This formula will color any bar on the chart green where the percent change from the 
previous bar was above 5%.  The rest of the bars on the chart will be colored red.  The $1 
variable was used so that the color rule could be applied to any instrument that is 
displayed in the chart. 
 

To write a color rule for this condition, follow these steps: 
1. In the Color Rule Dialog, Left-Click the Add button. 
2. Left-Click the Name textbox.   
3. Type in 5% Gain 
4. Left-Click the Formula textbox. 
5. Type the following: 

if(pchg ($1)>5,clr_green,clr_red) 
6. Left-Click the Memorandum Textbox. 
7. Check the Status field; if it says ok, select Done. If it has an error message, 

change the formula to read exactly as the line above. 
 

Writing a Color Rule for a Specific Symbol 



 
Color rules can be written either generically or specifically. The 5% Gain color 
rule in the previous example is generic; it will calculate on any instrument 
displayed on the chart. Replacing $1 with an instrument (i.e. SPH7) would 
calculate the color rule using that instrument, regardless of the data displayed in 
the bar chart. For example, the 5% Gain formula could be written as: 
 
if(pchg(sph7)>5,clr_green,clr_red) 
 
Written this way, IBM could be displayed in the bar chart and the bars of the chart 
will be colored based on the percent change of SPH7. 

 

 If you define a specific symbol in your color rule, it will only calculate your formula 
for that symbol, regardless of what symbol is displayed in the chart. 

 
 

Edit a Color Rule 
To edit a color rule already entered in Aspen Graphics, follow these steps: 
 

1.  Display the Color Rule Dialog.  
2.  Left-Click a Color Rule to Select it.  
3.  Make any necessary changes to the color rule. 
4.  Left-Click on Done. 

 

Using Color Rules in a Chart 
Once a color rule has been written, an additional step must be taken to activate it on a 
chart. To display a color rule on the chart, follow these steps: 
 

1. Right-Click the Chart.   
2. Left-Click Parameters… 
3. Left-Click the + Icon beside the word Color. 
4. Left-Click the word Yellow by the High field. 



 
5. Left-Click the Yellow Colored Box to display the Color Picker.  

 
6. Left-Click the Color Rules… Button.  
7. Double-Click the Color Rule name to select it. 
8. Click Apply. 
 

When you edit an active color rule, the changes will take effect immediately on any chart 
on which that color rule is active.   
 
When a color rule is activated on a chart and the cursor window is displayed, the High 
price in the cursor window will be drawn in the same color as the bar. 
 
Other data listed in the cursor window can be displayed in different colors using color 
rules. Although a color rule enacted on a value other than the High price will change the 
color of that price in the cursor window, the color of the bar itself will only be controlled 
by the color or color rule selected for the High price in the Bar Chart parameter menu. 

 
 



Using Color Rules to Color Studies 
Color rules can be displayed on studies as well as price data. When using color rules to 
color study values, there are two options. If you want the color rule to evaluate data based 
upon the values of the study, use the $1 convention. For example, to be alerted when the 
slope of the study is rising, enter the following in the formula field: 
 

if($1>$1[1],clr_green,clr_red) 
 

 
To color a STUDY based upon data of the underlying instrument, RAWDATA must be 
used instead of $1. For example, to be alerted when the instrument’s price is rising or 
falling, regardless of the study value displayed on the chart, enter the following formula:  
 

if(rawdata>rawdata[1],clr_green,clr_red) 
 
With a study displayed in a chart, activate the color rule by bringing using the same 
method as adding a color rule to a chart. 
 

Using Number Codes For Colors In A Color Rule 
In very lengthy color rule formulas, replacing the number codes for the colors can save 
valuable space.  (Color rule formulas are limited to 255 characters). Number equivalents 
to system colors are listed below. 
 

Color Named Constant Number
Yellow clr_yellow 0 
Green clr_green 1 
Cyan clr_cyan 2 
White clr_white 3 
Violet clr_violet 4 
Pink clr_pink 5 

Orange clr_orange 6 
Gray clr_gray 7 
Red clr_red 8 
Blue clr_blue 9 

Purple clr_purple 10 
Black clr_black 11 

 
 

The 5% Gain formula, using number codes in place of the colors, would be 
written the following way: 

 
if(pchg($1)>5,1,8) 

 



Coloring Specific Prices  
 
Color rules can be used to color a specific price on the bar chart.  For example, to set 5% 
Gain to the Low price, follow these steps: 

 
1.  Right-Click the chart. 
2.  Left-Click on Parameters… 
3.  Left-Click on the color name to the right of the Low price. 
4.  Left-Click on the Colored Box to the right of the Low Price. 
5.  Left-Click the Color Rules… button. 
6.  Double-Click on 5% Gain. 
7.  On the Parameter menu, under the Graph heading, Left-Click on Bars and 

change to Dots.   
Left-Click on Done. 

 
 

Alarms 
Alarms, or "alerts", let a trader know when certain market conditions have been met.  
They can be a visual alarm, an audio alarm or a combination of the two. An alarm is 
completely independent of anything else in Aspen Graphics. Once a user sets an alarm, 
s/he will be free to use their program for whatever they want - to watch another market, 
for profit and loss analysis, to enter strategies - while the alarm is constantly monitoring 
conditions in the background. 

 
This saves the user: 

o Time – you are free to work on other projects instead of watching a chart, waiting 
for their criteria to be met. 

o Space - you don't have to have a chart or quote window on the screen, so you can 
dedicate more room to other things. 

o Money - alarms are added insurance that a trade opportunity won't be missed. 
 

  If the Aspen Graphics session is minimized while you are working on another 
application, Aspen Graphics will "assert" itself as the active application when the alarm 
triggers. 
 

What can Trigger an Alarm? 
Aspen Graphics allows you to set alarms on: 

o PRICE: clx2<=19 

o TIME: time==15:30 



o DATE:  date==12/31/99 

o EXPIRE: date==clx4.expire-2 (alerts you 2 days before Nov 2004 crude 
expires) 

o FORMULAS: pchg(us#)>=.5 (when the value of "pchg" (percent change) is 
greater than or equal to .5 for the lead month of bonds). 

o EXPRESSIONS: sp#.prev-sp#.low>=10 (when S&P is down 10 points 
from yesterday's close) 
 

Any formula that can be entered in the Formula Writer can have an alarm set on it. Since 
most of the "canned" studies that come with Aspen Graphics can be written this way, 
these studies can have alarms set on them. 

 
Note: if the formula contains a ranged function (e.g. the highest high in the last 14 bars) 
or a subscription (e.g. the previous bar, or two bars back), the formula must include the 
Chart( ) function. See the Formulas section of this document for more details on using the 
Chart( ) function. 
 

 Alarms cannot monitor Trendlines or News stories. 
 

What Happens When The Alarm Is Triggered?  
When an alarm is triggered, an alarm window is displayed across the bottom of the screen 
(if Visual Alert is enabled). The alarm window will include the date & time the alarm 
was triggered, the state of the trigger condition (T=true, F=false), the trigger condition, a 
memorandum (if a message in the Memorandum field is specified) and directions for 
removing the alarm window from the screen. 
 

  If the “Trigger When State” matches the “Current State” in the Alarm Setup 
Window, your alarm will be triggered as soon as you select Done.  This allows you to test 
your alarm after creating it to ensure that it is evaluating your criteria properly. 

 
If more than one alarm is triggered before the alarm window is cleared off the screen, 
they will be stacked on top of one another. The number of alarms that can be displayed at 
one time depends on the font size settings; the smaller the font size, the more alarms that 
can be displayed simultaneously. 
 

 
 

Limitations on Setting Alarms 
o There is a maximum of 299 alarms that can be defined in any one session of 



Aspen Graphics.  

o There is a maximum of 256 characters per command 

o Activating many alarms that utilize the Chart Function could slow down system 
performance if they are very math-intensive. This may be alleviated somewhat by 
adding a "mem" clause (e.g. mem=12336) to the Target line of the icon which 
launches the Aspen Graphics program. Contact a support technician for assistance 
in adding this clause. 

 

The Alarm List Dialog 

 
 

o Close – Closes the Alarm List Dialog. 

o Add – Opens the New Alarm Dialog. 

o Edit – Opens the Edit Alarm Dialog. 

o Delete – Deletes the selected Alarm. 

o Import – Imports Alarms from Previous Versions of Aspen. 
 

Displaying the Alarm List Dialog 

Using the Main Menu 
1. Left-Click Tools in the Main Menu. 
2. Left-Click Alarms… in the Tools Menu. 

 

Using the Context Sensitive Menu 
1. Right-Click an empty Aspen Workspace. 
2. Select Tools. 
3. Left-Click Alarms… 



Using Dot Commands 
1. Type .alarm <enter> anywhere in Aspen.  
 

 

Adding or Editing an Alarm 

 
 

o Trigger Condition – Specifies the alert condition. (SPM7 == 765 or CK8.Recent – 
CN8.Recent > 4) 

o Memorandum – Optional and requires no entry. Configures a message that will be 
displayed in the visual alert box when the alarm is activated. 

o Command Actions on Trigger – Allows the user to assign an action to be 
performed when the alarm conditions are met.   

o Trigger State – Set the alarm to be activated when the Trigger Condition is True, 
False, or when the current status Changes. Selection depends on how the Trigger 
Condition is written. The Changes selection is probably best used when triggering 
the crossing of two study lines. 

o Enabled – Disables or enables the alarm. 

o Auto-Delete – Automatically deletes the Alarm after triggering. 



o Visual Alert - Toggle the visual alarm window on or off. 

o  Trigger Frequency – Continuous: configures the alarm to trigger continuously. 
Daily: Configures the alarm to trigger once a day. Once: Configures the alarm to 
trigger once.  

o Audio Alarm – Configures the alarm to place a specified wave file. Use the up 
and down buttons to scroll through the possible wave files. 

o Audio Repeat – Selecting this option will configure the alarm to repeat an audio 
alert every 10 seconds until the alarm is disabled. Deselecting this option will 
configure the alarm to play the audio alert only once.  

o Frequency – Never: configures the alarm to never send an email. Always: Sends 
an email every time the alarm triggers. Once: Sends the email only once when the 
alarm is triggered. 

o Configure Email – Launches the setup options dialog for configuring email 
preferences.  

o Recipient(s) – Configures one or more email addresses as recipients when the 
alarm triggers. Separate multiple addresses with a semi-colon. 
(myEmail@email.com; yourEmail@email.com) 

 

Defining a Trigger Condition 
The first step in writing an alarm is establishing the Trigger Condition. To enter a Trigger 
Condition, Left-Click in the Trigger Condition textbox and type the condition. There are 
six types of criteria that can be entered in this field. The following sections include 
definitions and examples of these. 
 

Instrument Symbols and Prices 
An alarm can be configured for any instrument that is defined in your feed. The 
Trigger Condition needs to reference a specific instrument; using the $1 variable 
will return an error message in the Current State field. 

 
Examples Result of Condition 

ibm==137 When the price of IBM reaches 137 
 
 
 

Times 
Alarms can be written to trigger at a specific time. These trigger conditions need 
to be written in HH:MM format, using 24-hour notation. 

 
Examples Result of Condition 



time>=9:00 On or after 9:00 a.m. 
time==15:45 At 3:45 p.m. 

 
 

Dates 
Dates used in trigger conditions need to be stated in mm/dd/yy format. Dates can 
be combined with times using the and operator. 

 

Examples Result of Condition 
date==4/15/97 On April 15, 1997 
date>=1/1/98  On or after Jan 1, 1998 
date==6/1/97 
and 
time==14:00 

On June 1, 1997 at 2:00 
p.m.  

 
 

Aspen Graphics’ date math capabilities make it possible to create alarms that tell 
you when it is a certain number of days before a future’s or option’s expiration 
date. 

 
Examples Result of Condition 

date==ck300c.expire-3 Three days before 
expiration 

date==spu7.expire Expiration day 
date<=dmm7.expire-2 Two days before 

expiration 
 

Table 17 
 

Formulas 
Any formula defined in the Formula Manager can be referenced in the 
Trigger Condition of an alarm. If the formula was written using the 
$1variable the symbol must be included in the trigger condition. 

 
Examples Result of Condition 

spread(ck7,cn7)>=0 When the spread value is 
positive 

chart(slowk(sp#,9)>=slowd
(sp#,9)[1],1,2,100,0,1) 

When the %K line is 
above %D line 

 

  If you are setting an alarm on a formula which requires other parameters in addition 
to an instrument, you must use the chart function around the formula. 
 



Functions 
An alarm can be set to monitor any Aspen Graphics function. For a complete list 
of functions, see the Formulas section of this manual. 
 
 

Examples Result of Condition 
chart((mom(sp#,10)>mom(sp#,10)[1] 
and mom(sp#,10)[1]>mom(sp#,10)[2]) 
[-1],1,2,100,1,3) 

When momentum is 
increasing over the last 
2 bars 

chart((rsi(ck7,14)>70 or 
rsi(ck7,14)<30)[-1],30,1,100,1,3) 

When the RSI is above 
or below 30 

 
 
 

Expressions 
You can write a mathematical expression as a condition for an alarm. An 
expression can employ any of the operators below. 
 

Operator Name Example 
^ Exponentiation kc#^2 
- Negative -2*(ibm.last) 
+ Positive +spz7 
* Multiplication 42*(ho#)-cl# 
/ Division ibm/indu 
+ Addition ck7+cn7 
- Subtraction cc#-cc#1 

== Equals intc==131 
>= Greater than or equal 

to 
kw#>=470 

<= Less than or equal to time<=14:00 
!= Does not equal date!=1/1/98 
> Greater than gcm7>gcz7 
< Less than ok7<175 

A space must be used before and after the next two 
operators when using them in a formula. 

AND Evaluates both trigger 
conditions.  Alerts 
only when both 
conditions are met. 

ck7.high<=300 
and 
cn7.high>=300 

OR Evaluates both trigger 
conditions.  Alerts 
when either condition 
is met. 

time==9:45 or 
time==13:10 

 



Command Actions on Trigger 
The Command Actions on Trigger feature allow you to assign any Aspen Graphics 
command to be enacted when your alarm is triggered. Individual commands should be 
separated by a semi-colon. For example, if you have written an alarm to trigger when the 
price of May corn goes above 305 and would like to print a page (called My_Page) when 
the alarm is triggered, enter the following in the Command Actions on Trigger field: 
 

My_Page; \CK7;.print 
 
When the alarm is triggered, My_Page will be displayed on your screen. May corn will 
be entered into all windows on the page, and the page will be printed. 

 
The portion of the screen that will be printed when the alarm is triggered depends on the 
selection in the Object section of the Print Setup box. If Screen is selected, the entire 
contents of the screen, including the alarm window, will be printed. If Active Window is 
selected, only the window which was active when the page was saved will be printed. 
 
 

  If you want to auto-print using this method, make sure that Print Preview (found in 
the Print Setup box) is not selected. If Print Preview is selected, the system will wait for 
you to approve the print job before it is printed. 
 

Setting an Audio Alarm 
The Audio Alarm field configures the alarm assign a sound sequence to an alarm. Single 
left clicking in the Audio Alarm field will scroll through the audio files assigned to the 
audio alarms. Setting this field to None will only trigger a visual alarm; no audio alarm 
will accompany it. 
 
If your computer is equipped with a sound card, you have access to up to 99 audio 
alarms. Using the Windows® audio recorder, you can record a custom message and 
assign it to an alarm. The Windows® audio recorder creates .WAV files. To create a 
.WAV file for use in an Aspen alarm, record a message, and name the file using the 
convention ALARM<integer>.WAV. Examples of names for your .WAV files are: 
 

Alarm1.wav 
Alarm23.wav 
Alarm89.wav 

 
Up to 99 unique .WAV files can be saved and applied to the Aspen alarm feature. Save 
the .WAV files to the \apex directory on the drive Aspen Graphics is located in. 

 
To assign a .WAV file to an alarm, left click in the Audio Alarm field until the file name 
which corresponds to the name of the .WAV file is displayed. For instance, if the file is 
named Alarm16.wav, scroll through the numbers in the Audio Alarm field until the name 



ALARM16.WAV appears. When the alarm is triggered, the selected custom recording 
will play. 
 

Alarms on Instruments Quoted in Fractions 
Some equities and commodities are quoted in fractional numbers, i.e. U.S. Bonds are 
quoted in thirty-seconds and grain options are traded in eighths. To set alarms based on 
fractional prices, use the following syntax: 
 

Syntax Meaning 
v+numerator Specifies eighths. To enter a price in 

the trigger condition in eighths, (for 
example, sx600c==29 3/8 ) type in 
sx600c==29 v3. 

'+ numerator Specifies thirty-seconds.  To enter a 
price in the trigger condition quoted 
in 32’s, (i.e. us#>=107 26/32), type in 
us#>=107'26.   

'+<32nds><1/8’s of 32nds> Specifies half- and quarter-thirty-
seconds.  See the following section 
on Half and Quarter Thirty Seconds. 

 

 To indicate a single digit numerator for 32’s, you must preface it with a zero.  For 
example:  us#==107 3/32 would be entered us#==107’03.  A price of less than one also 
needs a zero.   14/32’s would be entered as:  0’14. 
 

Half- and Quarter-Thirty-Seconds 
To enter a trigger condition based on half-thirty seconds, follow these steps:  

 
1.  Reduce the fraction to thirty-seconds. This will produce one of two 

conclusions: 
 

a) The fraction reduces to an even number. For example, you want to set an 
alarm to alert you when the five-year note hits 104 28/64. This fraction 
reduces to 14/32.  The Trigger Condition should be written as: 

fv#==104’14 



b)  The fraction does not reduce evenly. For example, you want to be 
alerted when it hits 10443/64. This trigger condition should be entered 
as: 

fv#==104’214 
 

104 - Represents the whole-number portion of the price. 
 
‘21  - Represents the reduced numerator (43/64 reduces to 21.5/32). 
 
4 - Represents the multiplier 4/8, converting the fraction to half-thirty-
seconds. 

 
2. To enter a trigger condition based on quarter-thirty-seconds follow these 

steps: 
 

a) Reduce the fraction to thirty-seconds. 
If it reduces evenly, follow step a in the 
previous section. 

 
If the fraction does not reduce evenly, 
follow these steps: 

 
.  For example, you want to use tu#==10253/128 as the Trigger Condition.  It 

would be entered as: 
 

tu#==102’132 
 
102 - Represents the whole-number portion of the price. 

 
13 - Represents the reduced numerator (53/128 reduces to 131/4 thirty-
seconds). 

 
2 - Represents the multiplier 2/8, converting the price to quarter-
thirty-seconds. 

 

Alarm Examples 
These examples highlight some of the opportunities available through Alarms. 
 

Slow Stochastic Lines Crossing 
 

This alarm triggers each time the SlowD line crosses the SlowK on a daily bar chart. 
Three Aspen Graphics functions are used in this alarm: the ssstoch() function, which 
replicates the SlowD line of a Slow Stochastic, the sstoch() function, which replicates 



the SlowK line, and the chart(). The Chart Function () works like a shell around the 
other two functions, providing the same frame-of-reference to the alarm when charting 
the study. 

 

Trigger Condition: 
chart((ssstoch(us#,9,3,3)>=sstoch(us#,9,3))[-1],1,2,100,1,3) 
 

Trigger State: 
Changes 
 

 

Slow Stochastic Lines Crossing Above 80 or Below 
20 

 

This alarm differs from the earlier Stochastic alarm it only alerts you when the SlowD 
and SlowK lines cross above 80 or below 20. 
 

Trigger Condition:  
chart(((ssstoch(us#,9,3,3)>=sstoch(us#,9,3) and 
ssstoch(us#,9,3,3)[1]<sstoch(us#,9,3)[1] and sstoch(us#,9,3)>=80) 
or (ssstoch(us#,9,3,3)<=sstoch(us#,9,3) and 
ssstoch(us#,9,3,3)[1]>sstoch(us#,9,3)[1] and  
sstoch(us#,9,3)<=20)[-1],1,2,100,1,3) 

 

Trigger State: 
True 
 

Price Breakouts from Bollinger Bands 
 

This alarm triggers when the price of NGZ9.fs breaks the top or bottom of the Bollinger 
bands. The function used for the Bollinger Band calculations is bb( ). Default 
parameters are used in the example; these can be modified at the user’s discretion. 
 
 

Trigger Condition: 
chart((NGZ9.low<bb(ngz4,20,-2,1) or NGZ9.high>bb(NGZ9,20,2,1)) 
[-1],60,1,100,1,1) 
 

Trigger State: 
True 
 

 



The Chart Function parameters used above ( i.e. [-1],60,1,100,1,1) ) are used 
when: 

[-1] the alarm recalculates each time there is a price change 
60,1 the hourly study values 
100 the default setting for “Numbars” 
1  Nogaps On 
1  includes the Night session in calculations 

 

Momentum Changes Direction 
 

This alarm triggers when the 10-period momentum of Microsoft begins to change 
direction. The Chart Function parameters used are the same as in the example above. 
 
 

Trigger Condition:  
chart((mom(msft,10)>mom(msft,10)[1] and 
mom(msft,10)[1]<mom(msft,10)[2]) or (mom(msft,10)<mom(msft,10)[1] 
and mom(msft,10)[1]>mom(msft,10)[2])[-1],60,1,100,1,1) 

 

Trigger State: 
True 

 

 

Option Volume Increases 
 

Stock option traders sometimes follow the volume on the first calls in-the-money. When 
the volume on these options suddenly increases, it can signal that a rally in the price of 
the underlying is on the way. 
 
This alarm triggers when the daily volume on the first in-the-money call triples from the 
previous day’s volume. 
 

Trigger Condition: 
chart((mu#+1c.volume>=3*mu#+1c.volume[1])[-1],1,2,100,1,3) 
 

Trigger State: 
True 
 
 

The Chart Function parameters used above ( i.e. [-1],1,2,100,1,3) ) are used when 
you want Calc On ([-1]), a daily time frame (1,2), the default setting for “numbars” 
(100), the Nogaps On setting (1) and the Night session omitted from consideration (3). 

 



Moving Average Crossover 
 

In this example we use two Moving Averages: one based on 18 periods, the other based 
on 40 periods.  Once again we need the Chart Function because we are doing this on 5-
minute bars and are comparing the current bar with previous bars. 
 

Trigger Condition: 
Chart((savg(msft,18)>=savg(msft,40) and savg(msft,18)[1]<= 
savg(msft,40)[1] or savg(msft,18)<=savg(msft,40) and 
savg(msft,18)[1]>=savg(msft,40)[1]) [-1],5,1,100,1,3) 

 

Trigger State: 
True 
 

Index or Instrument Outside a Given Range 
 

This type of alarm monitors indices or instruments trading outside a pre-defined range. It 
triggers when the TIKI (Tick of Dow Jones Industrials) is above 23 or below –23. 
 

Trigger Condition: 
tiki>23 or tiki<-23 
 
4 

Another equivalent version of this trigger condition would be: 

Trigger Condition: 
abs(tiki)>2 
 

Trigger State: 
True 
 

Instrument Up/Down 5 points 
In this particular example we used Microsoft’s ticker and we needed the Chart Function.  
Can you see why the Chart Function was needed? 
 
We wanted to be alerted if Microsoft went up 5 points or more on an intraday chart. We 
are comparing the currently building 15-minute bar with previous bars. Because we are 
comparing the current bar with earlier bars we needed to use the Chart Function.  

Trigger Condition: 
Chart(((msft.recent-msft.open)>=5)[-1],15,1,100,1,1) 
 

 



Trigger State: 
True 
 

Auto-Print 3 days prior to Expire 
 

This alarm will automatically print a page called “great_page” 3 days before the prompt 
crude oil futures contract expires. The command entered tells Aspen Graphics to bring up 
the page called great_page, change all the symbols on this page (using “\”) to the lead 
month of crude (cl#), and send this page to the printer 
 

Trigger Condition: 
date = = cl#.expire-3 
 

Trigger State: 
True  
 

Command Actions on Trigger: 
great_page;\cl#;.print 
 

DDE / Exporting Data to Excel 
Dynamic Data Exchange (DDE) allows information from Aspen Graphics data files to be 
transferred directly to Microsoft® Excel, a spreadsheet program. The links between the 
two programs are "live”; as a value is updated in Aspen Graphics, it is immediately 
updated in the spreadsheet. This can save time if you manually post values (i.e. daily 
closes) in spreadsheets for reports or analysis. Up to 5000 links containing 2-4000 bars 
each are available for both import and export. 

 
With DDE you can also: 

o Export historical information from Aspen Graphics into Excel 

o Import your own historical or "live" data from a spreadsheet program into Aspen 
Graphics 

o Create symbols not yet defined in your Aspen Graphics database, such as IPO's. 

 

 Microsoft® Excel is the only spreadsheet program we currently recommend using 
with the Aspen Graphics DDE utility. 



Loading the Aspen Graphics DDE toolbar in 
Excel   
If Excel was already installed on your computer when you loaded the Aspen Graphics 
software, you will be able to load a custom toolbar into Excel to better facilitate creating 
links between the two programs. The initial setup is a one-time process. These steps do 
not need to be repeated each time use DDE is used. To display the toolbar, follow these 
steps: 

 
Step 1: Left click on the Start button on the Windows® Taskbar; left 

click on Search and then Files or Folders...   

 
Step 2: Enter qmaster.xlb in the Named field of the dialog box and 

then left click on Search Now.  

 

Step 3: Double-left click on qmaster.xlb when it comes up in the 
window on the right side. Note the path to where this file resides 
(usually c:\apex\msexldde as in the example above. 

Step 4: Start Excel.  Left-click on View > Toolbars.  From the 



Toolbar menu select Aspen Graphics DDE Tools. 

  

The custom Aspen Graphics DDE Toolbar will now be 
displayed.  

 
Step 5: The final step is to left click on Tools > Add-ins...  Left click 

the Browse…button and look in c:\apex\msexldde (or, 
substitute the path from Step 3 above if qmaster.xlb was found 
in a different folder.)  

 
Step 6: Left click on arg32.xla and then click on OK. When returned to 



the Add-Ins list, left-click on OK. 

 

Displaying the DDE Link Generator Dialog 
Box 
A DDE link can be initiated from within either Aspen Graphics or Excel; however, both 
programs must be running for the links to be updated.  The following steps are performed 
in the Excel program.   
 

 Be sure to select an empty cell Before performing the next step! The data will be 
pasted into the active cell automatically.  

 
1. Left-Click a Cell in Excel to select it.  
2. Single left click on the first button on the Aspen Graphics DDE Toolbar. 

 
 

This action will display the DDE Link Generator Helper Dialog. There are four tabs on 
the DDE Link Generator Helper Dialog Box: Quote, History, Option and Formula. An 
explanation of each tab follows. 
 

Quote – “Live” Links from Aspen Graphics into 
Excel  
The first tab on the DDE Link Generator is labeled Quote. A link created with this 
option will mimic a quote page in that each time the value changes in Aspen Graphics, 
the quote element will update in the Excel spreadsheet.    



 

To create a l ink: 
1. Enter the Symbol to be linked to the spreadsheet. 
2. Select the quote fields in the link from the list in the middle of the menu. Left-

Clicking a quote field displays a description of the selection in the Element 
Description box. Double-Click the element to send it to the Selected box (a 
double left click on an element in the Selected box puts it back in the original 
list). 

3. When all of the quote elements have been selected, left click on the Copy Link 
button. The link is pasted into the spreadsheet. 

 
 

The order in which elements are selected for the link is important! The elements will be 
displayed on the spreadsheet from left to right in the order selected. This is an indivisible 
array; the fields cannot be rearranged once the array is pasted into Excel. Carefully plan 
how the link should be viewed. (Hint: Select SYMB as the first element of the link. This 
will aid in identifying which symbol the data is associated with.) 



History – Exporting Historical Data from Aspen 
Graphics to Excel  
To access Aspen Graphics historical database within Excel, a History link can be created.  
The History link differs from the Quote link. The output can contain up to 4000 periods 
of data in one link.  
 

To create a historical l ink: 
1. Enter the Symbol to be linked to the spreadsheet. 
2. Select the Interval, or time base, for the historical data to be exported. 
3. If  Intraday is selected, specify the number of minutes for each interval in the 

"Span" field. The number entered in the span field is the same as choosing a 
time frame in a chart. For example, a 15 entered in the Span field would export 
15-minute data into Excel.   

4. Choose the Start Date and End Date for your link, in mm/dd/yy format. Or, 
instead enter a number into the Periods field to have a rolling link that will 
always display the current period and the specified number of periods back from 
the current bar. Start Time and End Time will set the link to start at a 
particular time during the first day and end at the specified time on the final day 
of the link.   

5. Select the Quote Elements for the link. By default, all the quote elements are 
selected; deselect any unwanted elements by Left-Clicking the element. 

6. Selecting Skip gaps will close any gaps in data for holidays or other instances 
when there no data is available. 

7. Select the Copy Link button in the lower right-hand corner. The link will now 
be pasted into Excel. 

 



Options - Exporting Theoretical Values and 
Volatil ity Data from Aspen Graphics 
The Option link setup window looks identical to Quote, but has fields pertaining 
specifically to options analysis, including Implied Volatility, Theoretical Option Price 
and the Greeks. These options are only available if subscribing to either Basic or 
Advanced Aspen Graphics Optionalysis.   
 
To export price data for an option, use the Quote tab and follow the steps in the “Create 
a Quote Link” section above. 

To link Options specific data: 
1. Enter an option symbol or macro into the Symbol field. 
2. Double left click on the Options Quote Codes to be exported from the List of 

Available Elements. 
3. Left click on Copy Link. The requested options information should now be 

displayed in the spreadsheet. 

 



Formula - Exporting an Aspen Graphics Formula to 
the Spreadsheet 
The Formula tab only has one field for input. Enter the name of the formula as it 
appears in the Aspen Graphics Formula Manager, followed by the symbol(s) to be used 
in the formula in parentheses. 
 

 
 

A formula can also be written directly into the dialog box. The formula must use Aspen 
Graphics Formula syntax and remember to use the Chart Function in studies that call on 
past bars. 
 

 

 
 

Initiate a DDE Link from within Aspen Graphics 
A link can be initiated from the Aspen Graphics toolbar via Tools > Create DDE Link. 
 

 
 

 

The “DDE Link Generator Helper Dialog” box will appear.  Create the desired link as 
outlined in the segments above and then start Microsoft® Excel. Highlight the cell into 
which the link will be pasted.  If you selected more than one quote or option element, 
select the “left-most” cell in which you want the link to begin.  If you created a history 
link, select the cell which will be the upper-left corner of your array. 
 

Click on the second custom Aspen Graphics button in Excel (the DDE clipboard).  

 



Creating a Symbol using DDE 
The Personal (\Stand Alone) Edition and Server versions of Aspen Graphics allow the 
users to define a custom "symbol" and then import data for that symbol into the Aspen 
Graphics data files. There are several benefits for creating a custom symbol to do this: 

o Track a basket of instruments, and calculate the P&L of that basket in Excel. 
Aspen Graphics’ charting capabilities can then graph the performance of that 
basket, just as an equity or index. 

o Chart data that isn’t offered by the data provider, like total open interest or 
volume for a commodity. 

o Spreadsheet contains data from some external source and you would like to view 
that data in Aspen Graphics. 

o Results of formulas created in Aspen Graphics can only be displayed as a line, 
dots or a histogram. Using DDE, formula values for a period of time can be 
arranged in Excel, imported into Aspen Graphics as synthetic symbols, and 
charted as bars or candlesticks. 

 

 This feature is not available with the Aspen Graphics on the Internet versions of the 
software. 

 

 
To create a symbol, left click on the third custom Aspen Graphics button (the lightning 
bolt). 
 

 
 
The Create Symbol DDE Helper appears, allowing you to enter all the relevant 
information about the "symbol" you are creating. 

 

 Before naming a symbol, check to make sure there is not an existing symbol trading 
with that name. In Aspen Graphics, bring up the page SUPERQUOTE, then type in the 
prospective name. If it is undefined, use that name for the symbol. If it is quoted, try a 
different, more descriptive name. 
 
 
 
 
 



 
 

Create Symbol DDE Helper  Fields 
Field Contains Examples 

Symbol Name of Symbol Corn_Oi 
Description Description of Symbol (appears on a chart or 

quote page). 
CBOT Corn Total 

Open Interest 
Scale Increments in which a symbol trades (same as 

“Units” on Superquote) 
.01, 1/8, 1, etc. 

Exchange Exchange on which the instrument will trade 
(for synthetic symbols based on real symbols, 

use the exchange for the real symbol) 

CBOT 

Type Type of Instrument (stock, future, option, index) Future 
Base 100 Only for interest rate futures subtracted from 

100 
(leave blank) 

Currency Currency in which the instrument trades US Dollars 
Amount/Pt Dollar value of a one-point move (same as 

“Dollars” on Superquote 
50 

Volatility Base volatility at-the-money; optional (leave blank) 
Minimum 

Tick 
Minimum number of ticks per trade (For 

example, if the symbol scale is .01, but the 
smallest uptick or downtick is .05, the minimum 
tick would be 5 with the Scale set to .01.  Most 

of the time this setting is 1.) 

1 

Expiration Expiration date of the symbol (for future or 
option symbols only) 

12/31/07 for futures 
or options, leave 

blank for other types 
Trading Hours Session start and ending times, and time zone of 

exchange (left blank, these will default to the 
exchange entered above) 

(leave blank) 



If the symbol Type is entered as an Option, the additional fields of Strike Price, 
Underlying Symbol, Strike Scale (minimum strike units), Put/Call, and Option Type 
(whether or not early exercise is allowed (American) or exercise is only allowed at 
expiration (European)) must also be entered. 
 
Once the above fields are entered and OK is selected, the new symbol will be defined in 
the Aspen Graphics Master Table (the data file which contains symbol information). 

Importing Data from Excel to Aspen Graphics 
There are two ways to export data from Excel into Aspen Graphics: as an array of data 
from Excel (non-real-time import) or a "live" link using the Aspen Graphics Tick 
function (real-time updating). This feature is only available with the Aspen Graphics 
Standalone and Aspen Graphics Server versions of software. 

Importing Static (“historical”) Data from Excel into 
Aspen Graphics 

 A symbol must have been created for the data that you want to import into Aspen 
Graphics. 
 
The order of the data in Excel is very important. The table below shows the  
format of the data in the spreadsheet. This is an ARRAY of data.  It consists of two 
sections:  the Top Row (in yellow highlight) and the Body (the remaining data series.) 
 

o The first cell of the Top Row contains the Symbol Name. 

o The second cell tells Aspen Graphics the Type of Data in the Body. 
 

        
PwrUser HLO

C 
2/7/97 5:00 112.5 111.5 111.5 112
2/10/97 5:00 112.1563 111.7813 111.875 112
2/11/97 5:00 112.1875 111.875 112.125 111.9688
2/12/97 5:00 112.25 111.6875 111.9375 111.9375
2/13/97 5:00 112.875 111.9375 112.0625 112.8438
2/14/97 5:00 113.5938 113.0625 113.1563 113.4375
2/18/97 5:00 113.7813 113.1875 113.7813 113.375
2/19/97 5:00 113.6563 113 113.3438 113.1563
         

Contents of 
2nd Cell 

Imports Data Aspen Server 
Data File 

Order of Data in the Array 

TICKHIST Import of tick data Ticks.dat Date, Time, Price, Volume 
HLOC,15 Import of 15 min. data Bars15.dat Date, Time, High, Low, Open, Close 
HLOCV,15 Import of 15 min. data Bars15.dat Date, Time, High, Low, Open, Close, 

Volume, Open Interest 



HLOC Import of daily data Days.dat Date, Time, High, Low, Open, Close 
HLOCV Import of daily data Days.dat Date, Time, High, Low, Open, Close, 

Volume, Open Interest 
 

The Body of the array must always have the date and the time in the first two columns. 
The next columns will contain the price data, and volume and open interest if applicable. 
Once the array of data is properly formatted, simply highlight the entire array (Top Row 
and Body) and Left-Click on the fourth button on the DDE Toolbar. The data will be 
written to the Aspen Graphics database(s) and available on a chart of the corresponding 
time frame (.day if the data was based on daily values.) 

 

Import "Live" Data using the Aspen GraphicsTick 
Function 
The Aspen GraphicsTick function allows values from Excel to be imported into Aspen 
Graphics in real-time. Excel containing established live links from Aspen Graphics to 
Excel and manipulated the data once it arrived in Excel, that manipulated value can then 
be sent back to Aspen Graphics via a live link. 
 
Since the Aspen GraphicsTick function sends information to Aspen Graphics as tick data, 
it will be written to the TICKS.DAT file. It can’t be viewed on a daily (or higher) chart, 
because those charts reference the DAYS.DAT data file. To chart data from Excel on a 
daily chart, use the method outlined above ("Exporting Static Data from Excel to Aspen 
Graphics"). 

 

First make sure you have created a symbol to assign the data you want to export. 
 
Aspen GraphicsTick is a function which is placed in Excel when installing or upgrading 
Aspen Graphics. Once you have a cell in Excel that is producing the values you want to 
import to Aspen Graphics, select an empty cell, then: 
 

1. Select Insert from the Excel Menu Bar, and then select Function... 

 
2. In the Insert Function dialog, make the following changes: 
3. Select the All category in the “Select a Category” field. 
4. Choose Aspen GraphicsTick from the “Select a Function” list. 



 
5. Left click on Next.  This displays an Aspen GraphicsTick Setup Window.  

 
6. Enter the following information into the Aspen GraphicsTick dialog: 
 

o Symbol - Enter the name of the symbol name used to bring up this data once it is 
in Aspen Graphics. 

o Price – Left-Click on the cell whose value is to be linked to Aspen Graphics. The 
remaining fields are optional



o Time_Text - Used assigning a time to the tick OTHER THAN the current time.  
Leave blank to default to the current system time. 

o Bate – Specifies the price to reflect TRADE, BID, ASK, SETTLE, OPEN or 
CLOSE, enter those values here. If left blank, all prices are marked as trades. 

o TkVol - Enter the tick volume associated with the price. If left blank, the value 
will be 1. 

 

DDE Examples 
The following examples illustrates some of the possibilities available in Aspen Graphics 
and DDE. 

Displaying a Formula Value as a BAR Chart 
(intraday) 
By default, a formula is displayed as a line on an Aspen Graphics chart.  Users who 
would like to see the values displayed in other formats can use the Aspen GraphicsTick 
DDE function.  You would use this feature if: 

o You would like to see a custom formula (i.e. the spread of two commodities or a 
Natural Gas strip) as a bar chart, not a line or histogram. 

o You like to use Candlesticks or Point & Figure charts to analyze markets and 
want to use this method for the formula. 

o You want to easily quote the Net, Previous or any other quote value for the 
formula. 

 
The following example uses a July/December spread formula for Corn Futures, but the 
same steps apply to any Aspen Graphics or custom formula in your system. 
 

1. Display the Formula tab of the DDE Link Generator Dialog Box. In the formula 
line, type in the formula CN2-CZ2, then click on the Copy Link button.  

2. The next step is to create a symbol so that you can pipe the spread values back 
into Aspen Graphics. To do this, click on the lightening bolt icon on the DDE 
toolbar to display the Create Symbol DDE Helper box. Enter the following 
information into the dialog box: 



 
3. In the worksheet which contains the spread formula, select an empty cell and 

insert the Aspen GraphicsTick function, following the parameters below: 
4. In the Symbol field, enter the name of the symbol created. Left-click in the 

Price field, and then left click on the cell which contains the spread link. This 
enters the cell reference into the Price field. The other fields are optional and 
can be left blank.  

5. Click on OK. 
 

 

Switch back to Aspen Graphics, bring up a 0 minute chart and enter your symbol. As the 
formula updates in Excel, it will tick on a Aspen Graphics chart.  The new symbol can be 
charted in any intraday time frame; a close approximation to a daily chart is a 1439 
minute chart (1 minute less than 24 hours.)  

 



Displaying a Formula Value as a BAR Chart (Daily) 
This example illustrates how to create a daily bar chart for a three month Natural Gas 
Strip. The same method can be used to create daily bars with other Aspen Graphics 
formulas. 

1. In the Aspen Graphics Formula Manager, create the following formulas: 
a. strip3=(ng#+ng#1+ng#2)/3  or any variation on this with more months, 

etc. 
b. stripOpen=(ng#.open+ng#1.open+ng#2.open)/3 
c. stripMax=chart(rmax(strip3(ng#,ng#1,ng#2),310)[-1],1,1,100,1,3) 
d. stripMin=chart(rmin(strip3(ng#,ng#1,ng#2),310)[-1],1,1,100,1,3) 

2. Open a new spreadsheet in Excel (Aspen Graphics must be running in the 
background). Left-Click cell C2 of the spreadsheet. 

3. Display the Formula tab of the DDE Link Generator Dialog Box. 
4. Type: stripMax(ng#,ng#1,ng#2) into the Formula field. 
5. Left-Click the Copy Link button. 
6. Select cell D2.  Display the Formula tab of the DDE Link Generator Dialog Box 

again. 
7. Enter the formula stripMin(ng#,ng#1,ng#2) 
8. Select cell E2. 
9. Enter the formula stripOpen(ng#,ng#1,ng#2) into the Formula tab. 
10. Select cell F2.   
11. Enter the formula strip3(ng#,ng#1,ng#2) into the Formula tab. 
12. These values automatically update during trading hours. For this exercise, 

though, our focus is on the end-of-day value (after the market’s close). 
13. Select cell A1 and type the name used when the data is displayed on a chart or 

quote page in Aspen Graphics (e.g. ngstrip) 
14. Select cell B1, type: HLOC (this defines that the data will all be written to the 

DAYS.DAT file in the Aspen Graphics database.) 
15. Select cell A2.  Enter =TODAY( ). 
16. Select cell B2.  Enter 16:30. 
17. Create a synthetic symbol for the Strip, using the following information: 



 
 
18. Select cells A1 through F2.  Left click the “Send Symbol Update”  icon on 

the DDE Toolbar. The data for the NGStrip bar chart can now be displayed on a 
daily chart in Aspen Graphics. 

This last procedure needs to be performed after market hours each day. An Excel macro 
can be set to automate this process. (An advanced Excel macro user may be able to write 
a macro that performs this procedure automatically after market hours.) 

Creating a Database in Excel 
The following example shows how to automate building a database in Excel using the 
macro-writing feature. his feature is useful for archiving data which isn’t stored in Aspen 
Graphics’ data files (i.e.: study values or custom formula values). It is also useful for 
automatically posting daily closes (or any other value) in Excel for reports or further 
analysis. Although this automating process requires opening Excel once a day and 
performing a few keystrokes in this workbook, it greatly reduces the time required when 
compared to copying and pasting the values every day. 

1. Create a live link between Aspen Graphics and Excel with the data that needs to 
be archived. This example uses the daily close for Soybean futures. 



 
 

2. To save the date each day with the data, select an empty cell, and type:  
=today(). 

 

 
 

3.  Select Tools > Record Macro > Record New Macro. Rename the macro 
or click on OK. The steps performed from this point on are recorded as your 
macro. 

 
 

4. Select column D by Left-Clicking the D in the column header. Next, while 
column D is highlighted, select Format > Cells… 

 



 
 

5. Choose Date from the Category field and the date format you want from the 
Type field. 

 

 
 

6. Select and copy cells A1 and B1.  Next, select cells D1 and E1. Left click on 
Edit > Paste Special. Select Values from the Paste Category in the Paste 
Special dialog box. Click OK. 

 

 
 
7. Cells D1 and E1 should still be highlighted (if not, highlight these two cells).  

Select Insert > Cells…From the Insert menu, choose Shift Cells Down.  
Click OK. 

 



 
 

8.  Left click on Tools > Macro > Stop Recording. 
 

 
 

 
9. After the market close each day, open the Excel spreadsheet and then left click 

on Tools > Macro > Macros….  Select the macro from the list and then click 
on Run. (An advanced Excel user may be able to help you assign this macro to 
a newly created button on a toolbar.) 

   
To further automate the process, assign the macro to a shortcut key. Go to Tools > 
Macro > Macros…, select the macro, select Options.., and enter the desired key into 
the Shortcut Key field. 

Charting a Portfolio in Aspen Graphics Using DDE 
This example illustrates the process for building a portfolio, or custom index, in Excel 
and then importing the values of the portfolio back into Aspen Graphics for charting. 

1. Create a live link for the Last price of a symbol in the portfolio. 
2. Repeat this procedure for each instrument in the portfolio. Use Excel math 

functions to multiply the prices by the quantity of contracts (use negative 
quantities for short positions), as well as any other weighting that may need to 
be applied to each instrument in the portfolio. When finished, there should be 
one cell which contains the net value for the portfolio. 

3. Create a symbol for your portfolio, using the information below. 
  



 
 
4. Highlight an empty cell on the portfolio spreadsheet and insert the Aspen 

Graphics Tick function, using the following parameters: 
 

 
 

5. Left-Click Ok to return to the spreadsheet. 
6. Switch back to Aspen Graphics and display an intraday chart (0-1439 minutes), 

and enter the name of the new symbol. The data should update on the chart as 
the values update in the Excel spreadsheet. 

 



Appendix A – Custom Page Walk 
Through 

The ability to save and retrieve user-designed screen setups enables you to customize 
Aspen Graphics to suit your trading style. In working with Aspen Graphics you will hear 
the terms “Windows” and “Pages” used often. What are they? 
 

An Aspen Graphics window is one area of information on your screen. In the example 
below, two chart windows, two quote windows and a news window are displayed on the 
screen. When a window is retrieved from memory, it will be added to what is displayed 
on the screen when it is recalled. There is no limit to the amount of windows that can be 
on the screen at one time. 

 
A page is the entire Aspen Graphics screen layout. A page is made up of one or more 
windows. The example page below is comprised of five windows. When a page is 
retrieved from memory, any windows displayed on the screen at the time of recall will be 
cleared and then the retrieved page will be drawn.  

Creating a Custom Page 
This page building exercise will show you step-by-step how to create the page drawn 
below, which contains two charts, a quote window, a news window and a ticker window.  
Developing these skills will allow you to apply these techniques in creating other pages 
in Aspen Graphics. 

  

 



 

 

Create a Quote Window    
Open a new Quote Window via File > New Window > Quote 

 
 

Ready the Quote Window for Formatting  
Display the quote window’s menu by right-clicking the mouse button, then left-
click on Modify Layout.   

 



Three things happen: a gray grid appears on the quote window, an red cursor fills 
the upper left cell of the grid, and the menu is displayed.  

 

The window is now ready to be formatted with quote codes. 
  

Format the Quote Window using the Code Menu 
Left-click Quote Code List on the Quote Window Menu (see above). This displays the 
Quote Code List of available field variables for use in quote windows. Left-click, on 
SYMB (it’s in the first column about half way down). 

 



This will enter both a yellow label and the $1.symb quote code into the top left-
hand corner of the quote window.     

 
Each time you click on a Quote code the red cursor automatically moves to the 
next position, readying the quote window for the next quote code.   

Continue left clicking on LAST, NET, BID, ASK, UVOL, DVOL and TVOL.   

 

• Click the “X” on the Quote Code List title bar (or double left click on 
CLOSE MENU in the bottom right corner of the Quote Code List) to clear 
the Quote Code List from the screen. 

• Resize the window 

o Place the mouse arrow on the bottom right corner of the window 

o Hold the left mouse button and drag until the border is just below 
the quote codes and the window fills the screen horizontally. 

 

• Right-click in the body of the quote window to display its menu. Click on 
“Exit Modify Mode” 



Display the Two Charts   

• Display a new chart by going to FILE > NEW WINDOW > CHART. 

 

• Perform this step twice.  This places two charts on the screen partially 
covering the quote window.  

Format the Charts   

• Drag the charts into the layout as shown below by left-clicking and dragging 
their title bars.  The quote window becomes visible and the tops of the charts 
align with the bottom of the quote window. 

 
• Resize each chart by dragging the bottom of each chart up so it is just below 

the middle line of the grid on the blue background. 

• Set the time frame of the right-hand chart to daily bars by right-clicking in that 
chart to display its menu and selecting TIME FRAME > DAY. 



Add a Symbol to the Charts and Quote Windows  
To add a symbol to all of the windows on the screen, type a backslash ( \ ) before 
the symbol. For example, typing \sp# will add the front month of the S&P futures 
to the quote window and both chart windows simultaneously. 

 

Your page now displays data for the S&P futures in all three windows. 

Add a News Window to the Page  
Add a news window by left clicking on File > New Window > News. Drag the 
news window down so that its top border aligns with the bottom borders of the 
charts. Resize it as necessary to fill the screen horizontally while leaving some 
space available under the News window as shown below.  

 
 



Add and Format the Ticker Window  
1. Add a quote window by clicking on FILE > NEW WINDOW > QUOTE. 

2. Drag the quote window down to the bottom of the screen and resize it to fit in 
the available area underneath the news window.  

3. Right-click in the body of this new quote window to display its menu.  Select 
Modify Layout. 

4. Right-click again to redisplay the menu.  Left click on Format Rows.  

 

5. Redisplay the menu a third time and then select Quote Code List. 

6. Select SYMB, LAST and NET from the Quote Code List. Double left 
click on CLOSE MENU to remove Quote Code List.  

7. Redisplay the menu and click on Scroll Right to define the quote window as 
a “Scroll Region” (Aspen Graphics’ term for ticker window).



Your display should now look similar to the image below 

 

8. Display the menu one last time and select Exit Modify Mode to exit from 
the modify layout mode. 

 

Adding Symbols to the Ticker Window  
Right-click in the body of this quote window to display its menu. Left click on 
Edit Symbols. 

 

 

 



The Scroll Region Symbols dialog box will appear. 

 

Enter the symbols you want to see in the ticker window, pressing Add after each 
symbol. When you are finished adding symbols, click Done. Remember to use 
the # and @ macros when entering futures contracts so you won’t have to change 
symbols as contracts expire. 

 

Save the Page  
 

Save the page by left-clicking on File, then Save Page.   
 

 
 
Enter a unique name in the Name field. Up to 20 characters can be used to name 
a page. You cannot use only symbols or numbers in naming pages; this will return 
an error message saying the name is reserved. Numbers and symbols can be used 
in combination with no conflict (e.g. - IBM_15 is a valid page name). You also 
cannot use spaces in a page name; use the underscore ( _ ) instead. 
 



 
Select a folder from the choices available in the “Create in:” section. (If you want to 
create a new folder to store this page, click the New Folder button and, name the 
folder accordingly.) When you have selected (or created and named) the desired 
folder, click OK. The software verifies that the page has been saved by displaying its 
name in quotes on the title bar. 

 

. 
 



Additional Page Building Tips 
♦ The # macro is a type of variable used for instruments, like futures, which expire. It 

is used in place of a symbol’s month and year codes to specify which of the currently 
trading contracts you want to evaluate. Using the # macro will list a specific contract, 
either the front month if used alone or a number of contracts out if appended with a 
number.  For example: 

C# will always point to the front month CBOT corn futures contract. 
SP#2 requests the 2nd expire out for the S&P futures contract. 

♦ The @ is used to display a list of futures contracts. The @ sign lists ALL currently 
trading contracts for the specified future if used alone, or can be limited by placing 
the number of contracts desired after the @.  For example: 

C@ will list all of the currently trading corn contracts  
NG@12 will list the first twelve Natural Gas contracts 

♦  “Drag-and-Drop”: It is possible to drag-and-drop a symbol from one window into 
another window. Simply click and hold down the left mouse button on the symbol 
until a small rectangle appears at the base of the mouse pointer. When the rectangle 
appears, keep holding down the left mouse button as you drag the mouse into the 
destination window, then release the mouse button.   

♦ Clearing the Screen:  The “Clear” button  on the toolbar will remove everything 
displayed on the screen, taking you back to the blue screen with a black grid. 

♦ Turning off (hiding) Title Bars: Title bars can be hidden by going to TOOLS > 
OPITONS > and selecting the Miscellaneous tab. Clear the check mark from the 
“Display title bars on all windows” checkbox. This makes for a cleaner looking 
display so more of the available space on a page is devoted to displaying data. The 
title bar will reappear when you pause your mouse near the top of a window or page. 

CHARTS 
♦ Tables: When looking at a chart it is possible to see the values displayed in tabular 

form. This is done by displaying the chart’s menu and selecting Tabular List. 
♦ Changing the Color of the Bars:  The bars of any chart can be changed from the 

default color to another color by selecting Parameters from the chart’s menu. This 
opens the Bar Chart parameters dialog box, providing access to various chart features.  
Click the + sign next to Colors, then click the color name and the color box that 
subsequently appears. You can now select another color from the color palette. 

♦ Chart Parameters: See ASPEN GRAPHICS 4.0 > STUDIES > CHARTING 
TECHNIQUES > BAR CHARTS > CHARTING PARAMETERS (accessible 
from HELP > CONTENTS)”for more information on setting or changing a chart’s 
parameters. 



QUOTES 

♦ Clearing quotes from a Quote Page:  ,,  <enter>  (2 commas) or double left 
clicking on Clear All Symbols from the Quote Menu will clear all symbols from 
any quote window. 

♦ .FILLDN and .FILLRT commands:  The .filldn and .fillrt are keyboard commands 
entered directly into the command line that perform the same functions as selecting 
Fill Down or Fill Right when you are formatting a quote window but .Filldn and 
.Fillrt can be limited to a specific range of cells.  Examples: 

.Filldn 1 3 will copy the $1 row and fill down to the $3 quote codes. 

.Filldn 2 will start with the $2 quote code and copy down the rest of the 
window. 

 
♦ .DELGROUP command will clear the specified group of quote codes. Delgroup 20 

30 will clear groups $20 through $30 on the quote window. 

♦ Chart Header:  A chart header is a special kind of quote window that is linked to a 
chart; changing the symbol in one automatically updates the second. Chart headers 
are created like any other quote window, but must be saved as a window with the 
name of chart_header to be defined as such. To retrieve a header and link it to the 
chart, first display the desired chart and then type header <enter>. 

 

Appendix B - Description of the 
Studies 

 
The Overlays and Studies listed on the Select Study menu can be categorized into 
four groups: 

 

Trend Followers: 

 
Moving Averages Parabolic 
Moving Average Envelope Keltner Channels 
Bollinger Bands  

 

Overbought/Oversold Indicators: 

 
Momentum Modified Stochastic 
A/D Oscillator MACD 
Acceleration Williams’ %R 



Fast Stochastic MACD Oscillator 
Slow Stochastic Relative Strength Index 
Moving Avg. Momentum Commodity Channel Index 
Moving Avg. Oscillator HiLo Oscillator 

 

 

Trend Indicators: 
 

Directional Indicator 
Directional Oscillator 
Average Directional Index 

 
 

Activity Indicators :  
 

Volume Cumulative Volume 
Open Interest Volume Accumulation. Oscillator 
On Balance Volume Variable Acc/Distribution 
Average Balance Volume Historical Volatility 
 

The following section describes these indicators in more detail. They are arranged in 
alphabetical order. Examples of color rules and alarms based on these indicators are 
given at the end of each section. For more information on entering color rules and alarms, 
see the Formulas, Color Rules and Alarms chapter. 
 
MESA, DeMark, Kase and Implied Volatility studies are not outlined here. They are 
available as optional packages which integrate seamlessly into the Aspen Graphics 
program. Each package comes with its own documentation detailing these studies.  
Contact your salesperson for more information. 

Acceleration 
Acceleration is the difference between the current momentum value and a previous 
momentum value. While a momentum study indicates the rate at which prices change, an 
acceleration study indicates the rate of change in momentum.  When an acceleration study 
yields a positive value, prices are not only rising, they are also rising at a faster rate.When 
an acceleration study yields a negative value, prices are falling at a faster rate. 
 
For information on how momentum is calculated, see the Momentum section. 
 
Divergence between momentum and acceleration, or price and acceleration, are other 
uses of this study.  If momentum is decreasing while acceleration is unchanged or 
increasing, momentum may soon be changing directions; the converse is also true. 
 



Type of Study Dot Command It works best in 
Overbought/ Oversold .acc Cash and Futures markets, all 

time frames 
 

 
How Aspen Graphics Calculates It: 
 

Acceleration is: Current Momentum - Momentum n periods ago 
 

The user determines how many periods should be used in each of the Momentum 
studies. This is done from the Period field in the study’s parameter menu. 
 

 
 
At the end of October and beginning of November on the chart in, price was still 
rising but acceleration was falling. 
 

Default Parameters Settings: 
 

Field Value 
Color Yellow 
Graph Line 

Line Style Solid 
Line Width 1 pixel 

Period – 1st Momentum 10 
Period – 2nd Momentum 10 



Price Close 
 

 
Custom Aspen Graphics Formula: 
 

Accl(series,per=10)=mom($1,10)-mom($1,10)[per] 
 

This formula, once entered in the Formula Listing, allows you to use Acceleration 
in color rules and alarms, as shown in the following examples. 

 

 If charting this custom formula, make sure that Nogaps=On in the Chart Settings 
Menu. 
 
Color Rule Example: 
 

if(Accl($1,10)>Accl($1,10)[1] and   mom($1,10)<mom($1,10)[1],clr_blue,clr_yellow) 
. 

This color rule will turn a bar blue when the 10-period acceleration is increasing 
and the 10-period momentum is decreasing.  It will leave all other bars yellow.   

 
Alarm Example: 
 

chart((Accl(c#,10)>Accl(c#,10)[1] and Accl(c#,10)[1]>Accl(c#,10)[2])[-1],15,1,100,1,1) 
 

The alarm will trigger when the Acceleration has increased over the last two 
periods.  The alarm is based on 15-minute bars for the front month of corn.   

 
Charting Setup Idea: 
 

Oscillators, such as Acceleration, are sometimes graphed as histograms rather 
than as line charts.  To draw this study as a histogram, bring up the Acceleration 
study on a chart.  Bring up a Graph Menu, select Parameters, and then single left 
click on the word Line in the Graph field.  Select Histogram, and then select 
Done. 

 
A color rule can be written to display all positive values in green (or any other 
color) and all negative values in red by entering the following color rule: 

 
if($1>0,clr_green,clr_red)  

 





Accumulation/Distribution (A/D) Oscil lator 
The A/D Oscillator indicates overbought/oversold conditions by comparing “buying 
power” and “selling power” to the period’s trading range. This study was developed by 
Larry Williams and Jim Waters as a way of “normalizing” the relationship between the 
open and closing prices with the extreme prices for the period. 
 
Type of Study Keyboard 

Command 
It works best in 

Overbought/ Oversold .ado Cash and Futures markets that are trending. 
 

 
How Aspen Graphics Calculates It: 
 

The A/D Oscillator is calculated as follows:     Buying Power + Selling Power 
2 * True Range 

 
This study defines “buying power” as the difference between the true high (the 
higher of the current high or the previous close) and the period’s open. Selling 
power is defined as the difference between the close and the period’s true low (the 
lesser of the current low or the previous close). 

 
The A/D Oscillator values are not smoothed by averaging the values of several 
periods (as with a moving average), so the oscillator often fluctuates  
 
wildly between 0 and 100. ADTo make this study easier to read, a moving 
average can be applied to the A/D Oscillator, and overbought/oversold zones can 
be applied to this moving average. 

 
 
Default Parameters Settings: 
 

Field Value 
Color Yellow 
Graph Line 

Line Style Solid 
Line Width 1 pixel 

 
 
Custom Aspen Graphics Formula: 
 

ADOsc(series)=100*(($1.thigh-$1.open)+($1.close-$1.tlow))/ (2*$1.trange) 
 

This formula, once entered in the Formula Listing, allows you to use the A/D 
Oscillator study in color rules and alarms as shown in the following examples.  

 



Color Rule Example: 
 

if(ADOsc($1)>90 or ADOsc($1)<10,clr_red,clr_yellow) 
 

This color rule will turn a bar red when the value of the A/D Oscillator is over 90 
or less than 10 and leave all other bars yellow. 

 
 
Alarm Example: 
 

chart((eavg(ADOsc(lhq7),6)>70 or eavg(ADOsc(lhq7),6)<30),1,2,100,1,3) 
 

This alarm will trigger if, at the end of the day, the 6-period exponential moving 
average of the A/D Oscillator is above 70 or below 30.  The alarm is based on 
daily bars of the August ’97 lean hog contract. 

 
Charting Setup Idea: 
Oscillators are sometimes graphed as histograms rather than as line charts.  To draw this 
study as a histogram, see the Charting Setup Idea section at the end of the Acceleration 
study. 

 

Average Balance Volume 
Average Balance Volume is a simple moving average of the On Balance Volume which 
smoothes out that study.  The uses of the Average Balance Volume study, and the signals 
to be derived from it, are identical to the On Balance Volume study.  See the On Balance 
Volume study later in this Studies chapter. 
 
Type of Study Keyboard 

Command 
It works best in 

Activity Indicator .abv Cash and Futures markets which are active, all 
time frames 

Table 3 
 
How Aspen Graphics Calculates It: 
 

The Average Balance Volume study is calculated as follows: 
 

Simple moving average of the On Balance Volume 
 

Just like the On Balance Volume, the Average Balance Volume study uses an 
arbitrary positive integer as a starting point for the calculations.  For this reason, 
the Custom Aspen Graphics Formula may not have the same value as the Average 
Balance Volume that is preprogrammed in Aspen Graphics; the extent of your 
database may also have an effect on this value.  The shape of the graph, however, 



should look the same.  As mentioned later in the On Balance Volume section, the 
shape of the line is the most important aspect of these studies. 

 
Default Parameters Settings: 

Field Value 
Color Yellow 
Graph Line 

Line Style Solid 
Line Width 1 pixel 

Period 10 
 

 
 
Custom Aspen Graphics Formulas: 
 

OBVol(series)=if($1.close>$1.prev,obvol[1]+ $1.volume,if($1.close<$1.prev,obvol[1]-
$1.volume,obvol[1])) 
 
ABVol(series)=savg(OBVol($1),10) 

 
These formulas, once entered in the Formula Listing, allow you to use the 
Average Balance Volume study in color rules and alarms as shown in the 
following examples. 

 
Color Rule Example: 
 

if(ABVol($1)>ABVol($1)[1] and ABVol($1)[1] >ABVol($1)[2] and ABVol($1)[2]> 
ABVol($1)[3],clr_green, 
if(ABVol($1)<ABVol($1)[1] and ABVol($1)[1] <ABVol($1)[2] and 

ABVol($1)[2] <ABVol($1)[3],clr_red,clr_yellow)) 

 
This three-part color rule will turn a bar green when the Average Balance Volume 
has increased for three consecutive periods; it will turn a bar red when the 
Average Balance Volume has declined for three consecutive periods, and it will 
leave all other bars yellow.  

 
Alarm Example: 
 

chart((ABVol(sp#)>ABVol(sp#)[1] and sp#<sp#[1]) or (ABVol(sp#)<ABVol(sp#)[1] and 
sp#>sp#[1]) 
     [-1],30,1,100,1,3) 

 
This alarm will trigger when the direction of the Average Balance Volume line is 
diverging from price action. The alarm is based on 30-minute bars of the current 
S&P contract. 



 
Charting Setup Idea: 
 

When graphed, the Average Balance Volume can sometimes appear as a type of 
oscillator. It can, like other oscillators, be graphed as a histogram rather than as a 
line chart. To draw this study as a histogram, see the Charting Setup Idea 
section at the end of the Acceleration study. 

 

Average Directional Index (ADX) 
The Average Directional Index, often referred to as the Average Directional Movement 
Index or ADX, indicates the strength of a trend by measuring the degree of directional 
movement up or down. The ADX fluctuates between 0 and 100, with the higher values 
reflecting stronger trends. The ADX is designed to be used with the Directional Indicator, 
and is often displayed as an overlay on top of this study. Together, these two studies are 
often considered a Directional Movement System. 
 

Type of Study Keyboard 
Command 

It works best in 

Trend Indicator .adx Cash and Futures markets, all 
time frames 

 
 

When the ADX line has risen above both the DI+ and DI- lines and then makes its 
first down turn,  a trend reversal is often indicated. When the ADX line goes 
below the DI+ and DI- lines, it is a sign that trend-following systems should not 
be used; the market has entered a sideways or choppy phase.  

 
How Aspen Graphics Calculates It: 
 

The Average Directional Index study is calculated like this: 
 100 *  DI+ minus DI-  

DI+  plus  DI-  
 

The above value is referred to as the DX. A modified moving average of the DX 
is then taken, and this is referred to as the Average Directional Index or ADX. 

 
For an explanation of how the DI+ and DI- values are calculated, see the 
Directional Indicator study. 

 
The chart below shows the ADX overlaid onto the Directional Indicator. 
Although the ADX is usually displayed as a solid line, it is shown here as a dotted 
line to distinguish it from the DI+ and DI- lines. 
 



In mid-September, the DI+ line (green) was significantly above the DI- line (blue) 
signifying a strong uptrend. The ADX crossed above the DI+ line but soon turned 
down, predicting a reversal.This prediction was soon confirmed by price action as 
the market broke.  

 
Note also that when the ADX dropped below both lines in August, it 
corresponded to the sideways movement of the market. The ADX then reversed 
direction and turned up as a new uptrend began. 

 

 
 

 
Default Parameter Settings: 

Field Value 
Color Yellow 
Graph Line 

Line Style Solid 
Line Width 1 pixel 

Period 14 
 
Related Aspen Graphics Function:  adx( ) 
 

Example: adx($1,14) 
Key to Example 

$1 Placeholder for a symbol that 
will be supplied later. 



14 Number of periods in the ADX 
study. 

 
This function allows you to use the Average Directional Index study in color rules 
and alarms as shown in the following examples. 

 
Color Rule Example: 
 

if(adx($1,14)>dmineg($1,14) and adx($1,14)>dmipos($1,14) and adx($1,14)<adx($1,14)[1] 
and adx($1,14)[1]>adx($1,14)[2],clr_red,clr_yellow) 

 
The color rule above will turn a bar red when the ADX line is above both the DI+ 
and DI- lines and it has just turned down. All other bars will remain yellow.  
 

Alarm Example: 
 

chart((adx(mu,14)>dmineg(mu,14) and adx(mu,14)>dmipos(mu,14) and 
adx(mu,14)<adx(mu,14)[1] and adx(mu,14)[1]>adx(mu,14)[2]),1,2,100,1,1) 

 
This alarm will trigger at the end of the day for the same condition as described in 
the color rule above. The alarm is based on daily values for Micron stock.  

 
Formula Example: 
 

ADX_Ovrly(input)=adx($1,14) 
 

This custom formula benefits those who regularly overlay the ADX study on top 
of the Directional Indicator study. Once entered in the Formula Manager, it can be 
accessed from the Add Study menu by selecting Formula Study. 

 

Boll inger Bands 
This study was developed by John Bollinger based on his theory that the band width of an 
envelope should be a function of a market’s volatility. 
 
Bollinger Bands are similar to the Moving Average Envelope and Keltner Channel 
studies. The difference lies in the method used to calculate how far the bands should be 
drawn above and below the moving average line. Bollinger Bands are based on the 
number of standard deviations above and below the moving average.  
 

Type of Study Keyboard 
Command 

It works best in 

Trend 
Follower 

.bb Cash and Futures markets in all time frames, 
with daily being the most popular. 

 
This chart outlines several important aspects of Bollinger Bands.  They are as follows: 



 
1. The moving average (green) usually gives support in bull markets or 

resistance in bear markets. 
 
2. Penetration of a band usually signals the continuation of a trend, not the end 

of the trend (note the first breakout in early August). 
 
3. After the bands tighten around the average (indicating volatility has 

decreased), a sharp move is usually on the way (note how the bands 
constricted at mid-September before the rally began). 

 
4. Tops/bottoms falling outside the bands followed by tops/bottoms inside the 

bands usually signal that a trend reversal is imminent (note the double top in 
late September). 

 
Bollinger Bands can also be used to spot exhaustion of a trend.  Exhaustion can be 
indicated by a sharp move outside the bands followed immediately by a 
retracement. 

 

 
 

 
Default Parameters Settings: 

Field Value 
Avg.Type – Envelope Top Simple 

Avg.Type – Moving Average Simple 



Color – Envelope Bottom Cyan 
Color – Envelope Top Violet 

Color – Moving Average Green 
Graph – Envelope Bottom Line 

Graph – Envelope Top Line 
Graph – Moving Average Line 

Line Style – Envelope Bottom Solid 
Line Style – Envelope Top Solid 

Line Style – Moving Average Solid 
Line Width – Envelope 

Bottom 
1 pixel 

Line Width – Envelope Top 1 pixel 
Line Width – Moving Average 1 pixel 

Period – Envelope Top 1.0 
Period – Moving Average 20.0 

Price First Study 
Shift 0 

StdDev – Envelope Bottom 2.0 
StdDev – Envelope Top 2.0 

 
 
Related Aspen Graphics Functions: 
 

bb(  ) Example:  bb($1,20,2)       Top Band  
    bb($1,20,-2) Bottom Band  

 
Key to Examples 

$1 Placeholder for a symbol that 
will be supplied later. 

20 Number of periods in the 
moving average. 

2, -2 Number of standard deviations 
above or below the moving 
average. 

 
This function allows you to use Bollinger Bands in color rules and alarms, as in 
the following examples.  

 
Color Rule Example: 
 

if($1.high>bb($1,20,2),clr_red,if($1.low<bb($1,20,-2),clr_green,clr_yellow)) 
 

This three-part color rule will turn a bar red when the high price of that bar 
penetrates the top Bollinger band,  green when a bar penetrates the lower 
Bollinger band, and all other bars will remain yellow. (A Bollinger Band study 
does not need to be on the chart to use this color rule.) 



 
Alarm Example: 
 

chart((us#.high>bb(us#,20,2) or us#.low<bb(us#,20,-2))[-1],1,2,100,1,1) 
 
This alarm will trigger when either the top or bottom Bollinger Band is 
penetrated.  The alarm is based on daily bars for the front month of bonds. 

Commodity Channel Index (CCI) 
The CCI measures how far away a price is from its average. In any given market, 70 to 
80 percent of random price fluctuations should fall within the +100 to -100 range of the 
CCI. If the CCI yields a value above +100, a long position may be indicated. When the 
CCI value falls back below +100, closing a long position should be considered. The same 
is true for short positions. When the CCI falls below -100, it is an indication to go short. 
It is also an indication to cover your short position when the CCI rises above -100. 
 

Type of Study Keyboard 
Command 

It works best in 

Overbought/ Oversold .cci Cash and Futures markets that 
trade in cyclical patterns 

Table 6 
 
How Aspen Graphics Calculates It: 
 

The Commodity Channel Index is calculated as follows: 
 

High,Low,Close avg-Current Simple Moving Avg 
.015 * Mean Deviation 

 
The CCI study on the chart in chart below, shows how it can be used to time a 
short position. If a short position was initiated in early August when the CCI 
dipped below -100 (green lines) and was reversed when the CCI climbed back 
above -100 a few days later, the downtrend during that period could have been 
captured. 

 
 



 
 
Default Parameters Settings: 

 
Field Value 

Color Yellow 
Graph Line 

Line Style Solid 
Line Width 1 pixel 

Period 10 
 
 

Related Aspen Graphics Functions:  cci( ) 
 

Example: cci($1,7) 
 

Key to Examples 
$1 Placeholder for a symbol that 

will be supplied later. 
7 Number of periods in the CCI 

 
This function allows you to use the Commodity Channel Index study in color 
rules and alarms as shown in the following examples. 

 
Color Rule Example: 
 



if(cci($1,14)>125,clr_green,if(cci($1,14)<-125,clr_red,clr_yellow)) 
 

This three-part color rule will turn a bar green when the CCI has a value over 125 
and will turn a bar red when the CCI has a value under -125; all other bars will 
remain yellow. 

 
Alarm Example: 
 

chart((cci(o#,7)>125 or cci(o#,7)<-125)[-1],1,2,100,1,3) 
 

This alarm will trigger when the 7-period CCI is over 125 or under -125.  The 
alarm is based on daily bars of the front month of oats. 

 
Charting Setup Idea: 
 

Oscillators like the CCI are sometimes graphed as histograms rather than as line 
charts. To draw this study as a histogram, see the Charting Setup Idea section at 
the end of the Acceleration study. 
 

Cumulative Volume 
Cumulative Volume is a weighted version of the On Balance Volume study. It adds or 
subtracts a prorated portion of the current volume to the previous Cumulative Volume 
value. The result is a weighted volume accumulator. On intraday charts, the accumulated 
tick volume for the period is used. 
 

Type of Study Keyboard 
Command 

It works best in 

Activity Indicator .cv Active Cash and Futures 
markets, all time frames 

Table 7 
 
How Aspen Graphics Calculates It: 
 

The Cumulative Volume study is calculated as follows: 
 

((Current Price - Previous Price) * Volume)  + the previous Cumulative 
Volume value 

 
Just like the On Balance Volume, the Cumulative Volume study uses an arbitrary 
positive integer as a starting point for the calculations. For this reason, the Custom 
Aspen Graphics Formula may not have the same value as the Cumulative Volume 
that is pre-programmed in Aspen Graphics; the extent of your database may also 
have an effect on this value. The shape of the graph, however, should look the 



same. As mentioned in the On Balance Volume section, the shape of the line is 
the most important aspect of these studies. 

 

 
 

Default Parameters Settings:  
 

Field Value 
Color Yellow 
Graph Line 

Line Style Solid 
Line Width 1 pixel 

 
 
Custom Aspen Graphics Formula: 
 

CumVol(series)=CumVol[1]+(($1-$1[1]) *$1.volume) 
 

This formula, once entered in the Formula Listing, allows you to use the 
Cumulative Volume study in color rules and alarms as shown in the following 
examples. 

 
 
Color Rule Example: 
 



if(CumVol($1)>CumVol($1)[1] and CumVol($1)[1] >CumVol($1)[2] and CumVol($1)[2]> 
CumVol($1)[3],clr_green,if(CumVol($1)<CumVol($1)[1] and CumVol($1)[1] 

<CumVol($1)[2] and CumVol($1)[2]<CumVol($1)[3],clr_red,clr_yellow)) 

 
This three-part color rule will turn a bar green when the Cumulative Volume has 
increased for three consecutive periods; it will turn a bar red when the Cumulative 
Volume has declined for three consecutive periods, and it will leave all other bars 
yellow. 

 
Alarm Example: 
 

chart((if(CumVol(sp#)>CumVol(sp#)[1] and sp#<sp#[1] or  CumVol(sp#)<CumVol(sp#)[1] 
and sp#>sp#1[1])[-1],30,1,100,1,3) 

 
This alarm will trigger when the direction of the Cumulative Volume line is 
diverging from price action.  The alarm is based on 30-minute bars of the S&P’s. 

 
Charting Setup Idea: 
 

The Cumulative Volume study can sometimes appear as a type of oscillator.  It 
can, like other oscillators, be graphed as a histogram rather than as a line chart.  
To draw this study as a histogram, see the Charting Setup Idea section at the end 
of the Acceleration study. 

 

Directional Indicator (DMI) 
The Directional Indicator is used to determine if the market is in trend mode. This makes 
it one of the few studies that doesn’t simply follow a trend, but identifies the presence, 
strength and direction of a trend. It is often referred to as the DMI. 
 

Type of Study Keyboard 
Command 

It works best in... 

Trend Indicator .dm Cash and Futures markets, 
all time frames 

 
 
How Aspen Graphics Calculates It: 
 

Two lines make up the Directional Indicator:  the DI+ line and the DI- line.  
These lines measure the greatest part of the current price range that lie outside of 
the previous price range. A value is assigned either to the directional movement 
up (+DM) or to the directional movement down (-DM) for any given period; the 
other value is set to zero. For example, if the difference between the current and 
previous high is 8 points and the difference between the current and previous low 



is 5 points, we say that the directional movement up is eight, and the directional 
movement down is zero. 

 
The DI+ and DI- lines are plotted together. When the DI+ is above the DI-, a long 
position is indicated, and when the DI- is above the DI+, a short position is 
indicated. 

 
 

+DM  = current high - previous high 
-DM = current low - previous low 

Direc 
If  +DM>-DM, then -DM = 0 
If  -DM>+DM, then +DM = 0 

 
If the current range equals or lies within the previous range, both +DM and -DM 
= 0. 
 
The DI+ Line is:   (modified moving avg of the +DM) * 100 

modified moving avg of the Avg True Range 
 

The DI- Line is:   (modified moving avg of the -DM) * 100 
modified moving avg of the Avg True Range 

 
Because the directional movement is divided by the instrument’s average true 
range, the Directional Indicator is “normalized,” which means you can use it to 
compare instruments across markets and in different trading ranges.  

 
 
On the chart below, the Directional Indicator is signaling a long position at the 
end of June. The study indicates that this position should be closed when the DI+ 
line (green) crosses below the DI- line (yellow). A new long position taken on end 
of July, when the DI+ line once again rose above the DI- line, would have kept 
you in the market to enjoy the August rally which followed. 

 



 
Figure 23 

 
Default Parameters Settings: 
 

Field Value 
Color: DI- Yellow 
Color: DI+ Green 
Graph: DI- Line 
Graph: DI+ Line 

Line Style: DI- Solid 
Line Style: DI+ Solid 
Line Width: DI- 1 pixel 
Line Width: DI+ 1 pixel 

Period 14 
 

Related Aspen Graphics Functions: 
 

dmineg( )        DI- line Example: dmineg($1,14) 
dmipos( )        DI+ line Example: dmipos($1,14) 
 

Key to Examples 
$1 Place holder for a symbol that 

will be supplied later. 
14 Number of periods in the DMI 

study. 



 
These functions allow you to use the DI- and DI+ lines of the Directional 
Indicator study in color rules and alarms as shown in the following examples. 

 
Color Rule Example: 
 

if(dmipos($1,14)>=dmineg($1,14),clr_green,clr_red) 
 

This color rule will turn all bars green when the DI+ line is above or equal to the 
DI- line and will color all bars red when the DI+ line is below the DI- line. 

 
Alarm Example: 
 

chart((abs(dmipos(kc#,14)-dmineg(kc#,14))>=15)[-1],1,2,100,1,1) 
 

This alarm will trigger when there is a spread of at least 15 points between the 
DI+ and the DI- lines.  The alarm is based on daily bars for the front month of 
coffee futures. 

 

Directional OscilIator  
The Directional Oscillator combines the DI+ and DI- lines of the Directional Indicator 
(also known as the Directional Movement Index) into one line that fluctuates above and 
below zero. The signals generated by the Directional Oscillator and the Directional 
Indicator are identical. See Directional Indicator in this section for more information on 
the DI+ and DI- lines. 
 

Type of Study Keyboard 
Command 

It works best in... 

Trend Indicator .do Cash and Futures markets, all time 
frames 

 
 
How Aspen Graphics Calculates It: 

The Directional Oscillator study is calculated as follows:     DI+ minus DI- 
 

For an explanation of how the DI+ and DI- values are calculated, see the 
Directional Indicator study. 

 
Default Parameters Settings: 
 

Field Value 
Color Yellow 
Graph Line 

Line Style Solid 



Line Width 1 Pixel 
Period 14 

 
 

Custom Aspen Graphics Formula: 
 

DirOsc(series)=dmipos($1,14)-dmineg($1,14) 
 

This formula will allow you to use the Directional Oscillator study in color rules 
and alarms. 

 
Color Rule Example: 
 

if(DirOsc($1,14)>=0,clr_green,clr_red) 
 

This color rule will color all bars green when the Directional Oscillator is positive 
and will color all bars red when the Directional Oscillator is negative. 

 
Alarm Example: 
 

chart(((DirOsc(csco)-DirOsc(csco)[5])>=25)[-1],1,2,100,1,1) 
This alarm will trigger when the Directional Oscillator has increased by at least 
25 points over the last 5 days. The alarm is based on daily bars for Cisco Systems 
stock. 
 

HiLo Oscil lator 
The HiLo Oscillator provides a measurement of directional movement. Periods which 
gap up or gap down will often register large positive and negative values on the HiLo 
Oscillator. This study takes the difference of the current period’s high and previous 
period’s close and divides it by the current period’s true range.  
 

Type of Study Keyboard 
Command 

It works best in... 

Overbought/Oversold .hlo Cash, Futures, and Options markets in all 
time frames and all market conditions. 

 
 

The true range is defined as the greatest of the following three values: 
 

1.  The current high minus the previous close; 
2.  The current high minus the current low; or 
3.  The previous close minus the current low. 

 



The HiLo Oscillator is plotted on a scale between -100 and 100, and like the A/D 
Oscillator, often fluctuates dramatically between these numbers.  To make this 
study easier to read, a moving average can be applied to the HiLo Oscillator and 
overbought/oversold zones can be applied to this moving average. 

 
How Aspen Graphics Calculates It: 
 

The HiLo Oscillator is calculated as follows: 
 

100 *  Current High - Previous Close 
                              True Range 

 
Where True Range = true high - true low  

 
Default Parameters Settings: 

Field Value 
Color Yellow 
Graph Line 

Line Style Solid 
Line Width 1 Pixel 

 
 
 
Custom Aspen Graphics Formulas: 
 

HiLoOsc(series)=100*($1.high-$1.prev)/$1.trange   
 

This formula allows you to use the HiLo Oscillator study in color rules and alarms 
as shown in the following examples. 

 
Color Rule Example: 
 

if(HiLoOsc($1)>90 or HiLoOsc($1)<-50,clr_red,clr_yellow) 
 

This color rule will turn a bar red when the value of the HiLo Oscillator is over 90 
or less than -50, and leave all other bars yellow. 

 
Alarm Example: 
 

chart(eavg(HiLoOsc(sm#1),6)>=70 or eavg(HiLoOsc(sm#1),6)<=30),1,2,100,1,3) 
 

This alarm will trigger if, at the end of the day, the 6-period exponential moving 
average of the HiLo Oscillator is above 70 or below 30.  The alarm is based on 
daily bars of the first month out soybean meal contract. 

 
Charting Setup Idea: 



Oscillators like the HiLo Oscillator are sometimes graphed as histograms rather 
than as line charts.  To draw this study as a histogram, see the Charting Setup 
Idea section at the end of the Acceleration study. 

 

Historical Volati l i ty  
Historical Volatility is a measure of price fluctuation over time. This study measures the 
likelihood of certain price levels being reached. If a market has large price swings over 
time, it is considered to have high historical volatility. In such a market, it is more likely 
that higher highs and lower lows will be hit than in a market that doesn’t have such 
dramatic price swings. 
 
Notice that Historical Volatility doesn’t predict the direction of price movement. Instead, 
it shows how much the price has changed over a range of recent prices, and this 
information can be used in predicting the likelihood of future price movements. For 
example, rising volatility in a market that has been moving sideways usually indicates 
that prices are ready to break out of their current trading range to either the up or down 
side. It is also the case that decreasing volatility signals a breakout as market makers may 
soon step in to infuse new activity into a consolidated market. 
 
Type of Study Keyboard 

Command 
It works best in 

Activity Indicator .hvol Cash, Futures and Options markets, all time 
frames 

 
 



 
 
How Aspen Graphics Calculates It: 
 

First identify the mean, and then calculate the standard deviation: 
 
Formula: 

Historical Volatility: 
 

 ( )∑
=

n

1i

2
ix - m

1-n
1=σ  

Where: 
σ  =standard dev, or historical volatility 
n   =  number of occurrences (bars) 
m  =  mean 
xi  = price changes 

And: 
Mean: 

 ∑
n

1=i
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n
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Where:  m = mean 
n = number of occurrences 
xi = price changes 

 



And: 
xi can equal percent of price change: 
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Default Parameters Settings: 

Field Value 
Base 0.0 
Color Yellow 

Deviations 1.0 
Graph Line 

Line Style Solid 
Line Width 1 pixel 

Method Nat. Log. 
Period 10 
Price Close 

Trading Periods 253.0 
 
Related Aspen Graphics Function: hvol( ) 
 

Examples: hvol($1,10,1,253,0)  
hvol($1,10) 

 
Key to Examples 

$1 Place holder for a symbol that 
will be supplied later. 

10 Number of periods in the Hist. 
Vol. study 

1 Number of standard deviations 
253 Number of trading periods in a 

year 
0 Base 100 value. 0 is Default. 100 

needs to be used only when the 
hvol function is surrounded by 
the chart() function. 

 
This function allows you to use the Historical Volatility study in color rules and 
alarms as shown in the following examples. 



 
Color Rule Example: 
 

if(hvol($1,10)<5,clr_cyan,clr_yellow) 
 

This color rule will change a bar to cyan when the historical volatility drops 
below five percent and will leave all other bars yellow. 
 

Alarm Example 
 

chart((hvol(sp#,10)>25)[-1],1,2,100,1,1)  
 

This alarm will trigger when the historical volatility for the front month of the 
S&P’s exceeds 25.  The alarm is based on daily bars. 

 
Formula Example: 
 

hsvol(series)=hvol($1,6)/hvol($1,100) 
 

In their book, Street Smarts, Linda Raschke and Larry Connors describe an 
indicator in which the six-day historical volatility is divided by the 100-day 
historical volatility.  The formula above, once entered in the Formula Listing, will 
allow you to chart this indicator.  From the Select Study menu, single left click on 
Formulas…and then select hsvol from the Select Formula Study menu. 
 

Keltner Channels 
This study was developed by Chester W. Keltner and is similar to the Moving Average 
Envelope and Bollinger Band studies. The difference lies in the method used to calculate 
how far the bands should be drawn above and below the moving average line. Keltner 
Channels are drawn above and below the moving average at a distance which is the 
weighted 10-period moving average of the true range multiplied by a constant.  
 

Type of Study Keyboard 
Command 

It works best in...… 

Trend Follower .keltner Cash and Futures markets that are trending. 
 
 
Default Parameters Settings: 

 
Field Value 

Avg,Type Simple 
Color – Lower Channel Cyan 

Color – Moving Average Green 
Color – Upper Channel Violet 



Graph – Lower Channel Line 
Graph – Moving Average Line 
Graph – Upper Channel Line 

Line Style – Lower Channel Solid 
Line Style – Moving Average Solid 
Line Style – Upper Channel Solid 

Line Width – Lower Channel 1 pixel 
Line Width – Moving Average 1 pixel 
Line Width – Upper Channel 1 pixel 
Multiplier – Lower Channel 1.0 
Multiplier – Upper Channel 1.0 

Period  10.0 
Price Close 

 
 
Related Aspen Graphics Functions:  keltner( ) 
 
Example:   keltner($1,10,1)  Upper Channel (default parameters) 

    keltner($1,10,-1) Lower Channel (default parameters) 
 

Key to Examples 
$1 Placeholder for a symbol that 

will be supplied later. 
10 Number of periods in the 

moving average. 
1, -1 Multiplier for the Upper and 

Lower Channels 
 
Color Rule Example: 
 

if($1.high>keltner($1,10,1),clr_red,if($1.low<keltner($1,10,-1), 
clr_green,clr_-yellow)) 

 
This three-part color rule will turn a bar red when the high price of that bar 
penetrates the top channel, green when it penetrates the lower channel, and will 
leave all other bars yellow.  

Alarm Example: 
 

chart((msft.high>keltner(msft,10,1) or msft.low<keltner(msft,10,-1))[-1],1,2,100,1,1) 
 

This alarm will trigger when either channel for MSFT is penetrated by a daily bar. 



Linear Regression 
Linear regression uses the “best fit” technique to draw a straight line that is closest to 
most of the data points. The most popular technique in statistics for “best fit” 
determination is the method of least squares. The best fit is the straight line from which 
all actual data points vary least. Along with this “best fit” line, two parallel confidence 
level lines are drawn showing the range that 95% of all values fall in. Data lying outside 
of these ranges are considered outliers and are often followed by a trend reversal.    
Because of this linear regression is considered an “envelope” study, much like Bollinger 
Bands and Keltner Channels. 
 

Type of Study Keyboard 
Command 

Works Best For 

Trend Follower .lr Cash and Futures markets that are 
trending. 

 
How Aspen Graphics calculates it: 

 
Aspen Graphics calculates linear regression using 200 periods by default. Linear 
regression always starts counting periods from the right hand side of the chart, 
even if there is no data displayed, so unlike Bollinger Bands and Keltner Channels 
the study will return different values as you look into the future. 

 
   Y = a + bX 
  

where 
  

Y is a price 
X is time 
b is the “Y intercept”, or the point at which the line crosses the Y axis, or  

  

 
  

a is the slope, or angle of the line 
  

 
   

N is the number of data points and  represents the sum over N points. 
  
Linear regression uses the “best fit” technique to draw a straight line that is 
closest to most of the data points. The most popular technique in statistics for 
“best fit” determination is the method of least squares. The best fit is the straight 
line from which all actual data points vary least. 



 
 

Default Parameter Settings: 
 

Field Value 
CI 95.0 

Color – Confidence High Blue 
Color – Confidence Low Blue 

Regression Green 
Graph – Confidence High Dotted 
Graph – Confidence Low  Dotted 

Regression Line 
Line Style – Confidence High Solid 
Line Style – Confidence Low Solid 

Line Style – Regression Solid 
Line Width – Confidence High 1 pixel 
Line Width – Confidence Low 1 pixel 

Line Width – Regression 1 pixel 
Price  Close 

Regression Width 200.0 
Type Linear 

 
 

 
Related Aspen Graphic Functions: 

 
Lr()   Example: Lr($1,100,0) 
 

Key to Examples 
$1 Placeholder for a symbol that 

will be supplied later. 
100 Number of periods in the 

regression. 
0 Tells the function to use linear 

scaling. 
1 Use Logarithmic scaling 
2 Use Continuous scaling 
3 Use Quadratic scaling 

 
 
This function allows you to use Linear Regression’s best fit line in Color Rules, 
Quote pages, and Alarms. Unfortunately there is no function to calculate the 
confidence intervals. 

 
Color Rule Example: 

  



if($1.close > lr($1,200,1), clr_red, if($1.close <lr($1,200,1), clr_green, 
clr_yellow)) 
 
This Color Rule will color the bars with a close above the 200 period best fit line 
red and those below the best fit line green.  
 

Moving Average Convergence Divergence   
(MACD)  
The MACD study measures overbought or oversold conditions. The MACD differs from 
the Moving Average Oscillator in that it uses two moving averages of the same average 
type (exponential) but different number of periods. 
 
Type of Study Keyboard 

Command 
It works best in 

Overbought/ 
Oversold 

.macd Cash and Futures markets with wide trading 
ranges, and at the end of strong trends. 

Table 14 
 
How Aspen Graphics Calculates It: 
 

Moving Average Convergence Divergence (MACD) is as follows: 
 

MACD Line = short term Exponential Moving Average with 
smoothing factor 

minus long term Exponential Moving Average with smoothing 
factor. 

Signal Line =      Exponential Moving Average of the MACD line. 
 

Overbought and oversold conditions are indicated where the MACD line crosses 
above or below its moving average.  These crossovers must occur above or below 
certain levels for the signal to be valid. 

 
Bull markets are often indicated when the MACD line is above the signal line and 
rising; it is just the opposite for bear markets.  These are only generalizations; the 
strongest signals are produced in volatile or trending markets. 

 



 
 
 
Default Parameters Settings: 
 

Field Value 
Avg. Type – Avg 1 Exponential 
Avg. Type – Avg 2 Exponential 

Signal Line Exponential 
Color – Macd Line Green 
Color – Signal Line Violet 
Graph – Macd Line Line 
Graph – Signal Line Line 

Line Style – Macd Line Solid 
Line Style – Signal Line Solid 
Line Width – Macd Line 1 pixel 
Line Width – Signal Line 1 pixel 

Period – Avg 1 0.1 
Period – Avg 2 0.2 

Period – Signal Line 0.3 
Price – Avg 1 Close 
Price – Avg 2 Close 

 
 

Note that the periods for the MACD are expressed differently than in other 
studies. This is because the number of periods are related to the smoothing factor 



2/(n+1), where n is the number of periods in the moving average.  When you enter 
a value in the  
 
Period field, you can enter either a whole number for the number of periods or a 
decimal value for the smoothing factor.  It’s automatically converted for you, as 
shown in Table 15. 
 
 

If you enter 
this value in 
Periods field: 

Aspen Graphics 
calculates the number 
of periods (n) like this: 

.1 1 = 2/(n+1) 
1 = 20/(n+1) 
1/20 = 1/(n+1) 
20 = n+1 
19 = n  so  Periods = 19 

.2 2 = 2/(n+1) 
2 = 20/(n+1) 
1/10 = 1/(n+1) 
10 = n+1 
9 = n  so Periods = 9 

.3 3 = 2/(n+1) 
3 = 20/(n+1) 
3/20 = 1/(n+1) 
20/3 = n+1 
17/3 = n  so Periods = 5.67 

 
 
Custom Aspen Graphics Formulas: 
 

MACD_(series)=eavg($1,.2)-eavg($1,.1) 
Signal_Line(input)=eavg(macd_($1),.3) 

 
These formulas, once entered in the Formula Listing, allow you to use MACD 
study in color rules and alarms as shown in the following examples. 

Color Rule Example: 
 
if(MACD_($1)>MACD_($1)[1] and MACD_($1)>Signal_Line($1),clr_green, 

   if(MACD_($1)<MACD_($1)[1] and              

 MACD_($1)<Signal_Line($1),clr_red,clr_yellow)) 

This three-part color rule will turn the bars green where the MACD line is rising 
and it is above the Signal line. Where the MACD line is falling and it is below the 
Signal line, the bars will be red. All other bars will be yellow. 

 



Alarm Example: 
 

chart((MACD_(w#)>=Signal_Line(w#))[-1],30,1,100,1,3) 
(make sure to set Trigger When State: to Changes) 

 
This alarm will trigger each time the MACD line crosses the Signal line for the 
front month of wheat. The alarm is based on 30-minute bars. 
 

MACD Oscil lator 
The MACD Oscillator converts the two lines of the MACD into a single line that 
fluctuates above and below zero. The MACD Oscillator is calculated by subtracting the 
Signal Line value from the MACD Line value. When the MACD Line crosses the Signal 
Line, the MACD Oscillator displays a value of zero, and a buy or sell signal is generated.  
The signals provided by the MACD and the MACD Oscillator are identical.  
 

Type of Study Keyboard 
Command 

It works best in 

Overbought/Oversold .macdo Cash and Futures markets with wide 
trading ranges and at the end of strong 
trends.  

 
 
How Aspen Graphics Calculates It: 
 

The MACD Osc is: MACD Line minus Signal Line  
 

MACD Line = short term Exponential Moving Average with smoothing factor 
minus long term Exponential Moving Average with smoothing factor 

 
Signal Line = Exponential Moving Average of the MACD Line 

 
The MACD Oscillator study may indicate oversold conditions when it crosses 
above the “zero line.”   
 
When the oscillator moves back below zero again, overbought conditions may be 
indicated. 

 



 
 
Default Parameters Settings: 

Field Value 
Avg. Type – Avg 1 Exponential 
Avg. Type – Avg 2 Exponential 

Avg. Type – Signal Line Exponential 
Color Yellow 
Graph Line 

Line Style Solid 
Line Width 1 pixel 

Period – Avg 1 0.1 
Period – Avg 2 0.2 

Period – Signal Line 0.3 
Price – Avg 1 Close 
Price – Avg 2 Close 

 
 

Note that the periods for the MACD Oscillator are expressed just like the MACD 
study, which are different from the other studies in Aspen Graphics. For an 
explanation of how these periods are calculated, see the Default Parameters 
Settings for the MACD study in the previous section. 

 
Custom Aspen Graphics Formulas: 
 

MACD_(series)=eavg($1,.2)-eavg($1,.1) 



Signal_Line(input)=eavg(macd_($1),.3) 
MACD_Osc(series)= MACD_($1)-Signal_Line($1) 

 
 

These formulas, once entered in the Formula Listing, allow you to use the MACD 
Oscillator study in color rules and alarms, as shown in the following examples.  

 
Color Rule Example: 
 

if((MACD_Osc($1)>=0 and MACD_Osc($1)[1]<0),clr_green, if((MACD_Osc($1)<=0 and 
MACD_Osc($1)[1]>0),clr_red,clr_yellow)) 

 
This three-part color rule will turn the bar green where the MACD Oscillator has 
changed to a positive value; it will turn the bar red where the MACD Oscillator 
has changed to a negative value, and all other bars will remain yellow. 

 
Alarm Example: 
 

chart((MACD_Osc(c#)>=0)[-1],30,1,100,1,3) 
(make sure to set Trigger When State to Changes) 

 
This alarm will trigger each time the MACD Oscillator line crosses the “zero” 
line for the front month of corn. The alarm is based on 30-minute bars. 

 
Charting Setup Idea: 
 

Oscillators are sometimes graphed as histograms rather than as line charts. To 
draw this study as a histogram, see the Charting Setup Idea section at the end of 
the Acceleration study. 

Momentum 
Momentum is the difference between the current price and a previous price. Momentum 
indicates the rate of change in prices and helps determine when a trend is “running out of 
steam.” If prices are going up but momentum is falling, prices are expected to rise less 
quickly, signaling that the current trend may be coming to an end. 
 
The Momentum study can generate buy signals. When momentum has been negative and 
then becomes positive, a buy may be indicated if this is also the direction of the current 
trend. 
 
Divergence between momentum and price is another important use of this study. A down 
trend may be coming to an end if prices make new lows, but momentum makes higher 
lows; the same is true for an up-trend when price and momentum diverge. 
 

Type of Study Keyboard 
Command 

It works best in 



Overbought/Oversold .mom Cash and Futures markets, all time frames 
Table 13 

 
How Aspen Graphics Calculates It 
 

Momentum is:  Current Price - Price n periods ago 
 

The user determines which price (i.e. how many bars back) should be subtracted 
from the current price.   
 

 
 

The trendlines (red) drawn on the chart above, show divergences between price 
and momentum; price was going up while momentum was going down, and the 
uptrend was soon reversed. 

 
Default Parameters Settings: 
 

Field Value 
Color Yellow 
Graph Line 

Line Style Solid 
Line Width 1 pixel 

Period 10 
Price Close 

 



 
Related Aspen Graphics Functions: mom( ) 

 
   Example: mom($1,21) 

The mom(  ) function allows you to use Momentum in color rules and alarms as 
shown in the following examples. 
 

Key to Example 
$1 Placeholder for a symbol that 

will be supplied later. 
21 Number of periods in the 

momentum study. 
 

Color Rule Example: 
 

if(mom($1,21)>0 and mom($1,21)[1]<=0,clr_blue,clr_yellow) 
 

This color rule will turn a bar blue when the 21-period momentum becomes 
positive. 

 
Alarm Example: 
 

chart((ip.high>ip.high[1] and ip.high[1]>ip.high[2] and 
mom(ip,10)<mom(ip,10)[1] and mom(ip,10)[1]<mom(ip,10)[2])[-
1],15,1,100,1,1) 

 
This alarm is monitoring divergence between price and momentum. The alarm 
will trigger when the high price of International Paper has increased over the last 
two periods while the 10-period momentum was falling during that same period, 
based on 15-minute bars. 

 
Formula Example: 
 

LBR_RSI=chart(rsi(mom($1,1),3)[-1],1,2,100,1,3) 
In their book Street Smarts, Linda Raschke and Laurence Connors talk about a 
trading technique they call “Momentum Pinball.” This technique uses a 3-period 
RSI study on a 1-period Momentum study.   

 
This combination can be easily charted in Aspen Graphics using the “Add a 
Study” option on the Select Study menu and the “First Study” price parameter.   
 
The LBR_RSI can also be quoted on a quote page using the preceding formula. 

 



Moving Averages 
Moving averages are smoothing techniques. They are the average price of an instrument 
over a certain number of periods. Faster moving averages are based on fewer periods, 
and slower moving averages are indicative of long-term trends. The strength of a trend is 
indicated by the steepness of the moving average’s slope. 
 
Moving averages are always lagging indicators because they incorporate historical data. 
For this reason, they are used more to confirm that a change in trend has already taken 
place than as a way of predicting when a change will occur. 
 

Type of Study Keyboard 
Command 

It works best in 

Trend Follower .mav Cash and Futures markets that are trending. 
 

 
Aspen Graphics has five different types of moving averages. These five moving 
averages are listed and explained in the tables below. 

 
Key to Example 

P Current Price 
P1 Price 1 Period ago, etc. 
MAprev Previous Moving Average Value 
n Number of Periods 
a Smoothing Constant 2/(n+1) 

 
 

Description How Aspen Graphics Calculates It
Simple Moving Average 

Average (mean) of data over n periods P+P1+…+P(n-1)  
            n 

Modified Moving Average 
Subtracts last moving average value instead 
of oldest data  

MAPrev+1/n(P-MAPrev) 

Exponential Moving Average 
Assigns more weight to newer data using a 
geometric formula 

P+a*P1+a2*P2+…+(an-1)*Pn-1 
          1+a+a2+…+a(n-1) 

Weighted Moving Average 
Assigns more weight to newer data using an 
arithmetic formula  

n*P+(n-1)*P1+(n-2)*P2+.+P(n-1) 
              1+2+3+…+n 

Hamming Moving Average 
Weights recent data much more heavily than 
older data using a sine wave curve function 

Proprietary; developed by Aspen 
Research Group 

 
Default Parameters Settings: 



Field Value 
Avg. Type Simple 

Color Green 
Graph Line 

Line Style Solid 
Line Width 1 pixel 

Period 5 
Price First Study 
Shift 0 

 
 
Related Aspen Graphics Functions: 
 

savg(  ) Simple Moving Avg.  savg($1,21) 
mavg(  ) Modified Moving Avg. mavg($1,14,1) 
eavg(  ) Exponential Moving Avg  eavg($1,10) 
wavg(  ) Weighted Moving Avg. wavg($1,52) 
havg(  ) Hamming Moving Avg. havg($1,5,1) 
 

Key to Examples 
$1 Placeholder for a symbol that 

will be supplied later. 
2nd 
number 

Number of periods in the 
moving average. 

3rd 
number 

(if present) number of bars to 
shift the moving average. 

 
Color Rule Example: 
 

if(savg($1,5)<savg($1,5)[1] and savg($1,5)[1]>savg($1,5)[2],clr_green,clr_yellow) 
 

This color rule will turn the bar green when a 5-period simple moving average 
reverses direction on a high (i.e. the current moving average value is less than the 
one before, and that value was greater than the moving average value two bars 
back). 

 
Alarm Example: 
 

chart((sp#.low>wavg(sp#,5))[-1],1,2,100,1,3) 
 

This alarm will trigger when the low is higher than the 5-day weighted moving 
average. 

 
Formula Example: 
 

doubleEAVG(input)=eavg(eavg($1,14),14) 



  
This formula can be charted as an overlay and produces a super-smooth double 
exponential moving average (a moving average of a moving average). 
 

Moving Average Envelope 
The Moving Average Envelope study draws bands around a moving average to form a 
channel. The purpose of the bands is to show which prices are falling outside of the 
expected range. 
 
The Moving Average Envelope study is very similar to the Bollinger Band and Keltner 
Channel studies; the difference lies in the method used to calculate how far the bands 
should be drawn above and below the moving average line. The Moving Average 
Envelope bands are drawn above and below the moving average at a distance which is a 
percentage of the moving average value. For example, if the value of the moving average 
at a particular bar is 100 and the Percent field is set to 0.5, the top and bottom bands will 
be drawn at 100.5 and 99.5. 
 
Type of Study Keyboard 

Command 
It works best in 

Trend Follower .env Cash and Futures markets that are trending 
 
The figure below shows a Moving Average Envelope around a 10-day simple moving 
average with bands set at 2% above and below the average. 
 

 
 

 
Default Parameters Settings: 

Field Value 
Avg. Type Simple 

Color: Envelope Bottom Cyan 



Color: Envelope Top Violet 
Color: Moving Average Green 
Graph: Envelope Bottom Line 

Graph: Envelope Top Line 
Graph: Moving Average Line 

Line Style: Envelope Bottom Solid 
Line Style: Envelope Top Solid 

Line Style: Moving Average Solid 
Line Width: Envelope Bottom 1 pixel 

Line Width: Envelope Top 1 pixel 
Line Width: Moving Average 1 pixel 

Percent: Envelope Bottom 2.0 
Percent: Envelope Top 2.0 

Period 10.0 
Price First Study 

 
Custom Aspen Graphics Formulas: 

 
EnvAverage(input,per=10)=savg($1,per) 
EnvTop(input,per=10,prcnt=0.005)=savg($1,per)+prcnt*savg($1,per) 
EnvBottom (input,per=10,prcnt=0.005)=savg($1,per)-prcnt*savg($1,per) 

 
These formulas, once entered in the Formula Listing, allow you to use the Moving 
Average Envelope study in color rules and alarms, as shown in the following 
examples. 

 
Color Rule Example: 
 

if($1.high<EnvBottom($1) or $1.low>EnvTop($1),clr_red,clr_yellow) 
 

This color rule will turn a bar red when the entire price range for that bar lies 
outside of the Moving Average Envelope. 

 
Alarm Example: 
 

chart((sp#.high<EnvBottom(sp#) or sp#.low>EnvTop(sp#))[-1],10,1,100,1,3) 
 

This alarm will trigger when the entire price range lies outside of the Moving 
Average Envelope. The alarm is based on a 10-minute bar chart of the current 
S&P contract. 



Moving Average Momentum 
The Moving Average Momentum study measures the rate of change of a moving average. 
It is very similar to the Acceleration study except that instead of comparing momentum 
values, this study compares moving average values. 
 

Type of Study Keyboard Command It works best in 
Overbought/ Oversold .mavmom Cash and Futures markets, 

all time frames. 
 
How Aspen Graphics Calculates It: 
 

Moving Average Momentum is:  
 
Current Moving Avg.-Moving Avg n periods back 

 

 
 

 
Default Parameters Settings: 
 

Field Value 
Avg. Type Simple 

Color Yellow 
Graph Line 

Line Style Solid 
Line Width 1 pixel 

Mav. Periods 10 
Period 5 
Price Close 

 
 



The user determines how many periods should be used in the moving average from the 
Mav. Periods field of the study’s parameter menu. The number of periods back to be 
compared against the current moving average value is determined in the Period field of 
the study’s parameter menu. 

 
Custom Aspen Graphics Formulas: 
 

MovAvgMom(series,per=5)=savg($1,10)-savg($1,10)[per] 
 

This formula, once entered in the Formula Listing, allows you to use Moving 
Average Momentum in color rules and alarms as shown in the following 
examples.  

 
Color Rule Example: 
 

if(MovAvgMom($1)>1,clr_green, 
if(MovAvgMom($1)<-1,clr_red,clr_yellow)) 
 
This three-part color rule will turn a bar green when the Moving Average 
Momentum is greater than 1, red when the value is less than -1, and leave all other 
bars yellow.  The color rule is based on a 10-period moving average. 

 
Alarm Example: 
 

chart(MovAvgMom(us#)<-1.5[-1],1,2,100,1,3) 
 

The alarm will trigger when the Moving Average Momentum for the front month 
of bonds is less than -1.5.  The alarm is based on daily bars.   

 
Charting Setup Idea: 
 

The Moving Average Momentum study is an oscillator. By default, the study is 
drawn as a line but can be graphed as a histogram or a variety of other methods.  
See the Charting Setup Idea at the end of the Acceleration section. 
 

Moving Average Oscil lator 
This study subtracts one moving average from another. The MACD study, which uses 
two moving averages of the same average type (exponential) but a different number of 
periods, is different from the Moving Average Oscillator. This study uses (as default) two 
different average types (simple and modified) with the same number of periods. 
 
The emphasis of this study lies more in the difference between the two average types than 
in comparing long and short term trends. Comparing the trends is the job of the MACD. 
 

Type of Study Keyboard It works best in 



Command 
Overbought/ Oversold .mao Cash and Futures markets that are 

trending. 
 
How Aspen Graphics Calculates It: 
 

The Moving Average Oscillator is:   
 

Moving Avg#1-Moving Avg#2 
 

The user determines the type of moving averages to be used and the number of 
periods in each moving average. 

 
Default Parameters Settings: 
 

Field Value 
Avg: 1 Simple 
Avg: 2 Modified 
Color Green 
Graph Line 

Line Style Solid 
Line Width 1 pixel 

Period: Avg 1 10 
Period: Avg 2 10 
Price: Avg 1 Close 
Price: Avg 2 Close 
Shift: Avg 1 0 
Shift: Avg 2 0 

 
Custom Aspen Graphics Formula: 
 

MovAvgOsc(series)=savg($1,10)-mavg($1,10) 
 

This formula, once entered in the Formula Listing, allows you to use Moving 
Average Momentum in color rules and alarms as shown in the following 
examples. 

 
Color Rule Example: 
 

if(MovAvgOsc($1)>0 and MovAvgOsc($1)>MovAvgOsc($1)[1], clr_red,clr_yellow) 
. 

This color rule will turn a bar red when the Moving Average Oscillator is positive 
and rising and will leave all other bars yellow. 

 
Alarm Example: 
 



chart((MovAvgOsc(s#)>MovAvgOsc(s#)[1] and MovAvgOsc(s#)[1]> MovAvgOsc(s#)[2] and 
MovAvgOsc(s#)[2]>MovAvgOsc(s#)[3])[-1], 1,2,100,1,3) 

 
The alarm will trigger when the Moving Average Oscillator for the front month of 
soybeans has risen for the last three daily bars.   

 
Charting Setup Idea: 
 

The Moving Average Oscillator study is, by default, drawn as a line but can be 
graphed as a histogram or a variety of other methods; see the Charting Setup 
Idea at the end of the Acceleration section. 

 

On Balance Volume 
On Balance Volume is a volume accumulator. All of the volume in an up-period (a period 
which closes higher than the previous period) is added to the previous On Balance 
Volume, while all of the volume in a down-period (a period which closes lower than the 
previous period) is subtracted from the previous On Balance Volume. 
 

Type of Study Keyboard 
Command 

It works best in... 

Activity 
Indicator 

.obv Cash and Futures markets which are active, all time 
frames 

 
The important aspect of this study is the direction and not the exact volume level of the 
On Balance Volume line. Divergence between price and the On Balance Volume can be a 
signal of trend reversal. This study can also lend some clues as to supply and demand as 
measured by the volume in up-periods and the volume in down-periods. 
 
How Aspen Graphics Calculates It: 
 

The On Balance Volume study is calculated as follows: 
 

If the current close is greater than the previous close, all the volume for the 
period is added to the previous On Balance Volume. 

 
If the current close is less than the previous close, all the volume for the 
period is subtracted from the previous On Balance Volume. 

 
The On Balance Volume uses an arbitrary positive integer as a starting point for 
the calculations. For this reason, the Custom Aspen Formula (below) may not 
have the same value as the On Balance Volume that is preprogrammed in Aspen 
Graphics. The extent of your database may also have an effect on this value. The 
shapes of the two graphs, however, should look the same. 

 



Default Parameters Settings: 
Field Value 

Color Yellow 
Graph Line 

Line Style Solid 
Line Width 1 pixel 

 
Custom Aspen Graphics Formula: 
 

OBVol(series)=if($1.close>$1.prev,obvol[1]+$1.volume,if($1.close<$1.prev,ob
vol[1]-$1.volume,obvol[1])) 

 
This formula, once entered in the Formula Listing, allows you to use the On 
Balance Volume study in color rules and alarms, as shown in the following 
examples. 

 
Color Rule Example: 
 

if(OBVol($1)>OBVol($1)[1] and OBVol($1)[1]>OBVol($1)[2] and 
OBVol($1)[2]>OBVol($1)[3],clr_green, 

 if(OBVol($1)<OBVol($1)[1] and OBVol($1)[1]<OBVol($1)[2] and 

 OBVol($1)[2]<OBVol($1)[3], clr_red,clr_yellow)) 

This three-part color rule will turn a bar green when the On Balance Volume has 
increased for three consecutive periods, turn a bar red when the On Balance 
Volume has declined for three consecutive periods, and leave all other bars 
yellow.  

 
Alarm Example: 
 

chart((OBVol(sp#)>OBVol(sp#)[1] and sp#<sp#[1]) or (OBVol(sp#)<OBVol(sp#)[1] and 
sp#>sp#1[1])[-1],15,1,100,1,3) 

 
This alarm will trigger when the direction of the On Balance Volume line is 
diverging from price action. The alarm is based on 15-minute bars of the front 
month of the current S&P contract. 

 
Charting Setup Idea: 
 

When graphed, the On Balance Volume can sometimes appear as a type of 
oscillator. It can, like other oscillators, be graphed as a histogram rather than as a 
line chart.   

 
To draw this study as a histogram, see the Charting Setup Idea at the end of the 
Acceleration study section. 



Open Interest 
Open Interest is the number of outstanding future contracts at the end of a trading day. 
This study is not available on stocks, nor is it available in intraday time frames. 

 
Type of Study Keyboard 

Command 
It works best in... 

Activity Indicator .opint Futures and Options markets, daily and longer 
time frames 

 
 

When a new contract is written, open interest is increased by a value of one. If an existing 
contract is traded, open interest remains unchanged, but if a contract is liquidated, open 
interest is decreased by a value of one. 
 
How Aspen Graphics Calculates It: 
 

Calculations don’t take place within the Aspen Graphics program for this study.  
The values for Open Interest are sent by the datafeed just like the price data. 

 

 
 
 

Default Parameters Settings: 
 

Field Value 
Color Yellow 
Graph Line 

Line Style Solid 
Line Width 1 pixel 

 
 
Custom Aspen Graphics Formulas: 



 
You can make reference to Open Interest values by using the $1.oi quote code in 
formulas, color rules and alarms, as shown in the following examples. 

 
Color Rule Example: 
 

if($1.oi>100000,clr_cyan,clr_yellow) 
 

This color rule will turn a bar cyan when open interest exceeds 100,000.  
 
Alarm Example: 

spm7.oi>=200000  
This alarm will trigger when the open interest of the June ’97 S&P’s reaches or 
exceeds 200,000. 

 

Parabolic 
The Parabolic study sets a stop price for each bar based on the direction of the trend. 
When the price penetrates the “trail” of Parabolic stops, it is an indication that the 
position should be reversed. This is called the Stop and Reverse point (SAR). 
 
This study works well in trending markets but can give many false signals that might stop 
you out of a trade too early when the market is flat. For this reason, the Parabolic study is 
often used in conjunction with trend identifying indicators like the Directional Indicator 
or Directional Oscillator. 
 

Type of Study Keyboard 
Command 

It works best in 

Trend Follower .parab Cash and Futures markets that are 
trending. 

 
 
How Aspen Graphics Calculates It: 
 

The initial SAR point represents the last significant high or low. If the market is 
trending up, stops are placed below the price activity. Stops are placed above the 
bars during down trends. 

 
 
At first, these stops are set “loosely” so that you will not be stopped out by the 
minor volatility of a change in trend. As the trend continues, the stops are 
“tightened up” in the direction of the trend using an acceleration factor. This 
factor begins at .02 and increases by .02 to a maximum acceleration factor of .2.  
This acceleration formula is hard coded into the Aspen Graphics software and 
cannot be changed by the user. 



 
Once the price penetrates a stop, a new series of Parabolic trailing stops begins on 
the other side of the price activity and continues until it is penetrated by price. 
 
In the  chart below, ots sloping down above the bars are the trailing stops for a 
short position starting on Sept 6. On October 18, the stop is penetrated by price, 
an indication that the position should be reversed. A new series of SAR points 
begins building below the bars. 

 

 
 
Default Parameters Settings: 
 

Field Value 
Accelerator 0.020 

Color Green 
Graph Dots 
Limit 0.2 

Line Style Solid 
Line Width 1 pixel 

 
Figure 46 

 
Custom Aspen Graphics Formula: 
 

Because Aspen Graphics has no Parabolic function, and a custom Parabolic study 
cannot be written as a formula in the Formula Listing menu, no color rules or 
alarms can be set on Parabolics. 

 
Color Rule Example: 

We cannot use the results of the Parabolic function directly in a formula or color 
rule but we can use the values on the chart to create a color rule. The following 
color rule colors descending values red and ascending values blue.  

 



if($1<rawdata[1],clr_blue,clr_red) 
 

Relative Strength Index (RSI)  
Developed by J. Welles Wilder, the RSI is used to determine the strength of a trend and 
to predict market reversals. This index is an overbought/oversold indicator plotted on a 
vertical scale from 0 to 100. 
 

Type of Study Keyboard Command It works best in... 
Overbought/Oversold .rsi Cash and Futures markets that are 

trending; in all time frames. 
 

Values under 30 were considered by Wilder to represent oversold conditions, and RSI 
values over 70 were considered overbought conditions. Today, RSI values of 80 and 20 
are more commonly used.  
 
How Aspen Graphics Calculates It: 
 

The Relative Strength Index is calculated as follows: 
 

⎥⎦
⎤

⎢⎣
⎡

 RS+ 1
100-100=RSI  

 
where RS is: 
 
modified moving average of x day’s up closes 
modified moving average of x day’s down closes 

 

 
 

The RSI study in the chart above reveals several important aspects of the market activity 
on the March ‘07 Coffee futures:
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o The periods of strongest trend are reflected in the steepness of the RSI’s slope. 

o While the highest RSI value in July, didn’t signal an immediate reversal, the 
market began to consolidate which was an indication that the current uptrend had 
lost momentum. 

 
Default Parameters Settings: 

Field Value 
Color Yellow 
Graph Line 

Line Style Solid 
Line Width 1 pixel 

Period 14 
Price Close 

 
 

Wilder’s original RSI employed a number of periods equal to half of the normal 
cycle. For example, if an instrument was presumed to have a 28-day cycle, 14 
periods were used in the RSI calculation. 

 
Related Aspen Graphics Functions: rsi( ) 
 

Example: rsi(sp#,14) 
 

Key to Examples 
$1 Placeholder for a symbol that 

will be supplied later. 
14 Number of periods in the RSI. 

 
This function will allow you to use the Relative Strength Index study in color 
rules and alarms as shown in the following examples. 
 

Color Rule Example: 
 

if(rsi($1,14)>75,clr_cyan,if(rsi($1,14)<25,clr_red,clr_yellow)) 
 

This three-part color rule will turn a bar cyan when the RSI has a value over 75 
and will turn a bar red when the RSI has a value under 25; all other bars will 
remain yellow.  

 
Alarm Example: 
 

chart((rsi(sp#,14)>70 or rsi(sp#,14)<30)[-1],40,0,100,1,1) 
 

This alarm will trigger when the 14-period RSI has a value over 70 or under 30.  
The alarm is based on a 40-EqTick chart of the current S&P contract. 
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Stochastic, Fast 
Two lines make up this study: %K and %D.  These lines oscillate between 0 and 100.  
The Fast Stochastic gives a variety of signals:  
 

Overbought: when the %K is above 80* and crosses below the %D line  
Oversold: when the %K is below 20* and crosses above the %D line 

 

  These values are left to the discretion of the user. Overbought conditions often range 
between 70 and 90, and oversold conditions range anywhere from 10 to 30. 
 

Type of Study Keyboard Command It works best in 
Overbought/ 
Oversold 

.fstoch Cash and Futures markets 

 
According to its developer George Lane, a divergence between the %D line and price 
produces the most important stochastic signal. Divergence occurs when price is making a 
series of lower lows while the %D line is making a series of higher lows. This signals an 
oversold market. A divergence when the %D line is below 15 is commonly thought of as 
a signal to buy. Overbought conditions are indicated when prices are reaching higher 
highs while the %D is making lower highs. A divergence when the %D line is above 85 
is commonly thought of as a signal to sell. 
 
How Aspen Graphics Calculates It: 
 

The Fast Stochastic study is calculated as follows: 
 

Fast %K line is:      100*(current close - lowest low in n periods) 
                                            (highest high in n periods - lowest low in n periods) 
 

Fast %D line is:   3 period modified moving average of the Fast %K  
 

The chart below shows a buy signal on 6/29/06 where the Fast %K line crosses 
above the Fast %D line. Later that month and into early August, prices continued 
to make higher highs while the Fast %D line began to taper off flat. This 
divergence signaled that a reversal was on its way, a reversal which came when 
prices broke in August.  
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Default Parameters Settings: 
 

Field Value 
Color %D Yellow 
Color %K Green 
Graph %D Line 
Graph %K Line 

Line Style %D Solid 
Line Style %K Solid 
Line Width %D 1 pixel 
Line Width %K 1 pixel 

Period 9 
 
Related Aspen Graphics Functions: 
 

fstoch( )   (for the Fast %K line) fstoch($1,14) 
sstoch( )   (for the Fast %D line) sstoch($1,14,3) 
 
 

Key to Examples 
$1 Placeholder for a symbol that 

will be supplied later. 
14 Number of periods in the Fast 
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%K line. 
3 Number of periods in the Fast 

%D line. 
 
 
These functions allow you to use the lines of the Fast Stochastic study in color 
rules and alarms, as shown in the following examples. 

 
Color Rule Example: 
 

if(fstoch($1,14)>sstoch($1,14,3) and fstoch($1,14)[1]<sstoch($1,14,3)[1]and 
fstoch($1,14)<30,clr_green,if(fstoch($1,14)<sstoch($1,14,3) and 
fstoch($1,14)[1]>sstoch($1,14,3)[1] and fstoch($1,14)>70, clr_red,clr_yellow)) 

 
This three-part color rule will turn a bar green when the Fast %K line has a value 
under 30 and has crossed above the Fast %D line; it will turn a bar red when the 
Fast %K line has a value over 70 and has crossed below the Fast %D line, and it 
will leave all other bars yellow. 

 
Alarm Example: 
 

chart((fstoch(sp#,14)>=sstoch(sp#,14,3))[-1],60,1,100,1,1) 
(make sure to set  Trigger When State: to Changes) 
This will trigger each time the Fast %K and Fast %D lines cross, based on hourly 
bars. 

 

Stochastic, Modified  
The Modified Stochastic is identical to the Slow Stochastic study, but it allows the user 
more flexibility.  The Fast and Slow Stochastic studies use a 3-period modified moving 
average to calculate the %D lines.  In the Modified Stochastic, the number of periods and 
the moving average type, as well as the price used to calculate the Fast %K, can be 
changed by the user. 
 

Type of Study Keyboard 
Command 

It works best in 

Overbought/ Oversold .mstoch Cash and Futures markets 
 
 

The ways in which the signals are generated, and the values used to calculate overbought 
and oversold conditions, are the same as for the Slow Stochastic study. 
 
Default Parameters Settings: 

Field Value 
Avg. Type: %D Modified 
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Avg. Type: %K Modified 
Color: %D Yellow 
Color: %K Green 
Graph: %D Line 
Graph: %K Line 

Line Style: %D Solid 
Line Style: %K Solid 
Line Width: %D 1 pixel 
Line Width: %K 1 pixel 

Period: %D 3.0 
Period: %K 3.0 
Stochastic 14 

Price Close 
 
 
Related Aspen Graphics Functions and Formulas: 
 

sstoch( )   (for the Slow %K line)  sstoch($1,14,3) 
ssstoch( )    (for the Slow %D line)   ssstoch($1,14,3,3) 

 
These functions allow you to change the number of periods used for the lines of 
the Modified Stochastic study. Note, however, that they do not allow you to 
change the Average Type; a modified moving average is used by default. For a 
different Average Type, use one of the moving average functions in a custom 
formula as shown in the following examples: 

 
SlowK(input)=eavg(fstoch($1,14),3) 
SlowD(input)=savg(wavg(fstoch,$1,14),3),3) 
 
Entering these formulas and using the preceding functions allow you to use the 
Modified Stochastic study in color rules and alarms as shown in the following 
examples. 

 
 
Color Rule Example: 
 

if($1.high>$1.high[1] and $1.high[1]>$1.high[2] and $1.high[2]>$1.high[3] 
 and SlowD($1)<SlowD($1)[1] and SlowD($1)[1]<SlowD($1)[2] and 
 SlowD($1)[2]<SlowD($1)[3],clr_blue,clr_white) 
 

This color rule illustrates a way of signaling divergence. When price has made 
three consecutive highs but the Slow %D line has been decreasing over the same 
periods, this color rule will turn the bars blue to denote this divergence; otherwise 
the bars will remain white. 

 
Alarm Example: 
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chart((sstoch(pbg8,9,3)>=SlowD(pbg8)) 
[-1],1,2,100,1,1) 
(make sure to set  Trigger When State: to Changes) 

 
This alarm will trigger each time the Slow %K and Slow %D lines cross. The 
alarm is based on daily bars for February ’98 pork bellies. 

 

Stochastic, Slow 
The Slow Stochastic is a smoothed variation of the Fast Stochastic.  There are fewer 
crossovers, and therefore fewer signals than with the Fast Stochastic. 
 

Type of Study Keyboard 
Command 

It works best in 

Overbought/ Oversold .sstoch Cash and Futures markets. 
 

 
Just like the Fast Stochastic, two lines make up this study. In the Slow Stochastic study 
these lines are referred to as the Slow %K and Slow %D. The ways in which the signals 
are generated, and the values used to calculate overbought and oversold conditions, are 
the same as for the Fast Stochastic study. 
 
The Slow %K line in the Slow Stochastic is exactly the same as the Fast %D line from 
the Fast Stochastic. This line is then smoothed with a 3-period modified moving average 
to create the Slow %D line. 
 
How Aspen Graphics Calculates It: 
 

Slow %K line is: 
 3 period modified moving average of the Fast%K (same as Fast%D line) 
 
Slow %D line is: 
3 period modified moving average of the Slow %K line  

 
The chart in Figure 52 shows a strong buy signal on 10/11/06 where the Slow %K 
line crosses above the Slow %D line at a value under 15. 
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Default Parameters Settings: 
 

Field Value 
Color: %D Yellow 
Color: %K Green 
Graph: %D Line 
Graph: %K Line 

Line Style: %D Solid 
Line Style: %K Solid 
Line Width: %D 1 pixel 
Line Width: %K 1 pixel 

Period:9 9.0 
 
Related Aspen Graphics Functions: 
 

sstoch( )    (for the Slow %K line) sstoch($1,14,3) 
ssstoch( )     (for the Slow %D line)  ssstoch($1,14,3,3) 

Key to Examples 
$1 Placeholder for a symbol that 

will be supplied later. 
14 Number of periods in the Fast 

%K line. 
3 Number of periods in the Fast 

%D line. 
3 Number of periods in the Slow 

%D. 
 

These functions allow you to use the lines of the Slow Stochastic study in color 
rules and alarms, as shown in the following examples. 
 

Color Rule Example: 
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if(sstoch($1,14,3)>ssstoch($1,14,3,3) and 
sstoch($1,14,3)[1]<ssstoch($1,14,3,3)[1] and sstoch($1,14,3)<30,clr_green, 
if(sstoch($1,14,3)<ssstoch($1,14,3,3) and 
sstoch($1,14,3)[1]>ssstoch($1,14,3,3)[1] and sstoch($1,14,3)>70, 
clr_red,clr_yellow)) 

 
This three-part color rule will turn a bar green when the Slow %K line has a value 
under 30 and has crossed above the Slow %D line; it will turn a bar red when the 
Slow %K line has a value over 70 and has crossed below the Slow %D line, and it 
will leave all other bars yellow.  

 
Alarm Example: 
 

chart((sstoch(sp#,14,3)>=ssstoch(sp#,14,3,3))[-1],60,1,100,1,1)  
 

(make sure to set  Trigger When State: to Change). This alarm will trigger each 
time the Slow %K and Slow %D lines cross. The alarm is based on hourly bars 
for the front month of the S&P contract. 
 

Variable Accumulation Distribution 
Variable Accumulation Distribution modifies the concept of the On Balance Volume 
study by comparing the opening and closing prices to the range of prices for a given 
period. Accumulation, or acquisition of long positions in anticipation of a bull market, is 
reflected in positive values of the Variable Accumulation Distribution. Negative values 
reflect distribution or selling in the anticipation of a market decline. 
 

Type of Study Keyboard 
Command 

It works best in 

Activity 
Indicator 

.vad Cash, Futures and Options markets in all time 
frames and all market conditions. 

 
 
How Aspen Graphics Calculates It: 
 

Variable Accumulation Distribution is: 
 

(Close-Open) * Volume  
(High-Low)  

 
Once this is calculated, a moving average of this value is taken.  It is this moving 
average that is charted as the Variable Accumulation Distribution study. 

 
Default Parameters Settings: 
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Field Value 

Color Yellow 
Graph Line 

Line Style Solid 
Line Width 1 pixel 

Period 10 
 
 
Custom Aspen Graphics Formula: 
 

VADist(series)=savg($1.volume*(($1.close-$1.open)/($1.high-$1.low)),10) 
 

Once this formula is entered in the Formula Listing, the study may be used in 
color rules and alarms, as shown in the following examples. 

 
Color Rule Example: 
 

if(VADist($1)>=0,clr_green,clr_red) 
 

This color rule will turn a bar green when the Variable Accumulation Distribution 
study has a positive value and will turn a bar red when the value is negative.  

 
Alarm Example: 
 

chart((VADist(kc#)>2000)[-1],1,2,100,1,3) 
 

This alarm will trigger when the Variable Accumulation Distribution study has a 
value exceeding 2,000 based on daily bars of the front month of coffee. 

 
Charting Setup Idea: 
 

Oscillators like the Variable Accumulation Distribution study are sometimes 
graphed as histograms rather than as line charts. To draw this study as a 
histogram, see the Charting Setup Idea section at the end of the Acceleration 
study section. 
 

Volume 
Volume measures the activity on an instrument during any given period.  The Volume 
study measures different things depending on the instrument type and time frame that you 
are examining. 
 

Type of Study Keyboard Command It works best in... 
Activity Indicator .vol Cash and Futures markets which are 



284 
 
 

active, all time frames 
 
The Volume study can offer a variety of signals.  When markets are trending upward in 
price, the strength of the trend can be confirmed by rising volume.  If the volume is 
stagnating or decreasing while prices are rising, it can be a signal that the market is 
weakening, and a top may soon be reached.  Because there is often less activity in a bear 
market, the opposite isn’t always true when prices are falling. 
 
High volume on reversals and breakouts tends to confirm those signals. 
 
How Aspen Graphics Calculates It: 
 

Calculations don’t take place within the Aspen Graphics program for this study.  
The values in the Volume study are sent by the datafeed just like the price data. 

 
Futures exchanges do not transmit information on the number of contracts 
involved in any one trade.  Instead, each time a trade occurs, a volume of one is 
recorded; for futures and options, this is referred to as a tick.  At the end of the 
day, the exchange estimates and reports a daily summary for the total number of 
contracts traded during the day.  See the following table for explanations of the 
Volume study for different instrument types and time frames. 
 

Instrument Type:  Stocks 
Time Frame Volume Value Represents 

Tick Volume reflects the number of shares for a given trade.  This is referred to as 
tick volume and represents the same value you’d see in a quote window 

under the heading TICVOL. 
Intraday, Daily 
and Historical 

Volume reflects the total number of shares traded during that period. 

Instrument Type:  Futures 
Time Frame Volume value represents…. 

Tick Volume reflects a value of one for each trade. 
Intraday Volume reflects the total number of price changes during that period. 

Daily Volume reflects the estimated number of contracts traded on the previous day. 
Historical Volume reflects the total number of contracts traded during the time period. 

 
Default Parameters Settings: 

Field Value 
Color Yellow 
Graph Histogram 

Line Style Solid 
Line Width 1 pixel 

 
 
Custom Aspen Graphics Formula: 
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You can make reference to Volume values by using the $1.volume quote code in 
formulas, color rules and alarms as shown in the following examples. 

 
Color Rule Example: 
 

If($1.volume>$1.volume[1],clr_purple,if($1.volume<$1.volume[1],clr_red,clr_yellow)) 
 

This color rule will turn the bar purple if the volume for that bar is greater than 
the previous bar and red if it is less than the previous bar. 

 
Alarm Example: 
 

chart((spm7.volume>=rmax(spm7.volume,21)) 
[-1],1,2,100,1,1) 

 
This alarm will trigger when the daily volume reaches or exceeds the highest 
volume of past 21 days. 

 

Volume Accumulation Oscil lator 
The Volume Accumulation Oscillator combines the On Balance Volume and 
Accumulation/Distribution Oscillator studies into one oscillator.  It assigns a proportional 
amount of volume to a period depending on where the close falls in the total range of 
prices. 
 
This study assigns all volume to buying or selling only if the close is the high or the low 
for the period.   
 

Type of 
Study 

Keyboard 
Command 

It works best in 

Activity 
Indicator 

.vao Cash, Futures, and Options markets in all time 
frames and all market conditions. 

 
 
How Aspen Graphics Calculates It: 

 
The Volume Accumulation Oscillator is:  

 
(Close-Low) -(High-Close) * Volume 

                                                     (High-Low) 
 

Once this is calculated, a 10-period moving average of this value is subtracted 
from three-period moving average. 
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Default Parameters Settings: 
 

Field Value 
Color Yellow 
Graph Line 

Line Style Solid 
Line Width 1 pixel 

 
 
Custom Aspen Graphics Formula: 
 

VAOsc(series)=savg($1.volume*(($1.close-$1.low)-($1.high-$1.close))/ ($1.high-$1.low),3)- 
savg($1.volume*(($1.close-$1.low)-($1.high-$1.close))/($1.high-$1.low),10) 

 
This formula, once entered in the Formula Listing, allows you to use the Volume 
Accumulation Oscillator study in color rules and alarms as shown in the following 
examples. 

 
Color Rule Example: 
 

if(VAOsc($1)>=0,clr_green,clr_red) 
 

This color rule will turn a bar green when the Volume Accumulation Oscillator 
has a positive value and will turn a bar red when the value is negative.  

 
Alarm Example: 
 

chart((VAOsc(s#)>40000)[-1],1,2,100,1,3) 
 

This alarm will trigger when the Volume Accumulation Oscillator has a value 
exceeding 40,000.  The alarm is based on daily bars of the front month of 
soybeans. 
 
 

Charting Setup Idea 
 

Oscillators like the Volume Accumulation Oscillator are sometimes graphed as 
histograms rather than as line charts.  To draw this study as a histogram, see the 
Charting Setup Idea section at the end of the Acceleration study section. 
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Will iams’ %R 
The scale in Williams’ %R is reversed from that of the Fast and Slow Stochastics; that is, 
it runs from -100 to 0. When the %R line is above -20, overbought conditions are said to 
exist, and when the %R line is below -80, it signals oversold conditions. 
 
The Williams’ %R study is displayed as a single line which often fluctuates dramatically.  
Values near the top of the scale (closer to zero) indicate market strength, while weakness 
in the market is signaled by values near the bottom of the scale. As with the other 
stochastic studies, divergence between this study and price movement can be a warning 
that a reversal is about to occur. 
 

Type of Study Keyboard 
Command 

It works best in 

Overbought/Overs
old 

.%r 
 

Cash and Futures markets in trading ranges, and in 
all time frames. 

 
 
How Aspen Graphics Calculates It: 
 

The Williams’ %R study is: 
 

100 * (highest high in n periods - current close) 
(lowest low in n periods-highest high in n periods) 
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Default Parameters Settings: 
 

Field Value 
Color Yellow 
Graph Line 

Line Style Solid 
Line Width 1 pixel 

Period 10 
 

 
Custom Aspen Graphics Formula: 
 

PerCentR(series)=100*(RMAX($1.HIGH,10)-$1.CLOSE)/ (RMIN($1.LOW,10)-
RMAX($1.HIGH,10)) 

 
This formula, when entered in the Formula Listing, allows you to use the 
Williams’ %R study in color rules and alarms as shown in the following 
examples. 

 
Color Rule Example: 
 

if(PerCentR($1)<=-80,clr_green,if(PerCentR($1)>-20,clr_red,clr_yellow)) 
 

This three-part color rule will turn a bar green when the Williams’ %R value is 
under -80, red when the Williams’ %R value is over -20, and all other bars will 
turn yellow.  

 
Alarm Example: 
 

chart((PerCentR(dm#)<=-80 or PerCentR(dm#)>=-20)[-1],60,1,100,1,1) 
 

This alarm will trigger when the Williams’ %R value is below -80 or above -20.  
The alarm is based on hourly bars for the front month of Deutschemarks.  

 


